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Informações de segurança e aprovação 

Este produto da Rosemount segue todas as diretivas europeias aplicáveis quando instalado adequadamente em conformidade com 
as instruções deste manual. Consulte a declaração da UE de conformidade das diretivas que se aplicam a este produto. A Declaração 
de Conformidade da UE, com todas as diretivas europeias aplicáveis, e os desenhos e instruções completos de instalação ATEX estão 
disponíveis na Internet em Emerson.com ou em seu centro de suporte local da Emerson. 

As informações afixadas no equipamento que está em conformidade com a Diretiva para Equipamentos de Pressão podem ser 
encontradas na Internet em Emerson.com. 

Para instalações perigosas em território europeu, consulte a norma EN 60079-14 se as normas nacionais não se aplicarem. 

Outras informações 

As especificações completas do produto podem ser encontradas na ficha de dados do produto. As informações de solução de 
problemas podem ser encontradas no manual de manutenção e solução de problemas. 

As fichas de dados e os manuais dos produtos estão disponíveis no site da Emerson em Emerson.com. 

Política de devolução 

Siga as instruções da Emerson para devolver seu equipamento. 

Esses procedimentos garantem conformidade legal com agências de transporte governamentais e ajudam a fornecer um ambiente de 
trabalho seguro para os funcionários da Emerson. A Emerson não aceitará os equipamentos devolvidos caso suas instruções não 
tenham sido seguidas. Os procedimentos e formulários de devolução estão disponíveis em nosso site Emerson.com ou entrando em 
contato com o departamento de atendimento ao cliente da Emerson. 

http://www.emerson.com/global
http://emerson.com/global
https://www.emerson.com/en-us/global
https://www.emerson.com/en-us/global
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1 Lista de verificação inicial 

1.1 Lista de verificação 
Durante a inicialização do medidor, tenha em mãos os seguintes equipamentos e informações: 

Tabela 1-1: Lista de verificação de inicialização do medidor 
 

 Desenhos de tubulação e identificação do local com elevações 

 Diagramas de fiação do local 

 Dados de calibração do medidor ultrassônico de líquidos Rosemount 

 Manuais do Medidor Ultrassônico de Líquido Rosemount 

 Informações e manuais de todos os outros instrumentos de fluxo - computadores de 
fluxo, fichas de dados de transmissores de pressão e temperatura e fiação 

 Informações sobre válvulas de corte e controle, especificações, operação e dados de configuração 

 Cabos Ethernet (cabos Cat 5) ou seriais para conectar o laptop ao medidor 

 Números de telefone do representante de serviço de campo para os principais componentes: 
válvulas, medidor, computador de fluxo, equipamento de comunicação, transmissores, 
projetistas ou integradores do local 

 Verifique toda a fiação do medidor ultrassônico. 

 Verifique as configurações dos interruptores no módulo da CPU do transmissor. 

 Inicie o MeterLink™. 

 Estabeleça o fluxo no medidor (pelo menos 4 pés/s para garantir uma boa mistura térmica). 

 Salve o arquivo de configuração do medidor - seu registro As Found do medidor. No MeterLink, 
selecione Tools → Edit/Compare Configuration. 
Clique no botão Read e selecione File Save. 

 Abra File → Program Settings e personalize as preferências do usuário do MeterLink. 

 Abra Meter → Monitor e verifique os caminhos ou cordas de medição e se eles estão de acordo 
entre si em aproximadamente 0,2%. 

 Verifique se há alarmes, abra Meter → Monitor e clique em Check Status. 

 Verifique a intensidade do sinal 

• Verifique se há uma boa intensidade de sinal (geralmente mostrada como "SNR") ou relação 
sinal/ruído. 

• Verifique se o perfil de fluxo está razoavelmente correto. 
 Vá para Logs/Reports → Maintenance Logs/Reports para coletar e salvar um Registro de 

manutenção para registrar o desempenho inicial do seu medidor (esse é o seu registro As Found ). 

 No menu Meter → Field Setup Wizard faça os ajustes de configuração, como a definição das 
variáveis de frequência e saída digital, escala total de frequência, saídas analógicas, 
configuração do visor local e limites de alarme e escala das entradas analógicas de temperatura 
e pressão. 

 Salve outro registro de manutenção (este é o registro As Left). 
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1.2 Segurança cibernética e comunicações de rede 
Para reduzir os riscos de segurança cibernética, configure as comunicações TCP/IP dos 
componentes eletrônicos do 3810 da seguinte forma: 

1. O MeterLink™ usa os protocolos FTP ou HTTP para coleta de registros de arquivamento e 
verificação de medidor inteligente. Recomenda-se desativar o protocolo FTP e deixar o 
protocolo HTTP ativado usando a caixa de diálogo Meter → Communication Settings no 
MeterLink. Ambos podem ser desativados para maior segurança, mas a coleta de registros 
não será possível nessa configuração. 

2. Deixe a porta Telnet desativada. Essa porta não é necessária para nenhuma comunicação 
com dispositivos de campo ou com o MeterLink. A partir do firmware da série Rosemount 
3810 v1.60, a Telnet é permanentemente desativada. 

3. A ativação da chave física de proteção contra gravação impedirá alterações na configuração 
da metrologia e atualizações de firmware. Também impedirá a ativação de protocolos TCP/IP, 
como FTP, HTTP e Telnet. 

4. Desative os protocolos não utilizados ou defina-os como somente leitura se o recurso de 
gravação não for necessário. O protocolo Modbus TCP/IP pode ser definido como Somente 
leitura ou Desativado na porta Ethernet. Os protocolos Modbus podem ser desativados ou 
tornados somente leitura nas portas seriais, permitindo ainda comunicações autenticadas do 
MeterLink. 

5. O firmware da série Rosemount 3810 v1.60 e posteriores requerem autenticação de usuário e 
têm uma senha de administrador padrão. Embora a senha seja exclusiva de cada medidor, é 
altamente recomendável que seja alterada na inicialização do medidor. Para aumentar a 
segurança, o nome de usuário padrão, administrador, também pode ser alterado. 

6. Outros usuários podem ser adicionados com privilégios e senhas diferentes no firmware da 
série Rosemount 3810 v1.60 e posteriores. Conceda aos usuários privilégios para o 
desempenho de suas funções de trabalho. Para mais informações, consulte Gerenciamento de 
usuários para saber como adicionar, alterar e excluir usuários. 

Este transmissor: 

1. Não se destina a ser conectado diretamente a uma empresa ou a uma rede voltada para 
a Internet sem um controle de compensação em vigor. 

2. Deve ser instalado seguindo as práticas recomendadas do setor para segurança cibernética. 
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2 Configuração inicial de comunicação 

2.1 Configuração das comunicações do medidor 
Após a instalação do seu medidor ultrassônico Rosemount, instale o MeterLink™ no seu PC ou 
laptop conforme descrito no Manual de início rápido do  software MeterLink para medidores de 
vazão ultrassônicos de gás e líquido (00809-0100-7630) para o seu sistema operacional e, em 
seguida, configure o medidor. 

O Manual de Início Rápido do Software MeterLink para Medidores de Vazão Ultrassônicos de 
Gás e Líquido (00809-0100-7630) é disponibilizado com o medidor. 

O programa de instalação do MeterLink está disponível para download no site da Emerson: 
Emerson.com/meterlink. 

 

2.1.1 Utilitários de configuração do MeterLink™ 
O MeterLink fornece os seguintes utilitários para configurar as unidades de medição de vazão do 
medidor, os parâmetros de saída do medidor, as configurações de comunicação, os testes de saída, as 
formas de onda e o gerenciamento de arquivos de registros e relatórios: 

Medidor 

• Conectar 

• Desconectar 

• Monitorar 

• Assistente de Configuração em Campo 
— Inicialização 

— Informações Gerais 

— Fontes de saída de frequência/digital 

— Saídas de frequência 

— Saídas Digitais do Medidor 

— Saídas Analógicas 

— Saídas HART® 

— Correções do medidor 

— Temperatura e Pressão 

— Limites de alarme 

— Visor local 

• Configurações de comunicação 

• Analisador de sinais 

• Informações do medidor 

• Gerenciar usuários 

• Abrir pasta de dados 

• Ferramentas 

https://www.emerson.com/documents/automation/quick-start-guide-meterlink-software-v1-90-en-43940.pdf
https://www.emerson.com/documents/automation/quick-start-guide-meterlink-software-v1-90-en-43940.pdf
https://www.emerson.com/documents/automation/quick-start-guide-meterlink-software-v1-90-en-43940.pdf
https://www.emerson.com/documents/automation/quick-start-guide-meterlink-software-v1-90-en-43940.pdf
https://www.emerson.com/documents/automation/quick-start-guide-meterlink-software-v1-90-en-43940.pdf
http://www.emerson.com/meterlink
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— Editar/Comparar configuração 

— Visualizador de forma de onda 

— Teste de saídas 

— Troca de transdutor 

— Definir tipo de transdutor 

— Redefinir rastreamento 

— Redefinir estimativa de velocidade 

— Substituir o tempo de atualização da estimativa de velocidade 

— Localizar medidor 

— Download do programa 

— Analisador de comunicações 

— Medidor de partida a quente 

 
2.1.2 Configuração do diretório do medidor 

Configure as propriedades de conexão para seu medidor. 

Por padrão, o diretório do medidor contém apenas um registro chamado New Meter (Novo medidor), 
que é predefinido para se conectar a um medidor ultrassônico de líquidos Rosemount configurado 
como enviado da fábrica. 

 
2.1.3 Criação de um novo registro de medidor 

Procedimento 

1. Selecione Insert, Insert Duplicate, ou Add da lista suspensa File para criar um novo 
registro. 

2. Configure o registro inserindo Short Desc, Meter Type e marcando as caixas de 
seleção de tipo(s) de conexão: Direct, Modem, Ethernet. 
Para cada tipo de conexão selecionado, um botão será ativado na parte inferior da caixa de 
diálogo com o mesmo nome. 

3. Clique nesses botões para editar as propriedades da conexão para esse método de conexão. 

4. Após escolher as propriedades da conexão, clique em OK para aceitar as alterações ou 
clique em Cancel para descartar as alterações e fechar a caixa de diálogo. 

 
2.1.4 Configurar uma conexão direta 

Procedimento 

1. Conecte-se ao medidor diretamente através de uma das portas seriais do medidor usando 
uma das portas seriais do seu computador. 

2. Clique em Direct para definir os seguintes parâmetros. 

O protocolo TCP/IP é um campo somente leitura e é o único protocolo utilizado pelo MeterLink™. 
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Endereço para 
Comunicação 

Obs.: 
Os medidores ultrassônicos Rosemount ainda suportam Modbus® ASCII e 
unidade terminal remota (RTU) Modbus ao se comunicarem com outros 
aplicativos ou dispositivos. 

 
 

Digite o endereço de comunicação que está configurado no hardware do 
medidor. O endereço padrão de fábrica dos medidores é 32. Para os 
medidores Ultrassônicos Rosemount, a faixa válida é de 1 a 247. 

Port Selecione o driver disponível na lista de drivers instalados em seu 
computador. 

Baud rate Selecione a taxa de transmissão da porta serial na lista suspensa para a qual 
o hardware do medidor está configurado. A taxa de transmissão padrão é 
19200. 

 

2.1.5 Conexão do modem 
Defina as seguintes propriedades para se conectar ao medidor por meio de um modem: 

Protocolo e 
endereço de 
comunicação 

Use os parâmetros Protocolo e endereço de comunicação em Configuração de uma 
conexão direta. 

Modem Selecione o modem a ser usado na lista suspensa. Somente os modems instalados 
no Windows® são exibidos na lista suspensa. Se a lista suspensa estiver em branco, 
nenhum modem foi instalado para o Windows®. 

Observação 
Não selecione Direct Connection ou o Cabo de comunicação entre dois 
computadores para o modem. Este é um driver de modem NULL para conexão 
direta apenas com medidores ultrassônicos Rosemount. Ele não funcionará para a 
conexão do modem. 

O MeterLink™ usa a rede dial-up da Microsoft® para fazer conexões seriais diretas e 
de modem a um medidor. Clique em Modem Properties para exibir a entrada de 
rede dial-up que o MeterLink criou para esse medidor. A maioria das informações 
necessárias é configurada corretamente pelo MeterLink. 

Baud Rate Selecione a taxa de transmissão desejada na lista suspensa. 

Telephone # Digite o número de telefone do modem ao qual o medidor está conectado. Inclua os 
dígitos para obter uma linha externa, se necessário. A inserção de vírgulas entre os 
dígitos interrompe a taxa de discagem. Cada vírgula é aproximadamente igual a dois 
segundos. 

Propriedades 
do modem 

Configura as propriedades associadas ao modem. 

O MeterLink usa o Microsoft® Dial-up Networking para fazer conexões seriais 
diretas e de modem com um medidor. Clique em Modem Properties para exibir a 
entrada de rede dial-up que o MeterLink criou para esse medidor. A maioria das 
informações necessárias é configurada corretamente pelo MeterLink. Clique em OK 
para aceitar as alterações ou clique em Cancel para descartar as alterações e 
retornar à caixa de diálogo Meter Director. 

 

2.1.6 Conexão Ethernet 
Defina as seguintes propriedades para configurar o hardware do medidor ultrassônico Rosemount 
para conectividade Ethernet. Use as caixas de seleção Direct, Modem, Ethernet e Ethernet 2 para os 
métodos de comunicação desejados. 
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Observação 
Recomenda-se que o medidor seja configurado utilizando um único computador host independente 
(rede externa). Após a configuração do medidor, a opção DHCP deve ser desativada. 

IP Address Digite o endereço IP da porta Ethernet do medidor. 

O endereço IP definido na fábrica é 172.16.17.200 para medidores ultrassônicos 
de líquidos Rosemount ou você pode usar 192.168.135.100 se o DHCP estiver 
ativado no medidor (consulte Protocolo de configuração dinâmica de host (DHCP) 
para mais detalhes). 

Protocolo de 
Configuração 
Dinâmica de Host 
(DHCP) 

Os PCs comerciais geralmente são configurados para trabalhar em um ambiente 
de rede em que um servidor DHCP atribui um endereço IP a cada computador 
quando eles se conectam à rede. 

Se um PC estiver configurado para obter um endereço IP de um servidor DHCP e 
for se conectar através do cabo Ethernet (N/P 1-360-01-596) a um medidor 
Ultrassônico Rosemount que não esteja conectado a uma rede, o servidor DHCP 
no medidor deverá ser ativado para que possa atribuir um endereço IP ao PC 
quando ele se conectar. 
O servidor DHCP pode ser ativado no medidor configurando o interruptor DHCP 
no módulo da unidade central de processamento (CPU) para a posição ON. 

Ao se conectar a um medidor com DHCP ativado, use o endereço IP 
192.168.135.100 para se conectar ao medidor. Nesse modo, é possível criar 
apenas um registro do Diretório de medidores com esse endereço IP para se 
conectar a todos os seus medidores com o DHCP ativado. Após a conexão ser 
estabelecida, selecione para utilizar o Meter Name, ao invés do Meter 
Directory Name, para manter todos os arquivos de registro e configurações 
separados para cada medidor. 
Clique em OK para aceitar as alterações ou clique em Cancel para descartar 
as alterações e retornar à caixa de diálogo Meter Director. 

 

2.1.7 Etapas de conexão inicial à Ethernet 
Procedimento 

1. Ligue o medidor. 

2. Desligue o computador. 

3. Conecte a extremidade Phoenix do cabo adaptador Ethernet no conector J8 da placa de 
conexão de campo do medidor e conecte a extremidade RJ-45 no conector Ethernet do PC. 

4. Ative o servidor de protocolo de configuração dinâmica de host (DHCP) do conector de rede 
local (LAN) Ethernet no módulo da unidade central de processamento (CPU) movendo o 
DHCP (chave-1) para a posição ON (veja a seta de direção na etiqueta do módulo da CPU). 

5. Ligue (inicialize) o PC e faça login no prompt de login inicial do Windows®. 
6. Verifique o status da conexão Ethernet pelo LED de LINK do módulo da CPU. A cor 

desejada é verde sólido. 

7. Inicie o MeterLink e crie um novo registro de medidor. 

 
2.2 Importação de um registro de medidor 

Procedimento 

Selecione File → Import da lista suspensa Meter Directory ou clique em Import. 
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A caixa de diálogo Import Meter Directory File (Importar arquivo do diretório do medidor), que 
permite selecionar um arquivo .DAT do diretório do medidor para importar o arquivo para o arquivo 
do diretório do medidor usado no momento, é aberta. 

Se um registro de medidor idêntico já existir e uma duplicata estiver tentando ser importada, o 
MeterLink™ insere o registro de medidor duplicado. O botão Import executa a mesma 
operação. 

 
2.3 Exportação de um registro do medidor 

Use o comando Export para salvar o diretório atual do medidor em um arquivo. Selecione File → 
Meter Directory na lista suspensa Meter Directory  ou clique em Export. 

Procedimento 

1. Ative a caixa de seleção do registro do diretório do medidor que deseja exportar ou clique em 
Select All. 

2. Clique em OK para começar a exportar o(s) registro(s) do medidor. Use a caixa de diálogo 
Export Meter Directory File (Exportar arquivo de diretório do medidor) para salvar o registro 
exportado na pasta padrão (C:\Ultrasonic Data) ou insira outro local. 

3. Clique em Save. Se houver um arquivo METER_DIRECTORY_EXPORT.DAT existente, será solicitado 
que você altere o nome do arquivo ou substitua o arquivo. Se alterar o nome do arquivo, 
mantenha a extensão .DAT para manter a funcionalidade ao importar o arquivo para a nova 
máquina. 

4. Copie o arquivo exportado para a nova máquina. 
5. Use o comando Import para selecionar esse arquivo e importá-lo para o Meter Directory. 

Importante 
Devido às limitações na rede dial-up da Microsoft®, nem todas as informações de diretório 
para conexão direta e por modem podem ser exportadas para o arquivo METER_DIRECTORY.DAT 
para medidores ultrassônicos Rosemount. O MeterLink™ exporta os nomes dos medidores, o 
endereço de comunicação, a interface e os números de telefone. É necessário verificar 
novamente as propriedades da conexão e verificar se os parâmetros de comunicação, como a 
porta COM, os bits de dados e a paridade, estão configurados corretamente. 

 

2.4 Conexão ao medidor 
Procedimento 

1. Na barra de menus, selecione Meter → Connect ou clique em , no ícone Connect, na 
barra de ferramentas. 
A caixa de diálogo Connect to meter exibe uma lista de medidores configurados no 
MeterLink™. 

2. Clique em Direct ou Ethernet ao lado do nome do medidor para estabelecer uma conexão 
com o seu medidor ultrassônico. 

Para o firmware da série Rosemount 3410 v1.60 e posterior, o MeterLink exibirá a caixa de 
diálogo Meter Login e exigirá a inserção de um nome de usuário e uma senha válidos para 
estabelecer uma conexão. 

O nome de usuário padrão para um medidor vindo da fábrica ou para um medidor atualizado 
a partir de uma versão de firmware anterior à v1.60 é administrator. A senha padrão é 
Administrator-XXXXX em que XXXXX é o número de série da unidade central de 
processamento (CPU), que pode ser encontrado em uma etiqueta no módulo da CPU. 

O MeterLink v1.90 ou posterior é necessário para estabelecer uma conexão com um medidor 
que exija autenticação de usuário. Consulte Meter → Manage Users para mais detalhes sobre 
a configuração de usuários, tipos de usuários e senhas. 
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2.5 Coleta de registros e relatórios "As Found” 

Use o menu MeterLink™ Logs/Reports (Registros/Relatórios) e colete e salve os registros e relatórios 
para um registro histórico do medidor em várias velocidades dentro da faixa de operação do medidor 
para estabelecer uma linha de referência a ser usada para a tendência dos diagnósticos do medidor e 
salve os seguintes registros e relatórios para as configurações "As Found" (padrão de fábrica): 

• Registro de Manutenção 

• Registro do sistema 

• Salvar o arquivo de configuração do medidor 

• Use o menu Tools → Edit/Compare Configuration para exibir a caixa de diálogo. Ative o botão de 
rádio  View All ou Metrology e clique em Read. 

• A visualização All (Tudo) exibe os parâmetros de configuração estendida do medidor. Os valores 
em cinza são somente para leitura, mas ajudam a descrever a configuração. A visualização 
Metrologia exibe as dimensões do caminho, o diâmetro do tubo, os parâmetros de atraso do 
transdutor, os coeficientes de calibração de fluxo zero e os coeficientes de calibração de fluxo. 
— Clique no ícone de ponto de interrogação do ponto de dados para exibir informações adicionais. 

• Clique em Save para salvar o arquivo de configuração. Por padrão, o arquivo é salvo na pasta 
Data  configurada em File → Program Settings. 

 
2.6 Personalização das configurações do MeterLink™ 

Abra o MeterLink e acesse File → Program Settings e, em seguida, insira as configurações 
desejadas para seu medidor. 

Seu nome de usuário e o nome da empresa são incluídos nos relatórios e registros gerados com o 
MeterLink. 
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Figura 2-1: Configurações do programa 

 

• Nome do usuário 

• Nome da Empresa 

• Pasta de dados (onde os dados do medidor são armazenados) 

• Marque a caixa de seleção para criar uma subpasta com o nome do medidor na pasta Data 
(Dados) para salvar e abrir arquivos do seu medidor 

• Unidades de exibição (de medição); U.S. Customary ou Metric para as conversões de 
unidades necessárias lidas pelo medidor 

• Unidades de volume do medidor: gal, pés cúbicos ou bbl 

• Prompt to save Meter Config (configuração) solicita que você salve uma cópia da configuração 
do medidor depois de fazer alterações no medidor 

• Executar a caixa de diálogo Connect automaticamente após a conexão 

• Executar o Meter Monitor automaticamente após a conexão 

• Executar o resumo ou a exibição detalhada do Meter Monitor após a conexão 

• Editar o número de telefone antes de se conectar com um modem 

• Usar o modo passivo de FTP (comunicações cliente-servidor) 

• Conexão somente FTP - usada para baixar firmware para medidores ultrassônicos Rosemount 
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• Tabulação da planilha para o próximo controle em vez da próxima célula 

• Tempo limite do banco de dados da conexão do medidor TCP/IP - tempo que o MeterLink espera para 
responder a uma solicitação de dados do banco de dados do medidor (padrão: 13 segundos) 

• Override system default printer (Substituir impressora padrão do sistema) - usado para alterar a 
impressora 

• Preferência de tipo de produto - tipo de medidor que você conectará com mais frequência, gás ou líquido 

 
2.7 Configuração das comunicações Modbus® 

Os medidores de vazão ultrassônicos para líquidos Rosemount 3810 suportam interface serial RS-232 
ou RS-485 de 4 fios ou 2 fios half duplex para um sistema externo (por exemplo, computador de 
vazão) usando o protocolo Modbus ASCII com os seguintes parâmetros: 

Tabela 2-1: Parâmetros de comunicação Modbus 
 

Configuração Valor 

Taxa de Baud 19200 

Bits de Dados 7 

Bits de Parada 1 

Paridade Igual 

Protocolo Modbus ASCII 

 
Consulte o manual do usuário do computador de vazão para definir as configurações de 
entrada/saída (E/S) necessárias para permitir a comunicação serial com os medidores de vazão 
ultrassônicos de líquidos Rosemount 3810. 

Os medidores de vazão ultrassônicos de líquidos Rosemount 3810 suportam comunicação ASCII e 
RTU Modbus. Para o Modbus ASCII, tanto o 7E1 quanto o 7O1 são suportados. Para o Modbus RTU, é 
suportado o 8N1. As portas de comunicação proporcionam detecção automática de protocolos - 
apenas a taxa de baud e a ID do Modbus precisam ser especificadas. Além disso, consulte o site da 
Emerson e selecione a página Produto para o modelo de seu medidor: Emerson.com/automation. 

Configurar parâmetros Modbus TCP 

Se o firmware do medidor suportar a funcionalidade de servo de Modbus TCP, os seguintes controles 
estarão disponíveis: 

• Identificador da unidade de Modbus TCP: Insira aqui o identificador da unidade de Modbus 
TCP. Os valores válidos são de 0-255. 

• Habilitar a porta alternativa de Modbus TCP: A porta TCP padrão do Modbus TCP é a porta 
502. Esta porta está sempre habilitada em um medidor que é compatível com o Modbus TCP. Ao 
selecionar esta opção, você também pode habilitar comunicação Modbus TCP em uma porta TCP 
secundária, especificada pela porta Alternativa de Modbus TCP. 

• Porta alternativa de Modbus TCP: Depois de selecionar Enable alternate modbus TCP port, 
digite o número da porta TCP alternativa aqui. Os números de portas válidos variam de 1 a 65535. 
O medidor não permitirá alguns números de portas que são utilizados pelo medidor ou definidos 
para outros protocolos. O MeterLink™ lhe perguntará se não foi possível gravar o número de porta 
especificado no medidor. 

 
2.8 Configuração das comunicações HART®   

Os medidores de vazão ultrassônicos Rosemount são dispositivos compatíveis com HART que utilizam 
a saída analógica 1 do sinal de 4-20 mA no módulo da CPU, no qual o sinal digital é enviado do  

https://www.emerson.com/en-us/automation/measurement-instrumentation/flow-measurement


Operação Configuração inicial de comunicação 

Rosemount 3810 15 

 
 

 

00809-0222-3810 Dezembro 2023 
 

 
 
 

dispositivo de campo (medidor de vazão ultrassônico Rosemount) para o host (PC executando o AMS 
Device Manager ou um Comunicador de Campo). É necessária uma fonte de alimentação externa de 
24 V para o sinal analógico do módulo da CPU. 

O aplicativo HART Device Description fornece variáveis dinâmicas, comandos específicos do 
dispositivo, comandos universais e comandos de prática comum de acordo com a HART 
Communication Foundation. A Descrição do Dispositivo define os detalhes de comunicação do 
dispositivo para o host (por exemplo, menus para o Field Communicator, exibições gráficas para o 
AMS Device Manager e os parâmetros do dispositivo - variáveis de processo, pressão, temperatura, 
diagnósticos e três grupos de alerta de status - Failed, Maintenance e Advisory). Consulte 
Especificação do dispositivo de campo HART (00825-0300-3810)para mais  detalhes. 

Além disso, consulte os sites do AMS Device Manager e do Field Communicator: 

• Emerson.com/AMSDeviceManager 

• Emerson.com/FieldCommunicators 

 
2.9 Configuração do medidor em um sistema DeltaV 

Os medidores de vazão ultrassônicos Rosemount série 3810 são compatíveis com as comunicações do 
sistema DeltaV. A seguir estão as configurações de comunicação opcionais dos medidores de vazão 
ultrassônicos Rosemount: 

• Conexão serial para RS-232 ou RS-485 

• Ethernet 

• HART ® 

• Modbus TCP/IP (requer uma placa VIM) 

Consulte o Manual de instalação do seu sistema de automação digital para obter informações sobre 
as terminações da fiação de campo, interface de E/S, alimentação e rede de controle DeltaV. 

• Acesse o hiperlink do site do DeltaV: 
Emerson.com/DeltaV 

• Clique em Books Online nos Links rápidos. 

• Configure sua conta de usuário e acesse o manual. 

 
2.10 Gerenciamento de usuários 

A partir do firmware v1.60 da série 3810 do Rosemount, o medidor autenticará qualquer usuário que faça 
uma conexão com o medidor usando o MeterLink™. 

O MeterLink solicitará um nome de usuário e uma senha que serão autenticados pelo medidor antes que 
uma conexão bem-sucedida seja estabelecida. 

Somente usuários com um tipo de usuário Administrador podem acessar a caixa de diálogo Meter → 
Manage Users no MeterLink para adicionar, alterar ou excluir usuários no banco de dados de usuários. As 
alterações no banco de dados de usuários não são protegidas contra gravação pela chave WRITE PROT. Um 
usuário com o tipo de usuário Administrador também pode exportar e importar o banco de dados de 
usuários de um medidor para outro para facilitar a função de gerenciamento de usuários em vários 
medidores. O MeterLink v1.90 ou posterior é necessário para estabelecer uma conexão com um medidor que 
exija autenticação de usuário. 
Observação 
Os protocolos Modbus® não são compatíveis com autenticação, portanto os medidores não podem 
autenticar comunicações por meio desses protocolos. Nenhuma alteração foi feita na forma como 
esses protocolos funcionam. 

https://www.emerson.com/documents/automation/quick-start-guide-rosemount-3810-series-ultrasonic-flow-meters-hart-field-device-specification-en-44042.pdf
https://www.emerson.com/en-us/catalog/asset-reliability/ams-ams-device-manager
https://www.emerson.com/en-us/automation/asset-performance-management/field-device-management/field-communicators
https://www.emerson.com/en-us/automation/deltav
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2.10.1 Configuração do usuário 
Abra o MeterLink™ e conecte-se ao medidor como usuário com o tipo de usuário Administrator. 

Acesse Meter → Manage Users, para abrir a caixa de diálogo para adicionar, alterar ou excluir 
usuários. Um máximo de 25 usuários pode ser configurado em um medidor. A seguir estão as regras 
necessárias para configurar com êxito novos usuários em um medidor: 

Para configurar novos usuários em um medidor: 

Nome de usuário 

Os nomes de usuário podem ter de 1 a 20 caracteres. Os nomes de usuário são armazenados no 
medidor em letras minúsculas. O usuário pode inserir um nome de usuário em letras maiúsculas ou 
minúsculas, mas ele será convertido em letras minúsculas para autenticação. 

Os seguintes caracteres são permitidos: 

• Letras maiúsculas (A a Z) 

• Letras minúsculas (a a z) 

• Números (0 a 9) 

Tipo de usuário 

Há três tipos de usuários compatíveis: 
 

Tipo de usuário Descrição 

Administrador Capacidade total de leitura/gravação e privilégios para gerenciamento de usuários 

Engenheiro Capacidade total de leitura/gravação, mas sem privilégios de gerenciamento de 
usuários 

Operador Recurso somente de leitura. O operador não tem permissão para confirmar alarmes. 

 
Pelo menos um usuário com o tipo de usuário Administrador deve estar sempre configurado no 
medidor. O medidor não permitirá que o último usuário com um tipo de usuário Administrador seja 
excluído. 
Vários usuários podem ter o mesmo tipo de usuário. 

Senhas 

As senhas devem ter de 8 a 20 caracteres. Somente os caracteres dos grupos a seguir são permitidos: 

• Deve ter pelo menos uma letra maiúscula (A-Z) 

• Deve ter pelo menos uma letra minúscula (a-z) 

• Deve ter pelo menos um número (0-9) 

• Deve ter pelo menos um caractere especial dentre os seguintes: 
— & (E comercial) 

— * (Asterisco) 

— @ (símbolo de At) 

— \ (Barra invertida) 

— ^ ("circunflexo") 

— ) (Fecha parênteses) 

— } (Chave) 

— ] (Colchete de fechamento) 
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— : (Dois pontos) 

— , (Vírgula) 

— $ (Dólar) 

— = (Igual) 

— ! (Ponto de exclamação) 

— ` (Acento grave) 

— > (Maior que) 

— - (Hífen) 

— < (Menor que) 

— # (Número) 

— { (Abre chaves) 

— [ (Colchete de abertura) 

— ( (Abre parêntese) 

— % (Porcentagem) 

— . (Ponto final) 

— + (Positivo) 

— ? (Ponto de interrogação) 

— ; (Ponto e vírgula) 

— / (Barra) 

— " (aspas duplas retas) 

— ' (aspas simples retas ou apóstrofo) 

— ∼ (Tilde) 

— _ (sublinhado) 

— | (Barra vertical) 

 
2.10.2 Importação/exportação de banco de dados de usuários 

Para ajudar a facilitar o gerenciamento de usuários em vários medidores, há opções para exportar e 
importar o banco de dados de usuários de um medidor para outro. 

Isso permite que o usuário seja configurado em um medidor e facilmente transferido para outros. 
Essas funções também são necessárias no caso de um módulo de unidade central de processamento 
(CPU) em um medidor precisar ser iniciado a frio para os valores padrão ou substituído. 

Para exportar o banco de dados de usuários do medidor para um arquivo local no seu computador, 
clique em Exportem Meter → Manage Users no MeterLink™. O MeterLink solicitará uma senha para o 
medidor usar para criptografar o banco de dados a fim de fornecer algum nível de segurança para 
esse arquivo depois que o MeterLink o salvar em seu computador. Esse arquivo de banco de dados de 
usuários criptografado e a senha devem ser mantidos em um local seguro, pois contêm informações 
confidenciais, como nomes de usuário e senhas. 

Para importar um arquivo de banco de dados de usuários criptografado do seu computador para um 
medidor, clique em Import em Meter → Manage Users no MeterLink. O MeterLink solicitará a senha 
que foi usada para criptografar o arquivo durante a exportação. O arquivo e a senha serão enviados  



Configuração inicial de comunicação Operação 

18 Emerson.com/Rosemoun
t 

 
 

 

Dezembro 2023 00809-0222-3810 
 

 
 
 

ao medidor e se o medidor conseguir descriptografar o arquivo com êxito, o banco de dados de 
usuários existente no medidor será excluído e substituído pelo banco de dados de usuários 
importado. 

 
2.10.3 Redefinição de usuários 

É importante manter o controle das credenciais de login para pelo menos um uso com o tipo 
de usuário Administrador para evitar uma situação em que os direitos de administração sejam 
perdidos para um medidor. 

Se isso ocorrer, há um modo de redefinição de usuário que pode ser iniciado para excluir todos os 
usuários do banco de dados de usuários e restaurar o nome de usuário e a senha padrão do 
administrador. 

Pré-requisitos 

• A senha padrão é Administrator-XXXXX onde XXXXX é o número de série da CPU preenchido com 
zeros que pode ser encontrado em uma etiqueta no Módulo da CPU. 

• Essa operação não pode ser feita remotamente e requer acesso físico ao módulo da CPU. 

Para excluir todos os usuários e restaurar o usuário administrativo padrão: 

Procedimento 

1. Conecte seu computador com o MeterLink™ ao medidor que requer a redefinição do 
banco de dados de usuários usando o cabo apropriado. 

2. Para colocar o medidor em modo de reinicialização, faça a transição do interruptor Port A 
Override no módulo da CPU da posição Off para a posição On três vezes em um intervalo de 
cinco segundos e deixe o interruptor na posição On após a terceira transição. 
O medidor entrará no modo de redefinição do medidor após 5 segundos e permanecerá no 
modo de redefinição do medidor por até dois minutos ou até que uma ação de redefinição 
seja concluída ou o interruptor Port A override seja movido para a posição OFF. 

Dica 
Use uma caneta esferográfica retrátil com a ponta retraída como ferramenta para fazer a 
transição da chave. 

3. Dentro de dois minutos, conecte-se ao medidor com o MeterLink. A caixa de diálogo Meter 
Reset Mode is enabled será exibida. 

4. Clique na opção para Reset Users. 
O MeterLink solicita que você confirme que o banco de dados de usuários deve ser redefinido. 

Quando a operação for confirmada, o medidor excluirá o banco de dados de usuários e criará 
o usuário administrador padrão. O MeterLink se desconectará do medidor. 

5. Conecte-se ao medidor novamente usando o nome de usuário do administrador padrão e vá 
para Meter → Manage Users para configurar novos usuários e alterar a senha padrão do 
administrador. 

Observação 
Para maior segurança, o nome de usuário padrão do administrador também pode ser 
alterado. 
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3 Medição de vazão 

3.1 Princípios de medição de vazão 
Os medidores de vazão ultrassônicos para líquidos Rosemount 3810 medem os tempos de trânsito 
dos pulsos ultrassônicos que passam pelo meio em dois planos paralelos. Os caminhos de medição, 
chamados de "cordas", são angulados em relação ao eixo do tubo, e cada corda tem dois 
transdutores que atuam alternadamente como transmissor e receptor. 

A Figura 3-1 descreve o princípio da medição de vazão. Isto permite que o tempo de percurso seja 
medido no fluxo e contra o fluxo (a montante e a jusante). 

Os transdutores são montados no corpo do medidor em locais precisamente conhecidos para cada 
tamanho de tubo, de modo que a distância L entre os transdutores opostos e o ângulo são 
precisamente definidos para a medição. 

Figura 3-1: Princípio de medição do tempo de trânsito 

 
 

 

 

Figura 3-2: Princípio de medição 3812 

 

Transdutor 1 

Transdutor 2 



Medição de vazão Operação 

20 Emerson.com/Rosemoun
t 

 

 

Dezembro 2023 00809-0222-3810 
 

 
 
 

3.1.1 Controle de tempo do transdutor 
O controle de tempo do transdutor, o desempenho da coleta de dados em lote e as atualizações 
de cálculo nos medidores de vazão ultrassônicos de líquidos Rosemount 3810 são afetados 
pelos seguintes parâmetros: 

• Processamento de sinal 

• Processamento do ciclo de lote 

Figura 3-3: Analisador de sinais - taxa de atualização, tamanho da pilha, filtro e taxa de emissão 

 
 

3.1.2 Terminologia para medição de fluxo 

• Sequência- Um ciclo completo de disparo de todos os transdutores habilitados em uma única 
rodada de operação do transdutor. Por exemplo, quando todos os oito transdutores do medidor 
de vazão ultrassônico para líquidos Rosemount 3814 tiverem sido acionados em uma única 
rodada de operação, isso significa a conclusão de uma sequência. 

• Empilhamento - O processo de modificação de uma sequência de modo que cada 
transdutor individual seja acionado "x" vezes (onde x é igual ao tamanho da pilha) antes que 
o próximo transdutor da sequência seja acionado. 

• Tamanho da pilha - O número múltiplo de vezes que cada transdutor é acionado antes que 
o próximo transdutor da sequência seja acionado. 
Quando o empilhamento está ausente ou desativado, o tamanho da pilha é, na verdade, 1, 
porque cada transdutor ativado é disparado uma vez durante a sequência. Quando o 
empilhamento é aplicado ou ativado, ele é aplicado em incrementos de 2, 4, 8 e 16 e são as 
únicas opções de tamanho de pilha, de modo que cada transdutor ativado é disparado 2, 4, 8 ou 
16 vezes antes que o próximo transdutor na sequência seja disparado. 

• Taxa de emissão - O tempo decorrido antes que o próximo transdutor em uma sequência seja 
disparado, independentemente do tamanho da pilha (a taxa de emissão mínima é de 2 
milissegundos com o filtro ON ou OFF). A Emerson recomenda a configuração padrão do filtro, 
que é a posição OFF. 

• Taxa de emissão da pilha - O tempo decorrido antes que um único transdutor seja disparado 
novamente quando o empilhamento está ativado. A taxa mínima de emissão de pilha é de 2 
milissegundos com o filtro desligado. 

• Cordas inativas ou ativas - A exclusão ou inclusão de um par de transdutores 
formadores de cordas na sequência de operação do transdutor. 

• Tempo de atualização - O tempo decorrido, em segundos, entre cada processamento ou 
recálculo de dados coletados de sequências de disparos de transdutores. 
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• Período do lote ou ciclo do lote - Sinônimo de tempo de atualização. 

• Amostra - Refere-se a um ponto na forma de onda como em amostras por ciclo. Os dados que são 
coletados de uma sequência de operação do transdutor. Esse termo é exibido na tela do 
MeterLink™ Signal Analyzer e é quase sinônimo de Sequência, conforme definido acima. Ou seja, 
Samples/update (Amostras/atualização), conforme exibido no Assistente do analisador de sinais 
MeterLink, pode ser interpretado como Sequences/update (Sequências/atualização). Isso mostra o 
número médio de novas amostras coletadas durante um período de atualização. 

 
3.1.3 Processamento de sinal 

Processamento de sinal para medição do tempo de trânsito 

O sinal no transdutor receptor é digitalizado, amplificado e processado digitalmente para 
fornecer uma medição precisa do tempo de transição. 

Uma medida da "qualidade" do sinal é a relação sinal-ruído (SNR). Quanto mais alta a SNR, melhor é 
o sinal. Em geral, há dois tipos de ruído: o ruído “branco” e o ruído “colorido”. O ruído branco é o 
ruído que ocorre em todo o espectro da frequência e é assíncrono ao sinal transmitido. O ruído 
colorido é concentrado em torno de uma determinada frequência e pode ser sincronizado com o 
sinal transmitido. O medidor fornece dois métodos para melhorar a onda SNR do sinal recebido: 
Empilhando e Filtrando. 

 
3.1.4 Empilhamento 

Método de disparo do transdutor 

O empilhamento é um método de disparar um transdutor múltiplas vezes e tirar a média dos sinais 
recebidos numa base ponto por ponto. 

O empilhamento é eficaz no ruído assíncrono, uma vez que é tipicamente visto com o ruído de uma 
válvula. Este método não é útil para a remoção de ruído síncrono e não deve ser usado quando há 
muita flutuação de sinal. Os medidores são configurados por padrão com um tamanho da pilha 2. 

Deve-se tomar cuidado ao desativar o empilhamento e recomenda-se consultar o Suporte ao 
cliente da Emerson se não tiver certeza de como o empilhamento de um sinal pode afetar a 
operação do medidor. Consulte o Suporte técnico no menu Ajuda do MeterLink™ para obter 
informações de contato. 

O número consecutivo de vezes que cada transdutor é disparado é especificado no ponto de dados 
StackSize. Os tamanhos de pilhas disponíveis são 1 (nenhuma), 2, 4, 8, e 16. Um tamanho 1 não 
seleciona nada (ou seja, empilhamento desabilitado). O empilhamento está apenas disponível 
quando a taxa de atualização padrão é selecionada. 

 
3.1.5 Filtragem 

Filtro passa-faixa de frequência 

A filtragem aplica um filtro passa-banda que remove o ruído que está acima e abaixo da 
frequência do transdutor. A filtragem é eficaz para remover ruído fora da banda de passagem de 
frequência do filtro (por exemplo, a filtragem funciona com qualquer ruído fora da banda de 
passagem do filtro). A filtragem é habilitada e desabilitada pelo ponto de dados Filter (TRUE = 
habilita a filtragem, FALSE=desabilita a filtragem). 

Os medidores são configurados por padrão com a filtragem desativada. A Emerson recomenda a 
configuração padrão do filtro, que é a posição OFF. 

Deve-se tomar cuidado ao ativar e desativar a filtragem e recomenda-se consultar o Suporte ao 
cliente da Emerson se não tiver certeza de como essa alteração pode afetar a operação do medidor. 
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Consulte o Suporte técnico no menu Ajuda do MeterLink™ para obter informações de contato. 

 
3.1.6 Processamento do ciclo de lote 

Período de atualização de lote 

As atualizações dos cálculos realizados pelo medidor, para derivar o volume e a velocidade, são 
baseados em lotes de amostras de dados coletadas das sequências de disparo dos 
transdutores. 
O período de atualização do lote depende do período de atualização especificado pelo usuário 
(SpecBatchUpdtPeriod) e do tamanho da pilha (StackSize) conforme mostrado na Tabela 3-1. O 
período de atualização Standard é definido como o padrão. O período real de atualização do lote 
pode ser lido pelo ponto de dados BatchUpdatePeriod. 

Tabela 3-1: Período real de atualização do medidor 
 

SpecBatchUpddtPeriod Tamanho da pilha 

1 (Nenhuma) 2 4 8 16 

Rápido (250 ms) 0,25 s N/A N/A N/A N/A 

Padrão (1000 ms) 1 s 1 s 1,5 s 3 s 5 s 

 
3.2 Suavização 

Suavização da saída 

O medidor de vazão ultrassônico de líquidos Rosemount introduz um método para suavizar a 
saída (particularmente a saída de frequência), calculando a média dos tempos coletados de 
períodos de lote anteriores com novos tempos para o período de lote atual. 

A suavização pode ser aplicada nos seguintes incrementos: 0 (suavização desabilitada), 20, 40, 60, 
ou 80%. 

Por exemplo, ajustando a Suavização para 20% significa que, das amostras usadas para a atualização 
atual, 20% serão amostras coletadas previamente e 80% serão amostras novas. Assim, se oito novas 
amostras forem coletadas, essas oito amostras, juntamente com as duas últimas amostras anteriores, 
serão usadas em conjunto para os cálculos do período de atualização atual. 

Os medidores são configurados como padrão com Suavização de 0% (apenas novas amostras são 
usadas para o período de atualização atual). 

 
3.3 Modo de aquisição 

Aquisição de sinal 

O medidor de vazão ultrassônico para líquidos da série 3810 da Rosemount tem dois modos de 
operação normal: Aquisição e Medição. O modo de Aquisição é usado para adquirir os sinais 
ultrassônicos. Este modo é habilitado após ligar o medidor. Uma vez que os sinais ultrassônicos são 
adquiridos, o modo de Medição é ativado e a velocidade do fluxo é medida. O medidor permanece no 
modo de Medição enquanto houver pelo menos uma corda em funcionamento. 

Se enquanto estiver no modo de Medição todas as cordas falharem, então o medidor entra 
novamente no modo de Aquisição. Se o ponto de dados VelHold for definido como um valor maior 
que zero, então, enquanto estiver no modo VelHold de aquisição, o medidor manterá a velocidade 
média ponderada do fluxo no último valor bom por até o número de lotes VelHold antes de definir a 
velocidade como zero. O valor padrão de VelHold é 0. 
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O modo de operação do medidor é indicado pelo ponto de dados IsAcqMode. Quando for TRUE, o 
medidor está no modo de Aquisição; quando for FALSE, o medidor está no modo de Medição. 

O modo de aquisição usa as dimensões “L” das cordas (LA...LD, conforme apropriado para o tipo de 
medidor) e as velocidades sonoras mínima e máxima especificadas (SSMin e SSMax) para 
determinar a faixa de busca do sinal. 

 
3.3.1 Modo de reaquisição 

Readquirir sinais do transdutor 

Quando menos do que MinChord (padrão 1) as cordas são boas, o medidor entra novamente 
no modo de Aquisição. Se MinChord for definido como o número de cordas ativas, o medidor 
readquirirá na primeira vez que uma corda falhar em um lote. 

Observe que a falha em um lote é diferente da falha grave. Uma cord falha em um lote quando 
PctGood[A1..D2] é menor que MinPctGood. 

As falhas graves ocorrem após o número AlarmDef de lotes em uma linha. 

Se o ponto de dados VelHold for maior que zero, então, enquanto estiver no modo de Aquisição, o 
medidor mantém a média da velocidade de vazão ponderada no último valor aceitável até o número 
de lotes VelHold antes de estabelecer a velocidade para zero. O valor padrão de VelHold é 0,0. 

 
3.4 Medições de fluxo médio de cordas e velocidade do 

som 
Em cada período de atualização de lote, é feita a média das medições de tempo de trânsito de cada 
caminho de disparo. O valor médio (mediano) de cada caminho está disponível por meio dos pontos 
de dados MeanTmA1 ... MeanTmD2 (conforme apropriados para o tipo do medidor). 

Observação 
Os nomes do ponto de dados frequentemente usam um nome curto para identificar o transdutor 
receptor. Os dois últimos caracteres identificam a corda (A…D) e o transdutor (1=fluxo à montante, 2= 
fluxo à jusante). Por exemplo, MeanTmA1 é o tempo médio de trânsito para o transdutor a montante 
da corda A. 

A diferença entre o tempo médio de percurso à montante de uma corda e o tempo médio de 
percurso à jusante é o tempo médio delta. As médias de tempo da corda e as dimensões “X” e “L” da 
corda são usadas para calcular a velocidade média de fluxo e a velocidade do som para a corda, 
como mostrado na Equação 3-1 e Equação 3-2. 

Equação 3-1: Fluxo médio de cordas  

 
 

Equação 3-2: Velocidade do som da corda 

 
 

3.4.1 Velocidade Média do Fluxo 
A velocidade média é calculada como a velocidade média do som das cordas ativas, conforme 
mostrado na equação abaixo: 
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Equação 3-3: “Average Flow Velocity” (Velocidade Média do Fluxo) 

 
 

CAvg = Velocidade média do som (m/s) 

CChord = Velocidade média do som da corda (m/s) (SndVelA...SndVelD) 

NumActiveChords = Número de cordas ativas 
 

 

3.4.2 Velocidade média do fluxo usando proporções de corda 
No caso de falha de uma ou mais cordas, a operação do medidor depende do número de cordas que 
não falharam. 

• Se houver pelo menos uma corda operando, o medidor usa o método estimativo de velocidade 
descrito nos parágrafos a seguir. 

• Se todas as cordas falharem, o medidor entrará novamente no modo de aquisição, conforme 
descrito na seção "Reaquisição" abaixo. 

O medidor parte a gama de velocidade (para fluxo para frente e na direção oposta) em dez “bins” 
consecutivos e não sobrepostos (onde a gama de velocidade é especificada via ponto de dados 
MeterMaxVel). O medidor mantém um grupo de “bins” para cada corda ativa onde cada “bin” 
contém três valores de dados: 

1. A velocidade média da corda (dentro da faixa de velocidade do compartimento) 

2. O valor da proporção média da corda 

3. Um indicador de que o valor ainda é o padrão (Is[Fwd/Rev]Prop[A..D]DfltBin[1..10]) 

Um valor de proporção de corda é a razão entre a velocidade de corda e a velocidade média 
ponderada do fluxo, conforme mostrado na Equação 3-4. O indicador padrão é usado para determinar 
se os valores de dados de velocidade e proporção de um compartimento foram atualizados a partir de 
seus valores inicializados. Os compartimentos são inicializados com a velocidade média sobre a faixa 
do compartimento e os valores de proporção dependentes da geometria do medidor. Todos os 
indicadores padrão são inicializados como TRUE. Os dados do “bin” são armazenados em uma 
memória não volátil. 

Equação 3-4: Cálculo da proporção de cordas 

 

Propchord = proporção da corda (sem dimensão) 

Vchord = velocidade da corda (m/s) (FlowVelA ... FlowVelD) 

VAvgWtd = velocidade média ponderada do fluxo de líquido (m/s) (AvgWtdFlowVel) 
 

 

3.4.3 Atualizar valores de dados do compartimento de proporção da corda 
Quando o medidor tiver operado por um número especificado pelo usuário de lotes consecutivos 
sem nenhuma falha de corda, o medidor atualizará os valores de dados de cada corda para o 
compartimento que contém a velocidade da corda, conforme mostrado na Equação 3-5, e definirá o 
indicador padrão do compartimento como FALSE. O ponto de dados PropUpdtBatches configurável 
por meio da tela Edit/Compare Configuration do MeterLink™, especifica o número de lotes 
consecutivos sem falhas necessários para atualizar os dados do compartimento (intervalo: [1,1000], 
padrão: 24). O ponto de dados NumVals (que determina a rapidez com que um valor médio muda)  
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também é configurável por meio da tela Edit/Compare Configuration (intervalo: [1,1000], padrão: 10). 

Equação 3-5: Atualização dos valores de dados do compartimento de proporção da corda 

 
 

 

AvgVelChordBinn+1 = posição da corda (n+1)th velocidade média (m/s) 

AvgVelChordBinn = posição da corda nth velocidade média (m/s) 

NumVals = ponto de dados do fator de atualização (sem dimensão) (NumVals) 

VChord = (lote atual) velocidade média de fluxo da corda (m/s) (FlowVelA ... 
FlowVelD) 

AvgPropChordBinn+1 = posição da corda (n+1)th do valor da proporção média (sem dimensão)  

AvgPropChordBinn = posição da corda nth do valor da proporção média (sem 

dimensão) 

PropChord = (lote atual) proporção da corda (sem dimensão) 

 

3.5 Valores de vazão volumétrica 
O medidor de vazão ultrassônico de líquidos Rosemount fornece dois valores de vazão volumétrica: 
bruto e com condição de vazão. 

A taxa de vazão volumétrica em condição de vazão pode incluir correção da expansão 
causada pela pressão e/ou temperatura do corpo do medidor. 

Observação 
Uma taxa de vazão volumétrica positiva indica o fluxo na direção direta, enquanto uma taxa de vazão 
volumétrica negativa indica o fluxo na direção inversa. 

 
3.5.1 Taxas de fluxo volumétrico bruto 

Equação 3-6: Taxa Bruta de Vazão Volumétrica 
 

 
 

Qraw=Raw= taxa de fluxo volumétrico "bruto" (m3/h) (QMeter) 

VCustomerCal= velocidade média de fluxo calibrada pelo cliente (m/s) (AvgFlow) 

π = constante geométrica, pi (sem dimensão) (3,14159...) 

Din= diâmetro interno do tubo (m) (PipeDiam) 
 

 

3.5.2 Taxa de vazão volumétrica com condição de vazão 
A taxa de vazão volumétrica com condição de vazão é o resultado da aplicação da correção de 
expansão à taxa de vazão volumétrica bruta, conforme mostrado na equação a seguir, sujeita ao corte 
de baixa vazão. 
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Se o valor resultante estiver abaixo do valor de corte de vazão baixa, ele é ajustado para zero. A taxa 
de vazão volumétrica de corte de baixa vazão (CutRate) é a velocidade de baixa vazão especificada 
(ZeroCut) convertida na taxa de vazão volumétrica. 

Equação 3-7: Taxa de vazão volumétrica com condição de vazão 

QFlow = (QRaw)(EpCorrP)(EpCorT) 

QFlow= taxa de vazão volumétrica em condição de vazão (m3/h) (QFlow) 

QRaw = taxa de fluxo volumétrico "bruto" (m3/h) (QMeter) 

ExpCorrP = fator de correção da expansão devido à pressão (sem dimensão) (ExpCorrPressure) 

ExpCorrT = fator de correção da expansão devido à temperatura (sem dimensão) 
(ExpCorrTemperature) 

 

 

3.5.3 Correção de expansão de pressão 
O medidor é capaz de corrigir as taxas brutas de vazão volumétrica para efeitos de expansão do tubo 
devido a mudanças de pressão. Observe que, para que o fator de correção da expansão do efeito da 
pressão seja calculado, a correção deve ser ativada (por meio do ponto de dados 
EnableExpCorrPress) e a pressão da condição de fluxo deve estar disponível (ou seja, o ponto de 
dados EnablePressureInput deve ser definido como "Live" (1) ou "Fixed" (2)). 

Equação 3-8: Correção de expansão de pressão 

 

ExpCorrP=  fator de correção da expansão devido à pressão (sem dimensão) (ExpCorrPressure) 

ß = deformação do tubo por unidade de tensão (MPaa-1) (StrainPerUnitStress) 

Pabs,f= pressão absoluta em condição de fluxo (MPaa) (AbsFlowPressure) 

Pref= pressão absoluta de referência (MPaa) (0,101325 MPaa) 
 

Equação 3-9: Deformação pelo efeito da pressão por unidade de esforço 

 

ß = deformação do tubo por unidade de tensão (MPaa-1) (StrainPerUnitStress) 

Dout = diâmetro externo do medidor ou da tubulação (m) (PipeOutsideDiameter) 

Din = diâmetro interno do medidor ou da tubulação (m) (PipeDiam) 

υ = Índice de Poisson (sem dimensão) (PoissonsRatio) 

E = Módulo de elasticidade de Young (MPaa) (YoungsModulus) 
 

 

3.5.4 Correção da expansão da temperatura 
O medidor é capaz de corrigir as taxas brutas de vazão volumétrica para efeitos de expansão do tubo 
devido a mudanças de temperatura. Observe que, para que o fator de correção de expansão por efeito 
de temperatura ser calculado, a correção deve ser ativada (por meio do ponto de dados 
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EnableExpCorrTemp) e a temperatura de condição de fluxo deve estar disponível (ou seja, o ponto 
de dados EnableTemperatureInput deve ser definidi para “Live”(1) ou “Fixed”(2). Consulte a 
Equação 3-10. 

Equação 3-10: Correção da expansão da temperatura 

 

ExpCorrT = fator de correção da expansão devido à temperatura (sem dimensão) 
(ExpCorrTemperature) 

α = coeficiente de expansão linear do tubo devido à temperatura (K-1) 
(LinearExpansionCoef) 

Tf = temperatura da condição de fluxo (K) (FlowTemperature) 

Tref = temperatura de referência para o coeficiente de expansão linear do tubo (K) 
(RefTempLinearExpCoef) 

 

3.5.5 Cálculo do número de Reynolds 
O Coeficiente de Reynolds é um valor sem dimensão que representa a natureza da vazão de líquido 
no tubo. O Coeficiente de Reynolds é calculado como mostrado na Equação 3-11. 

Equação 3-11: Coeficiente de Reynolds 

 
Re= Número de Reynolds (sem dimensão) (ReynoldsNumber) 

π = constante geométrica, pi (sem dimensão) (3,14159...) 

QRaw = taxa de fluxo volumétrico "bruto" (m3/h) (QMeter) 

P(PƒTƒ) = densidade de massa do fluido na condição de fluxo (especificado por meio de 
SpecRhoMixFlow) (kg/m3) (RhoMixFlow) 

Din = diâmetro interno do tubo (m) (PipeDiam) 

µ = viscosidade dinâmica (Pa•s) (Viscosity) 
 

 

3.5.6 Acumuladores de volume para frente e para trás 
Acumuladores de volume para frente e para trás da vazão 

O medidor de vazão ultrassônico de líquidos Rosemount Série 3810 fornece acumuladores de 
volume para frente e para trás para os dois valores de vazão volumétrica: condição bruta e 
condição de vazão. Cada acumulador de volume está na verdade armazenado como um par de 
dados: porção inteira de 64 bits, porção fracionada de pontos flutuantes de 32-bit. 

Por exemplo, um volume de 12345,750 m3 é armazenado como 12345 m3 para a parte inteira e 0,750 
m3 como a parte fracionária. Observe que enquanto uma taxa de vazão volumétrica pode ser positiva 
(indicando fluxo para frente) ou negativa (indicando fluxo na direção oposta), os acumuladores de 
volume são sempre valores positivos. Os pontos de dados do acumulador de volume não volátil estão 
listados na Tabela 3-2 abaixo: 
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Tabela 3-2: Pontos de dados do acumulador de volume não volátil 
 

Tipo de Taxa de 
Vazão Volumétrica 

Direção do fluxo para frente Direção do fluxo reverso 

 Inteira Fração Inteira Fração 

Bruta PosVolUncorr PosVolUncorrFrac NegVolUncorr NegVolUncorrFrac 

Condição de fluxo PosVolFlow PosVolFlowFrac NegVolFlow NegVolFlowFrac 

 
3.6 Diagnóstico do medidor de vazão de líquidos da Série 

3810 
Simetria 

A simetria é uma medida sem dimensão da simetria do fluxo, comparando as cordas superiores 
com as cordas inferiores, e pode ser lida por meio do ponto de dados Symmetry. O ideal é que a 
simetria seja 1,0. 

Observação 
Isso se aplica somente aos tipos de medidores 3814, de 4 vias. 

Fluxo cruzado 

O fluxo cruzado é uma medida sem dimensão da simetria do fluxo comparando as cordas de um lado 
do medidor com as cordas do outro lado. Pode ser lida usando o ponto de dados CrossFlow. 
Idealmente, o fluxo cruzado deve ser 1,0. 

Turbulência da corda 

A turbulência da corda é uma estimativa da turbulência (porcentagem) em um local de corda. Um 
valor é calculado para cada corda ativa e pode ser lido por meio dos pontos de dados TurbulenceA, 
TurbulenceB, TurbulenceC ou TurbulenceD. Um valor de 0% indica que nenhuma turbulência pode 
ser percebida. 

Fator de perfil 

Esse fator é uma proporção sem dimensões das velocidades da corda interna e da corda externa. 
Pode ser lido usando o ponto de dados ProfileFactor. Idealmente, o Fator de Perfil deve ser 
1,17 ±0,05 para medidores 3814 e 1,0 para medidores 3812. 

Ângulo de turbulência 

O ângulo de turbulência é uma estimativa da turbulência (até o grau mais próximo) e pode ser lido 
via ponto de dados SwirlAngle. É calculado como uma função do estilo do corpo do medidor (3814) 
e do Fator de Perfil. Um valor de 0 grau indica que nenhuma turbulência pode ser percebida. 

Detecção de fluxo reverso 

A direção do fluxo reverso é detectada se o medidor tiver acumulado um volume de fluxo reverso 
maior do que um limite configurável pelo usuário definido no Limite de volume de fluxo reverso. 
Consulte Alarme de fluxo reverso para configurar o limite de volume. 
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4 Configurações 

4.1 Métodos de calibração 
Calibração de fábrica e calibração definida pelo usuário 

O medidor de vazão ultrassônico de líquidos Rosemount Série 3810 usa duas correções de calibração: 

• Calibração de fábrica 

• Calibração do Cliente 

Nesta metodologia, os valores de "Calibração de fábrica" são definidos pela Emerson na fábrica e não 
se espera que sejam modificados; os valores de "Calibração do cliente" devem ser definidos como 
resultado de uma calibração de fluxo do usuário (se desejado). 

 
4.1.1 Método de calibração de fábrica 

Importante 
O interruptor WRITE PROT. no módulo da CPU deve ser desativado (OFF) antes de gravar os fatores de 
calibração no medidor. Depois que o medidor for configurado, ative o interruptor WRITE PROT. 
(LIGADO) para proteger a configuração contra gravação. Colete um registro de manutenção e um 
arquivo de configuração para as definições de configuração "As left" do medidor. 

 

 

Não se recomenda a modificação dos parâmetros de calibração de fábrica. Os parâmetros de calibração a seco 
não devem ser modificados, a menos que orientados pelo representante da Emerson. 

A velocidade do fluxo calibrada na fábrica é o resultado da aplicação de uma equação polinomial de 
terceira ordem à velocidade média ponderada do fluxo, conforme mostrado na Equação 4-1. 

 

Equação 4-1: Velocidade média de fluxo calibrada de fábrica 

 

VFactoryCal = velocidade média de fluxo calibrada de fábrica (m/s) (FactoryCalVel) 

VAvgWtd = velocidade média ponderada do fluxo (m/s) (AvgWtdFlowVel) 

A0 = calibração de fábrica coeficiente de 0ª ordem (m/s) (FwdA0 ou RevA0) 

A1 = coeficiente de 1ª ordem de calibração de fábrica (sem dimensões) (FwdA1 ou RevA1) 

A2 = Coeficiente de 2a ordem com calibração de fábrica (s/m) (FwdA2 ou RevA2) 

A3 = Coeficiente de 3a ordem com calibração de fábrica (s2/m2) (FwdA3 ou RevA3) RevA3) 
 

 

Observação 
O medidor fornece um conjunto de coeficientes de calibração de fábrica para cada direção de fluxo. 

O medidor fornece coeficientes de calibração de fábrica separados para cada direção de fluxo, 
conforme listado na tabela abaixo: 

CUIDADO 
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Tabela 4-1: Coeficientes de calibração de fábrica 
 

Nome de exibição do MeterLink™ Pontos de Dados, Opções e Orientações 

Forward A0 Pontos de dados afetados: 
• FwdA0 

Opções: 
• Digite um valor (m/s ou pés/s) dentro do intervalo [-1,1 m/s]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Forward A1 Pontos de dados afetados: 
• FwdA1 

Opções: 
• Insira um valor (sem dimensão) dentro do intervalo 

[0,95, 1,05] 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Forward A2 Pontos de dados afetados: 
• FwdA2 

Opções: 
• Digite um valor (s/m ou s/ft) dentro do intervalo [-0,1,0,1 

s/m]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Forward A3 Pontos de dados afetados: 
• FwdA3 

Opções: 
• •Insira um valor (s2/m2 ou s2/pés2) dentro do 

intervalo [0,1,0,1 s2/m2]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Reverse A0 Pontos de dados afetados: 
• RevA0 

Opções: 
• Digite um valor (m/s ou pés/s) dentro do intervalo [-1,1 m/s]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 
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Tabela 4-1: Coeficientes de calibração de fábrica (continuação) 

Nome de exibição do MeterLink™ Pontos de Dados, Opções e Orientações 

Reverse A1 Pontos de dados afetados: 
• RevA1 

Opções: 
• Insira um valor (sem dimensão) dentro do intervalo 

[0,95, 1,05] 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Reverse A2 Pontos de dados afetados: 
• RevA2 

Opções: 
• Digite um valor (s/m ou s/ft) dentro do intervalo [-0,1,0,1 

s/m]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

Reverse A3 Pontos de dados afetados: 
• RevA3 

Opções: 
• •Insira um valor (s2/m2 ou s2/pés2) dentro do 

intervalo [0,1,0,1 s2/m2]. 

Orientações: 
• Esse valor só deve ser modificado sob a orientação de um 

representante da Emerson. 

 

4.1.2 Método de calibração do cliente 
O Medidor de Vazão Ultrassônico para Líquidos Rosemount Série 3810 oferece fatores de medição 
para frente e para trás para a Calibração do Cliente. O método de Calibração do Cliente a ser usado é 
selecionado por meio do ponto de dados CalMethod, sendo None (0) o valor padrão (ou seja, não 
aplicar nenhum fator do medidor). 

Equação 4-2: Velocidade média de fluxo calibrada pelo cliente 

VCustomerCal = VFactoryCal 

VCustomerCal= Velocidade média de fluxo calibrada pelo cliente (m/s) (AvgFlow) 

VFactoryCal = Velocidade média de fluxo calibrada de fábrica (m/s) (FactoryCalVel) 
 

Para que o fator apropriado do medidor seja aplicado, o ponto de dados CalMethod deve ser definido 
como Fator do Medidor (“Meter Factor”) (3). Nesse caso, o medidor deve aplicar o fator do medidor 
apropriado, conforme mostrado na equação a seguir: 
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Equação 4-3MeterFactor: Velocidade média de fluxo calibrada pelo cliente (MeterFactor) 

VCustomerCal = VFactoryCal × MtrFctr 

VCustomerCal =  Velocidade média de fluxo calibrada pelo cliente (m/s) (AvgFlow) 

VFactoryCal = Velocidade média de fluxo calibrada de fábrica (m/s) (FactoryCalVel) 

MtrFctr = Fator do medidor (sem dimensão) em que MtrFctr = FwdMtrFctr if FactoryCalVel ≥0, 
RevMtrFctr de outra forma 

 

Selecione a Calibração do Cliente desejada configurando o ponto de dados listado na Tabela 4-2 ; 
na página do MeterLink™ Calibration - Meter Factors . 

Tabela 4-2: Calibração do Cliente 
 

MeterLink™ Nome de exibição Pontos de Dados, Opções e Orientações 

Flow calibration method Pontos de dados afetados: Opções de 
CalMethod: 

• Nenhuma (0) 

• Meter Factor (Fator de Medição) (3) 

• Método de alta viscosidade (Desativado - 
padrão) (Ativado) 

Orientações: Este valor só deve ser modificado sob a 
direção de um representante da Emerson. 

 

Observação 
Se o medidor de alta viscosidade precisar ser recalibrado, entre em contato com o Suporte ao 
Cliente da Emerson. 

 
4.1.3 Método de calibração de alta viscosidade 

Se o método de alta viscosidade estiver definido como "Enabled" (Ativado), a velocidade linear do 
fluxo será o resultado da aplicação do deslocamento do fluxo de alta viscosidade da calibração zero 
(FwdA0HighViscosity ou RevA0HighViscosity) e do fator do medidor de linearização por partes da 
alta viscosidade (LinearMtrFctrHighViscosity) à velocidade média ponderada do fluxo 
(AvgWtdFlowVel). 
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Figura 4-1: Configurar o método de alta viscosidade 

 

Fatores do medidor de alta viscosidade 

Tabela 4-3: Fatores do medidor de alta viscosidade com linearização por partes 
 

PWL Fatores do medidor de alta viscosidade direta Ponto de dados da série 3810 

Fator 1 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity1 

Fator 2 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity2 

Fator 3 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity3 

Fator 4 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity4 

Fator 5 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity5 

Fator 6 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity6 

Fator 7 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity7 

Fator 8 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity8 

Fator 9 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity9 

Fator 10 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity10 

Fator 11 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity11 

Fator 12 do medidor de alta viscosidade de linearização por partes para frente FwdMtrFctrHighViscosity12 

 
Tabela 4-4: Linearização por partes fatores reversos do medidor de alta viscosidade 

 

PWL reverso Fatores de medidores de alta viscosidade Ponto de dados da série 3810 

Fator 1 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity1 

Fator 2 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity2 

Fator 3 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity3 

Fator 4 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity4 

Fator 5 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity5 

Fator 6 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity6 

Fator 7 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity7 
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Tabela 4-4: Linearização por partes fatores reversos do medidor de alta viscosidade 
(continuação) 
PWL reverso Fatores de medidores de alta viscosidade Ponto de dados da série 3810 

Fator 8 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity8 

Fator 9 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity9 

Fator 10 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity10 

Fator 11 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity11 

Fator 12 do medidor de alta viscosidade reverso de linearização por partes RevMtrFctrHighViscosity12 
 

Tabela 4-5: Parâmetros de desvio de alta viscosidade da calibração zero 
 

Parâmetro de calibração zero Ponto de dados da série 3810 

Compensação de fluxo direto de alta viscosidade com calibração zero FwdA0HighViscosity 

Calibração zero da compensação de fluxo reverso de alta viscosidade RevA0HighViscosity 

 
4.1.4 Calibrar os fatores do medidor 

Calibrar os parâmetros do fator do medidor 

Procedimento 

1. Use o menu Calibration → Meter Factors e selecione Flow Calibration Method → Meter 
Factor no menu suspenso. 

2. Insira os fatores do medidor para frente e para trás apropriados e clique em Write para 
enviar os fatores ao medidor. 

 
3. Para aplicações de alta viscosidade, use o menu Calibration → Meter Factors e selecione Flow 

Calibration Method → Meter Factor no menu suspenso. 
• Selecione High Viscosity Method Enabled  no menu suspenso. Consulte Método de 

calibração de alta viscosidade para obter parâmetros de configuração adicionais. 
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4. Clique em Close para sair da caixa de diálogo. Para validar alterações feitas, clique em 
Write. 

5. Depois que o medidor for configurado, ajuste a chave WRITE PROT. no Módulo da CPU para a 
posição ON para proteger a configuração contra gravação. 

 
4.1.5 Configurar os parâmetros de calibração de fluxo 

Procedimento 

1. Use o menu Calibration → Flow Calibration e selecione Flow Calibration Type 
(cronometrado ou fechado). Uma calibração com passagem registra o volume visto entre os 
fechamentos das chaves diretamente de um provador para o número de passagens 
necessárias para que o provador faça uma execução. 

a) Clique em Calibração Timed para que o medidor registre o volume através do medidor 
durante um período de tempo especificado pelo usuário para uma execução de 
calibração. Use os botões de rotação ou digite o número de passagens de um provador 

para fazer uma execução. 

Figura 4-2: Diálogo de configuração da calibração de fluxo cronometrado 

 
 

b) Clique em Change para mudar o local da pasta onde o arquivo de registro de 
calibração é salvo. 

2. Clique em Gated e use os botões de rotação ou digite o número de passagens de um 
provador para fazer uma execução. Uma calibração com passagem registra o volume visto 
entre os fechamentos das chaves diretamente de um provador para o número de passagens 
necessárias para que o provador faça uma execução. 

3. Selecione a detecção de início/parada da entrada de calibração em uma das seguintes opções: 
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Figura 4-3: Extremidade fechada, ativa alta: 

 
 

Figura 4-4: Extremidade controlada, ativa baixa: 
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Figura 4-5: Estado fechado, ativa alta: 

 
 

Figura 4-6: Estado fechado, ativa baixa: 

 
 

4. Clique em OK para aplicar os parâmetros selecionados. 
Um arquivo do Microsoft Excel® é gerado e o relatório de registro de calibração pode ser 
salvo ou anexado a um arquivo existente. 

5. Clique em Cancel para fechar a caixa de diálogo sem fazer alterações. Se você tiver feito 
alterações, clique em Write para aplicar as alterações. 

6. Depois que os parâmetros de calibração de fluxo forem configurados, coloque a chave WRITE 
PROT. no módulo da CPU na posição ON para proteger a configuração contra gravação. 
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4.1.6 Calibração zero 
Menu de Calibração 

A caixa de diálogo Calibração de zero permite zerar um medidor ultrassônico de líquido Rosemount 
que esteja em uma condição sem fluxo. 

Quando a caixa de diálogo for exibida, o MeterLink™ começará a ler e traçar o gráfico da velocidade 
de fluxo medida pelo medidor. Os LEDs de status também serão atualizados para informar quaisquer 
avisos ou alarmes. 

Calibração fluxo zero 

Pré-requisitos 

Antes de realizar uma calibração: 

• Se esta for a primeira vez que um medidor é iniciado, faça passar um fluxo suficiente pelo 
medidor para remover qualquer ar preso no medidor e na face dos transdutores antes de 
bloquear o medidor. 

• Certifique-se de que todo o volume do medidor esteja cheio com o fluido do processo. 

• Dê tempo suficiente após o bloqueio do medidor antes de iniciar a calibração para garantir que 
não haja fluxo através do medidor. 

• A velocidade do medidor informada pelo MeterLink™ deve ser estável e muito próxima do fluxo zero. 

Opções de calibração 

Antes de iniciar a calibração de zero, você pode ajustar o tempo de zero, que é o período de tempo em 
que o MeterLink coleta dados do medidor para a calibração. Diminuir esse valor pode aumentar a 
chance de aprovação na calibração, mas pode produzir uma calibração de qualidade inferior. Aumentar 
esse valor pode diminuir a chance de aprovação na calibração, mas pode melhorar a qualidade da 
calibração. Quatro minutos é o tempo recomendado para realizar uma calibração de zero. O tempo pode 
ser ajustado de 2 minutos a 10 minutos. 

Selecione Gerar relatório após gravar a calibração de zero no medidor se quiser um relatório do Excel® dos 
parâmetros de calibração "As Found" e "As Left". Os pontos de dados da configuração estendida do 
medidor são incluídos no relatório. Todos os dados coletados durante a calibração também serão salvos no 
medidor. Essa opção só estará disponível se o Microsoft® Excel® estiver instalado no computador que estiver 
executando o MeterLink. Se você não selecionar essa opção ou se ela não estiver disponível, as alterações 
dos parâmetros de calibração ainda serão registradas no registro de auditoria de arquivo do medidor. 

A configuração estendida inclui alguns pontos de dados somente leitura que ajudam a descrever a 
configuração do medidor. Os pontos de dados somente leitura são exibidos com um fundo cinza apenas 
para referência e não podem ser alterados. Os pontos de dados de configuração estendida podem ser 
visualizados nas caixas de diálogo Relatório de registros de manutenção, Relatório de registros de 
arquivamento, Calibração de fluxo, Calibração zero e na ferramenta Editar/Comparar configuração. 

Realização de uma calibração 

Procedimento 

1. Use o menu Calibration → Zero Calibration. 
2. Inicie a calibração clicando em Start Zero. A calibração será iniciada e executada durante o 

período de tempo definido em Zero time (Tempo zero). 
A velocidade média do fluxo é o valor usado para ajustar os coeficientes FwdA0 e RevA0 no 
medidor para que eles removam o fluxo de compensação em condições de ausência de fluxo. 

3. O desvio máximo estimado também é calculado para ajudar a verificar se o medidor está sem 
fluxo e é usado para definir critérios de aprovação/reprovação para a calibração. 
Será gerado um erro se o desvio máximo estimado for maior que 0,002 pés/s ou 0,0006 m/s. 
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4. Quando a calibração for concluída e não forem encontrados erros, clique em Write to 
Meter para enviar as alterações ao medidor. 
Se forem relatados erros após a calibração, a calibração não poderá ser gravada no medidor. 

5. Se você tiver selecionado a geração de um relatório, o MeterLink exibirá uma caixa de 
diálogo perguntando se você deseja exibir o relatório depois de criado. 

6. Clique em Stop Zero, a qualquer momento durante uma calibração, para interromper a 
calibração. 

7. Clique em Discard quando uma calibração for concluída sem erros, para cancelar a calibração 
e configurar a caixa de diálogo para realizar uma nova calibração. 

8. Clique em Close para fechar a caixa de diálogo Zero Calibration (Calibração de zero). 

 
4.1.7 Volumes Delta Disparados 

O recurso "volume delta acionado" oferece a capacidade de medir o volume total do fluxo de 
líquido entre dois acionamentos de eventos externos sucessivos. 

Para disparar um evento, estabeleça o ponto de dados DoUpdtTrigDeltaVols como TRUE. O 
medidor então salva os valores de volume acumulado atuais em condições de vazão e de 
referência (para frente e na direção oposta) O medidor então calcula a diferença entre esses 
valores e os valores correspondentes salvos do disparo do evento anterior. Por fim, o 
medidor insere os valores do volume delta nos pontos de dados apropriados 
(TrigDeltaPosVolFlow e TrigDeltaNegVolFlow) e estabelece o ponto de dados 
DoUpdtTrigDeltaVols para FALSE para limpar o disparo e indicar que o cálculo está 
completo. 

A funcionalidade do volume delta disparado é retida ao longos ciclos de energia, enquanto os 
valores do volume acumulado no último disparador de eventos são salvos em memória não 
volátil. 

Os pontos de dados do volume delta são armazenados internamente em memória não volátil como 
números flutuantes de dupla precisão. Os pontos de dados do volume delta podem ser lidos via 
Modbus como valores flutuantes de 32 bits ou como valores inteiros (usando o par de registro LONG 
[transbordo, inferior] de modo similar à leitura dos volumes acumulados). 

Sugestão de Lógica de Acesso 

Os pseudocódigos a seguir demonstram a lógica para acessar a funcionalidade do volume delta: 

Configuração inicial: Certifique-se de que as unidades Modbus estão configuradas como 
desejado: defina o registro 95 de Modbus (UnitsSystem) em 0 para unidades americanas e 
em 1 para unidades métricas. 

Ciclo periódico: 

• Espere por um evento externo para sincronizar o início dos volumes delta no medidor. Enviar 
mensagem Modbus de acionamento: definir o registro Modbus 1482 (DoUpdtTrigDeltaVols) 
como 1 (TRUE). 

• Leia o registro de disparo 1482 do Modbus (DoUpdtTrigDeltaVols) em um ciclo até que seja lido 

como 0 (FALSE) indicando que os volumes delta foram atualizados. 

• Leia o registro de disparo 1482 do Modbus (DoUpdtTrigDeltaVols) em um ciclo até que seja lido 

como 0 (FALSE) indicando que os volumes delta foram atualizados. 

• Leia o registro de disparo 1482 do Modbus (DoUpdtTrigDeltaVols) em um ciclo até que seja lido 

como 0 (FALSE) indicando que os volumes delta foram atualizados. 

• Leia os registros de volume delta (tanto os registros FLOAT como os pares de registros LONG 
em uma única leitura no Modbus. Se os registros de volume delta forem lidos como pares de 
registros LONG, calcule cada volume delta da seguinte maneira: 
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Equação 4-4: Volumes Delta Disparados 

 
 

onde 

DeltaVolume = Volume delta acionado (para frente ou para trás, condição de fluxo ou condição de 
base) (m3 ou ft3) (TrigDeltaPosVolFlow, TrigDeltaNegVolFlow, TrigDeltaPosVolBase, 
TrigDeltaNegVolBase) 
Excesso de fluxo = Valor inteiro de estouro do volume delta acionado (para frente ou para trás, 
condição de fluxo ou condição de base) (1e9m3 ou 1e9ft.3) 
Inferior = Valor inteiro inferior do volume delta acionado (para frente ou para trás, condição de 
fluxo ou condição de base) (m3 ou ft.3) 

Repita o “CICLO PERIÓDICO”. 

 
4.2 Calibração de entradas e saídas analógicas 

 

A chave WRITE PROT. no módulo da CPU deve estar desativada ou os valores de calibração não serão 
atualizados para um medidor. 

Uma entrada analógica pode ser calibrada independentemente do tipo de entrada correspondente, 
pressão ou temperatura. Porém, se o tipo de entrada correspondente é ajustado para ativa (Live), a 
entrada calibrada então é considerada inválida e o valor em uso depende da seleção 
FlowPOrTSrcUponAlarm (ver acima). Neste caso, o ponto de dados apropriado 
(FlowPressureWhileCal, FlowTemperatureWhileCal) é ajustado para o valor em uso de forma que 
possa ser registrado no registro opcional de Auditoria. 

O desvio e o ganho podem ser restabelecidos para os valores padrão (0 e 1, respectivamente) clicando 
o botão Reset Defaults. 

 

Clicar no botão Reset Defaults grava o desvio e o ganho imediatamente – os valores anteriores não 
podem ser restaurados. 
Clique em Edit Scaling para modificar a escala da entrada. 

 

 

As alterações feitas nos valores de desvio, ganho e escala de uma entrada analógica são gravadas no 
registro. 

No MeterLink™, selecione Calibrate para fazer alterações usando o Assistente de Entradas Analógicas. 

Procedimento 

1. Escolha a entrada analógica a ser calibrada, temperatura ou pressão, e clique em Next 
(Avançar). A tela Current → Calibration mostra a compensação e o ganho de corrente e a 
escala de entrada (ou seja, as pressões ou temperaturas correspondentes às entradas mínima 
(4 mA) e máxima (20 mA)). 

2. Clique em Next para ir para a tela Calibration → Method e, em seguida, selecione os 
métodos de calibração de deslocamento ou de dois pontos. 

• O método de desvio requer um único ponto de calibração e afeta apenas o parâmetro de 
offset de calibração da entrada. 

DeltaVolume = (Overflow × 1e9) + Lower 
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• A calibração de dois pontos requer a calibração em dois pontos diferentes (idealmente 
muito distantes em valor) e afeta os parâmetros de ganho e deslocamento de calibração 
da entrada. Dependendo do método de calibração selecionado, uma ou duas telas 
aparecerão quando o botão Next é clicado. 

3. A(s) tela(s) exibe(m) a leitura atual (ao vivo). Quando a entrada estiver estável, clique no botão 
Hold para congelar a leitura atual. 

4. Digite o valor correto na caixa de edição Actual. Por fim, a tela Finish mostra os novos 
valores de desvio e de ganho. 

Figura 4-7: Calibração de desvio 

 
 

5. Clique em Finish para gravar os valores no medidor. Se o medidor não estiver configurado 
para usar valores ativos da entrada analógica para cálculo, será exibido um prompt solicitando 
a alteração da configuração para usar a entrada ativa. 

6. Ative o interruptor WRITE PROT. no módulo da CPU para proteger a configuração contra 
gravação. 
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Tabela 4-6: Calibrar entradas e saídas analógicas 
 

Nome de exibição 

do MeterLink™ 

Pontos de Dados, Opções e Orientações 

Current output 
Output setting 

Pontos de dados afetados: 
• AO1TestModeOutputPercent 

Opções: 

• Entrar a porcentagem inteira da escala completa para a saída analógica 
dentro da faixa [0, 100%], onde 0% corresponde à saída mínima (4 mA) e 
100% corresponde à saída máxima (20 mA). 

Orientações: 

• O valor de teste especificado entra em vigor em um período de lote 
após clicar no botão Start. 

Current output Start 
(Stop) AO1 

Pontos de dados afetados: 
• IsAO1EnableTest 

Opções: 
• Clique no botão StartAO1 para entrar no modo de teste (TRUE). 

 

Observação 
O botão Iniciar se tornará o botão Stop depois de clicar nele. 

 

• Clique no botão StopAO1 para sair do modo de teste (FALSE). 
 

Observação 
O botão Stop se tornará o botão Start depois de clicar nele. 

 

Orientações: 

• O valor de teste especificado entra em vigor em um período de lote 
após clicar no botão Start. 

Current output 
Output setting 

Pontos de dados afetados: 
• AO2TestModeOutputPercent 

 Opções: 
 • Entrar a porcentagem inteira da escala completa para a saída analógica 

dentro da faixa [0, 100%], onde 0% corresponde à saída mínima (4 mA) e 
100% corresponde à saída máxima (20 mA). 

 Orientações: 
 • O valor de teste especificado entra em vigor em um período de lote 

após clicar no botão Start. 

 
 

 

Observação 
O AO2 só está disponível com o módulo da CPU, número de 
peça 1-360-03-010. 
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Tabela 4-6: Calibração de entradas e saídas analógicas (continuação) 

Nome de exibição 

do MeterLink™ 

Pontos de Dados, Opções e Orientações 

 Pontos de dados afetados: 
• IsAO2EnableTest 

Opções: 
• Clique no botão StartAO2 para entrar no modo de teste (TRUE). 

 

Observação 
O botão Iniciar se tornará o botão Stop depois de clicar nele. 

 

• Clique no botão StopAO2 para sair do modo de teste (FALSE). 
 

Observação 
O botão Stop se tornará o botão Start depois de clicar nele. 

 

Orientações: 

• O valor de teste especificado entra em vigor em um período de lote 
após clicar no botão Start. 

 

O tempo máximo que uma saída analógica pode permanecer no modo de teste é 
especificado através do ponto de dados NonNormalModeTimeout. Observe que este 
ponto de dados também se aplica a outros testes. O ponto de dados 
NonNormalModeTimeout pode ser alterado usando a tela do MeterLink Edit/Compare 
Configuration. Ele pode ser definido dentro do intervalo [1, 30 min] e tem um valor 
padrão de 2 min. 

 
4.3 Configurar fontes de saída de frequência/digital 

O medidor tem três saídas configuráveis pelo usuário que podem ser configuradas para 
uma saída de frequência ou saída digital (FODO). 

• FODO1 (oito possíveis configurações de parâmetros) [Tipo 2] [Tipo 4] 

• FODO2 (oito possíveis configurações de parâmetros) [Tipo 2] [Tipo 4] 

• FODO3 (oito possíveis configurações de parâmetros) [Tipo 2] [Tipo 4] 

• FODO4 (oito possíveis configurações de parâmetros) [Tipo 4] 

• FODO5 (oito possíveis configurações de parâmetros) [Tipo 4] 

• FODO6 (oito possíveis configurações de parâmetros) [Tipo 4] 
— (DI1Mode deve ser definido como Frequency/Digital Output 6 para ativar o FODO6) 

Opções de fonte de saídas de frequência ou digitais (FODO1, FODO6) ∼ Grupo 1 

• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B 

• A saída de frequência 1A é a fase A do conteúdo da saída de frequência 1 (taxa de fluxo de volume 
não corrigida, fator de perfil) 

• A frequência da saída 1B é a saída da fase B da saída de frequência 1 

• A saída de frequência 2A é baseada no conteúdo da frequência (real - taxa de fluxo não 
corrigida, fator de perfil) 

• A saída de frequência 2B é baseada no conteúdo da frequência e na Fase de Frequência 2B 

• A saída digital 1A é baseada no conteúdo da saída digital1A (Validade da saída de frequência 
1, direção do fluxo) 
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• A saída digital 1B é baseada no conteúdo da saída digital 1B (Validade da saída de frequência 
1, direção do fluxo) 

• A saída digital 2A é baseada no conteúdo da saída digital 2A (Validade da saída de frequência 
2, direção do fluxo) 

• A saída digital 2B é baseada no conteúdo da saída digital 2B (Validade de Frequência da Saída 
2, Direção do Fluxo) 

Opções de origem das saídas de frequência ou digitais (FODO2, FODO3, FODO4, FODO5) ∼ 
Grupo de Saídas 2 

• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B 

• A saída de frequência 1A é a fase A do conteúdo da saída de frequência 1 (taxa de fluxo de volume 
não corrigida, fator de perfil) 

• A frequência da saída 1B é a saída da fase B da saída de frequência 1 

• A saída de frequência 2A é a fase A do conteúdo da saída de frequência 2 (taxa de fluxo de volume 
não corrigida, fator de perfil) 

• A frequência da saída 2B é o conteúdo da fase B da saída de frequência 2 

• A saída digital 1A é baseada no conteúdo da saída digital1A (Validade da saída de frequência 
1, direção do fluxo) 

• A saída digital 1B é baseada no conteúdo da saída digital 1B (Validade da saída de frequência 
1, direção do fluxo) 

• A saída digital 2A é baseada no conteúdo da saída digital 2A (Validade da saída de frequência 
2, direção do fluxo) 

• A saída digital 2B é baseada no conteúdo da saída digital 2B (Validade de Frequência da Saída 
2, Direção do Fluxo) 

Modos 

• Coletor Aberto (requer tensão de alimentação externa e resistor de pull-up) 

• TTL (alimentado internamente pelo sinal de 0-5 VDC do medidor) 

Fases do Canal B: 

• Atrasar para frente, Conduzir para direção oposta (a Fase B atrasa a Fase A enquanto indica 
fluxo para frente, conduz a Fase A enquanto indica fluxo na direção oposta) 

• Conduzir para frente, Atrasar na direção oposta (a Fase B conduz a Fase A enquanto indica 
fluxo para frente, atrasa a Fase A enquanto indica fluxo na direção oposta) 

Saída da Fase A e Fase B (com base na direção de fluxo) 

• Fluxo na direção oposta - a saída informa apenas o fluxo na direção oposta. Para saídas de 
frequência, a Fase B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Fluxo para frente - a saída informa apenas o fluxo que flui para frente. Para saídas de frequência, 
a Fase B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Absoluto - a saída indica o fluxo que flui em ambas as direções. Para saídas de frequência, a Fase 
B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Bidirecional - a saída indica, na Fase A, o fluxo que flui para frente e, na Fase B, o fluxo que 
flui na direção oposta. 
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Frequência máxima das saídas de frequência 

• 1000 Hz 

• 5000 Hz 
 

Saída de Frequência/Digital Configuração da fonte 

Saída de Frequência/Digital 1 

Saída de Frequência/Digital 2 

Saída de Frequência/Digital 3 

Saída de Frequência/Digital 4 

Saída de Frequência/Digital 5 

Saída de Frequência/Digital 6 

• Saída de frequência 1A 

• Saída de frequência 1B 

• Saída digital 1A 

• Saída digital 1B 

• Saída de frequência 2A 

• Saída de frequência 2B 

• Saída digital 2A 

• Saída digital 2B 

 

 

 
A saída para FODO1 e a entrada digital 1 (Grupo 1 no módulo da CPU) compartilham um 
aterramento comum e têm isolamento de 50 V. O FODO2 e FODO3 (Grupo 2 no Módulo da CPU) 
compartilham o mesmo aterramento e possuem isolamento de 50 V. Isso permite que uma saída 
seja conectada a um computador de análise de fluxo diferente. As saídas são opto-isoladas do 
Módulo da CPU e possuem tensão suportável de, pelo menos, 500V rms dielétricos. 

Figura 4-8: Módulo da CPU - Aterramento compartilhado das Saídas de Frequência/Digitais - Tipo 2 

 

A. FODO1 e Entrada Digital1 - aterramento compartilhado (Grupo 1) 
B. FODO2 e FODO3 - aterramento compartilhado (Grupo 2) 
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Figura 4-9: Módulo da CPU - Aterramento compartilhado das Saídas de Frequência/Digitais - Tipo 4 

 

A. FODO1 e DI1/FODO6 - Aterramento compartilhado - Módulo de CPU tipo 4 (Grupo 1) 
B. FODO2, FODO3, FODO4 e FODO5 - Aterramento compartilhado - Módulo de CPU tipo 4 

(Grupo 2) 

 

4.4 Configuração de entradas/saídas digitais 
Entrada digital 

O medidor de vazão ultrassônico para líquidos Rosemount 3810 fornece uma entrada digital 
(referida como DI1). A polaridade da entrada é configurada através do ponto de dados 
DI1IsInvPolarity como segue: 

• FALSE – polaridade normal (padrão), ou 

• TRUE – polaridade invertida 

A entrada digital não é configurável por meio do Assistente de configuração de campo do 
MeterLink™. Ela deve ser configurada por meio do MeterLink Tools → Edit/Compare Configuration. 

Calibração de entrada digital 

O IsDI1UsedForCal especifica se a entrada digital 1 (DI1) é usada para fins gerais (quando definida 
como FALSE) ou para sincronizar a calibração (quando definida como TRUE). Se usada para calibração, 
a polaridade é determinada pelo ponto de dados IsDI1ForCalActiveLow, selecione um dos seguintes: 

• FALSE - uso geral (configuração padrão), ou 

• TRUE - para sincronizar a calibração 

O ponto de dados IsDI1ForCalActiveLow especifica a polaridade para a entrada digital 1 (DI1) 
quando ela é configurada (via IsDI1UsedForCal) para uso na sincronização de uma calibração. 
Consulte também IsDI1ForCalStateGated. 

• FALSE = Cal Active High 

• TRUE = Cal Active Low (padrão) 

O ponto de dados IsDI1ForCalStateGated especifica o gating de calibração para a entrada digital 
1 (DI1) quando ela é configurada (via IsDI1UsedForCal) para uso na sincronização de uma 
calibração. 
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Quando FALSE, a calibração é iniciada/interrompida por meio de uma borda inativa → ativa; quando 
TRUE, a calibração é iniciada por meio de uma mudança de status de inativa → ativa e interrompida 
por meio de uma mudança de status de ativa → inativa. A borda/status ativo é especificado por 
meio do ponto de dados IsDI1ForCalActiveLow. 

• FALSE = Cal Edge Gated (padrão) 

• TRUE = Cal State Gated 

 
Saída digital 

Selecione a função de configuração para a saída digital. As opções disponíveis são validity e direction. 

A opção de operação invertida é útil se a saída do medidor ultrassônico for invertida em relação ao 
que o computador de fluxo espera. Isso significa que se a saída normalmente indica HIGH para uma 
condição TRUE, marcar esta caixa de seleção altera a saída para que ela indique LOW para uma 
condição TRUE. 

 
4.5 Configuração das saídas de frequência 

A opção Frequency outputs permite configurar as saídas de frequência disponíveis para o medidor. 

Se você tiver configurado anteriormente uma ou mais saídas de Frequência/Digital, faça seleções 
para os seguintes parâmetros: 

Teor: 

• As saídas válidas são baseadas em taxas de fluxo não corrigidas (reais). 

• Os medidores ultrassônicos de líquidos Rosemount™ também permitem definir as saídas para 
o fator de perfil. 

“Direction” (Direção): 

• Reverse (Direção Oposta): A saída informa apenas o fluxo para trás. Para saídas de frequência, a 
Fase B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Forward (Para frente): A saída informa apenas o fluxo para frente. Para saídas de frequência, a 
Fase B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Absolute (Absoluto): A saída informa o fluxo que flui em ambas as direções. Para saídas de 
frequência, a Fase B da saída encontra-se 90 graus defasada em relação à Fase A. 

• Bidirectional (Bidirecional): A saída informa, na Fase A, o fluxo que flui para frente e, na Fase B, o 
fluxo que flui para trás. 

Saída de frequência máxima: 

• As opções válidas de saída de frequência são 1000 Hz e 5000 Hz. 

Os campos a seguir são usados para configurar as saídas de frequência selecionadas para gerar uma 
taxa de fluxo volumétrico. Os campos só serão ativados se o conteúdo da saída associada estiver 
definido como Uncorrected (Actual) (Não corrigido (real)). 

Taxa de vazão volumétrica total utilizada com a saída: 

• Insira a taxa de vazão para ser equivalente à frequência máxima da saída de frequência. Esta 
propriedade é desabilitada se as Saídas de Frequência foram desmarcadas na Página Inicialização. 
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Fator K: 

Um valor somente leitura que exibe o fator K calculado a partir da Taxa de vazão volumétrica total, que 
é utilizado com as saídas de frequência e a Frequência máxima da saída de frequência. Esta 
propriedade é desabilitada se as Saídas de Frequência foram desmarcadas na Página Inicialização. 

Vol/pulso: 

Um valor somente leitura que exibe o inverso calculado do fator K. Esta propriedade é desabilitada se 
as Saídas de Frequência foram desmarcadas na Página Inicialização. 

Velocidade: 

• Velocidade mínima utilizada com a saída: Insira a velocidade para ser equivalente à 
frequência máxima da saída de frequência. Esses valores só serão ativados se o Conteúdo for 
definido como Velocidade média do fluxo ou Velocidade média do som. Esta propriedade é 
desabilitada se as Saídas de Frequência foram desmarcadas na Página Inicialização. 

• Velocidade mínima utilizada com a saída: Insira a velocidade para ser equivalente à frequência 
mínima (isto é, 0Hz) da saída de frequência. Esses valores só serão ativados se o Conteúdo for 
definido como Velocidade média do fluxo ou Velocidade média do som. Esta propriedade é 
desabilitada se as Saídas de Frequência foram desmarcadas na Página Inicialização. 

 
4.6 Modo de teste das saídas 

O medidor de vazão ultrassônico para líquidos Rosemount 3810 oferece um modo de operação para 
testar a frequência, a corrente (analógica) e os sinais de saída digitais. Para entrar, configurar e sair 
desse modo, defina os pontos de dados usando MeterLink Tools → Outputs Test. 

A caixa de diálogo Outputs Test permite monitorar os valores ativos de todas as saídas de 
frequência, corrente (analógica) e digitais. Além disso, as saídas podem ser definidas em um Modo 
de Teste para forçar as saídas a valores específicos definidos pelo usuário. Essa caixa de diálogo está 
disponível apenas enquanto estiver conectado a um medidor. 

Procedimento 

1. Quando a caixa de diálogo abre pela primeira vez, as saídas disponíveis mostram os 
valores ativos atuais. O LED "Test mode" permanecerá cinza enquanto não estiver no modo 
de Teste. 
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Figura 4-10: Página de Teste de Saídas do Medidor 

 
 

Observação 
O AO2 só está disponível com o módulo da CPU, número de peça 1-360-03-010. 

2. Para fixar as saídas de frequência e de corrente em um valor definido pelo usuário, insira a 
porcentagem desejada no parâmetro de saída ("Output setting"). Para os medidores de vazão 
ultrassônicos de líquidos Rosemount 3810, cada saída disponível tem controle de saída 
individual e pode ser definida de 0 a 150%. A escala de 100% indica o valor total da escala para 
as saídas de frequência e pode ser alterada no assistente de configuração de campo. 

Para os medidores de vazão ultrassônicos de líquidos Rosemount 3810, cada saída disponível 
tem controle de saída individual e pode ser definida de 0 a 150%. 

A escala de 100% indica o valor total da escala para as saídas de frequência e pode ser 
alterada no assistente de configuração de campo. 

3. Clique em Start para entrar no modo de teste. 

Cada saída tem seu próprio botão de início, de forma que cada saída disponível pode ser 
testada uma de cada vez. 

As saídas de frequência e de corrente não serão atualizadas até o final do próximo ciclo 
de lote. 
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Observação 
As saídas de frequência para os canais A e B são exibidas. Se a opção Canal B zero em caso de 
erro for selecionada no Assistente de configuração de campo, a fase do Canal B mostrará 
zero porque a saída de frequência é considerada inválida durante o modo de teste. 

 
 

Observação 
O Fator K e o Fator K Inverso serão mostrados nas saídas de frequência configurados para a 
taxa de vazão volumétrica. Os valores serão mostrados ao lado da etiqueta para a saída de 
frequência associada. 

Quando o LED do modo de teste ficar verde, os valores de saída exibidos representarão os 
valores que as saídas estão acionando durante o teste. 

4. Para configurar as saídas digitais como um estado conhecido, selecione Test High ou Test 
Low para a saída digital apropriada e clique no botão Start daquela saída digital. 

Observação 
O tempo limite para cada saída no modo de teste é redefinido pelo MeterLink™ toda vez que 
os valores são atualizados. Enquanto esta caixa de diálogo estiver aberta com uma saída no 
modo de Teste, a saída permanecerá em tal modo até que o botão Stop seja clicado para 
encerrar o teste 

 

 
 

Observação 
Caso haja perda de comunicação entre o MeterLink e o medidor (antes que um modo de 
teste seja interrompido), o medidor encerrará automaticamente o modo de teste depois que 
o NonNormalModeTimeout tiver expirado. Isto pode demorar de 1 a 30 minutos, 
dependendo dos parâmetros . Como padrão, o tempo é definido como dois minutos. 

Uma vez que o LED "Test mode" ficar verde, o valor mostrado para as saídas representará os 
valores que as saídas estão usando no teste. 

5. O parâmetro de saída ("Output setting") apenas pode ser alterado enquanto estiver fora do 
modo de Teste. Para encerrar o modo de Teste, clique em Stop e aguarde o fim do lote e o 
LED Test mode ficar cinza para indicar que as saídas estão usando valores ativos. 

6. Clique em Cancel para fechar a caixa de diálogo. 
Se o medidor estiver no modo de Teste ao clicar o botão Cancel, o MeterLink encerrará 
primeiro o modo de Teste antes de retornar à Tela Principal. 

 
4.7 Configuração das saídas HART®  

Configure as saídas HART do medidor ultrassônico Rosemount. Para informações adicionais, 
consulte o Manual de especificações do dispositivo de campo HART (00825-0400-3240). 

 
4.7.1 Configuração das quatro variáveis dinâmicas 

• Primária - definida para corresponder ao Content for Current Output 1 

• Secundária - definida para corresponder ao Content for Current Output 2 

• Terciária- selecione entre as seguintes variáveis: Taxa de fluxo não corrigida, Velocidade média 
do fluxo, Velocidade média do som, Pressão e Temperatura 

• Quartenária - selecione entre as seguintes variáveis: Taxa de fluxo não corrigida, 
Velocidade média do fluxo, Velocidade média do som, Pressão e Temperatura 

https://www.emerson.com/documents/automation/quick-start-guide-rosemount-3410-series-gas-ultrasonic-flow-meters-hart-field-device-specification-en-44044.pdf
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4.7.2 Configuração da identificação do dispositivo 
Configure as variáveis comuns nos dispositivos HART® usadas para identificar o dispositivo específico. 

• Tag - Esse é o nome de identificação do dispositivo HART que pode ser utilizado pelos sistemas 
host para identificar exclusivamente o medidor. A identificação pode conter até 8 caracteres. 

• Long tag - O nome longo de identificação especificado corresponde ao do medidor. A tag pode 
ter 32 bytes de comprimento. 

• Date - Um valor de 3 bytes em que o byte mais significativo é o dia do mês (1-31), o segundo byte 
é o mês do ano (1-12) e o terceiro byte é o ano de 1900. 

• Message - Esse é um valor de cadeia de caracteres que não pode conter mais de 32 caracteres. 

• Descriptor - Esse é um valor de cadeia de caracteres que não pode conter mais de 32 caracteres. 

• Final assembly number - Esse é um valor numérico que deve estar entre 0 e 1677215. 

• Polling address - Este é o endereço HART do medidor. Por padrão, o medidor é definido para 
0, mas o endereço pode variar de 0 a 63. 

 
4.7.3 Configuração das unidades HART® 

Configure as unidades nas quais os valores serão lidos pela interface HART: 

• Unidades de volume 

• Velocidade média do som 

• Unidades de tempo da taxa de fluxo 

• Velocidade 

• Pressão 

• Temperatura 

 
4.8 Configuração das correções do medidor 

4.8.1 Correção da expansão da temperatura 
• Coeficiente de expansão linear do material do corpo do medidor 

• Temperatura de referência do coeficiente de expansão linear 

 
4.8.2 Correção da expansão da pressão 

• Diâmetro externo do tubo: Insira o diâmetro externo do corpo do medidor. 

• Módulo de Young: Insira o valor do módulo de Young (razão entre a tensão de tração e a 
tensão elástica). 

• Índice de Poisson: Digite o valor do Índice de Poisson (razão absoluta entre a tensão material 
lateral do tubo e a tensão axial). 
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4.9 Configuração da temperatura e pressão 

4.9.1 Temperatura e pressão do condicionamento de fluxo 
A pressão e a temperatura do condicionamento de fluxo são usadas pelo medidor de vazão 
ultrassônico de líquidos Rosemount Série 3810 para vários cálculos, tais como: 

• Correção de expansão 

Configuração 

A pressão e a temperatura do condicionamento de fluxo são configuráveis individualmente 
(por meio dos pontos de dados EnablePressureInput e EnableTemperatureInput) para 
serem: 

• Desativados (0) 

• Ativados (1) (sinal de entrada de 4-20 mA) 

• “Fixed” (Fixo) (2) 

Se uma entrada for ativa, os valores correspondentes à entrada mínima e máxima (4 e 20 
mA, respectivamente) serão especificados por meio de pontos de dados 
(MinInputPressure, MaxInputPressure, MinInputTemperature, MaxInputTemperature). 

Se um entrada estiver fixa, o valor é especificado através de um ponto de dados 
(SpecFlowPressure, SpecFlow). 

Os limites de alarme podem ser especificados para cada entrada (LowPressureAlarm, 
HighPressureAlarm, LowTemperatureAlarm, HighTemperatureAlarm). Adicionalmente, a pressão da 
condição de vazão é configurável para ser relativa ou absoluta (através do ponto de dados 
InputPressureUnit). Se a pressão é relativa, então a pressão atmosférica deve ser especificada 
(através do ponto de dados AtmosphericPress). Consulte Configuração dos parâmetros de 
temperatura para o medidor e Configuração dos parâmetros de pressão para o medidor para obter 
detalhes sobre como configurar a pressão e a temperatura da condição de fluxo. 

Outro ponto de dados (FlowPOrTSrcUponAlarm), comum à pressão e à temperatura, é usado para 
especificar a fonte de dados a ser usada quando os dados de entrada selecionados forem inválidos 
(ou seja, valor dentro ou fora dos limites de alarme ou uma entrada ativa em calibração) como um 
dos seguintes: 

• Último valor aceitável (0) 

• Valor fixo (1) 

Esse ponto de dados (FlowPOrTSrcUponAlarm) é configurável por meio da página MeterLink Field 
Setup Wizard → Temperature and Pressure na Seleção de Alarme. Ela também pode ser 
configurada por meio da tela MeterLink Tools → Edit/Compare Configuration. O padrão é utilizar 
o último valor aceitável. 

Atualizações de dados 

O medidor de vazão ultrassônico para líquidos da série 3810 da Rosemount coleta 
amostras do(s) sinal(is) analógico(s) de entrada e atualiza o(s) ponto(s) de dados 
correspondente(s) (LiveFlowPressure, LiveFlowTemperature) uma vez por segundo, 
independentemente da seleção de entrada (desativada, ativa). 

A cada cinco segundos, o medidor atualiza os valores de pressão e temperatura da condição de 
fluxo "em uso" (FlowPressure, AbsFlowPressure, FlowTemperature), dependendo da seleção de 
entrada, da validade dos dados de entrada e da fonte de dados selecionada no alarme, de acordo 
com a tabela a seguir: 
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Tabela 4-7: Fonte de dados da pressão e temperatura da condição de vazão 
 

Tipo de entrada 
(EnablePressureInput 
ou EnableTemperatureI 
nput) 

Validade dos dados 
(PressureValidity ou 
TemperatureValidity) 

Fonte de dados no momento 
do alarme 
(FlowPOrTSrcUponAla rm ) 

Fonte de dados "em uso" 
(FlowPressure ou 
FlowTemperature) 

Desativado N/A N/A Valor "In-Use" 
inalterado 

Live (Ativa) Válidos N/A Média de valores ativos 
(LiveFlowPressure ou 
LiveFlowTemperature) 

 Inválido(1) Último valor aceitável Valor "In-Use" 
inalterado 

  Fixed (Fixa) Ponto de dados fixo 
(SpecFlowPressure ou 
SpecFlowTemperature) 

Fixo Válido N/A Ponto de dados fixo 
(SpecFlowPressure ou 
SpecFlowTemperature) 

 Inválidos Último valor aceitável Valor "In-Use" 
inalterado 

  Fixo Ponto de dados fixo 
(SpecFlowPressure ou 
SpecFlowTemperature) 

(1)   A entrada ativa pode ser inválida devido (a) a um ou mais valores ativos estarem fora dos limites de 
alarme, ou (b) a entrada estar sendo calibrada. 

 
A pressão de fluxo absoluta da condição de fluxo é calculada conforme mostrado abaixo: 

Equação 4-5: Pressão de fluxo absoluta com condicionamento de fluxo 

 

onde 

Pabs,f = pressão absoluta em condição de fluxo (MPaa) (AbsFlowPressure) 

Pf= pressão para a condição de vazão (MPag if InputPressureUnit=FALSE, MPaa if 
InputPressureUnit=TRUE) (FlowPressure) 

PAtmosphere= (especificado) pressão atmosférica (MPaa) (AtmosphericPress) 

 
4.9.2 Configuração dos parâmetros de temperatura para o medidor 

• Temperatura real - Se Live Analog tiver sido selecionado para Temperatura para correções do 
medidor na página de inicialização do MeterLink™, insira a escala para o transmissor conectado à 
entrada analógica. A entrada mínima é a temperatura de escala zero do transmissor (ou seja, 1 
Volt ou 4 mA). A entrada máxima é a temperatura de escala total do transmissor (ou seja, 5 Volts 
ou 20 mA). 

• Temperatura fixa– Se Fixed (Fixa) tiver sido selecionado na página de inicialização do 
MeterLink para Temperature (Temperatura), ele também será ativado se uma entrada de 
temperatura ativa tiver sido selecionada. Insira 
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um valor fixo a ser usado nos cálculos se a entrada ativa entrar em alarme. Insira uma temperatura 
média do fluido do processo. 

• Alarme de temperatura – Insira os limites de alarme superior e inferior. Uma leitura de 
temperatura fora desses limites ocasiona um alarme “Temperature Validity”. A seleção de alarme 
determina qual valor utilizar enquanto houver uma entrada de tempo real com alarme. Esse valor 
é vinculado com a seleção de alarme de pressão; portanto, quando um valor é alterado, o outro 
muda para corresponder. 

 
4.9.3 Configuração dos parâmetros de pressão para o medidor 

• Leitura de pressão - Selecione Gage ou Absolute para o tipo de leitura de pressão desejada. 
Caso um transmissor de pressão em tempo real seja conectado, selecione o tipo de leitura 
que o transmissor irá fornecer. Caso seja selecionada a opção Absoluta, será necessário 
inserir a Pressão atmosférica. 

• Pressão ativa – Insira o valor de dimensionamento do transmissor conectado à entrada 
analógica. A entrada mín. é a pressão de escala zero do transmissor (isto é, 1 Volt ou 4 mA). A 
entrada máx. é a pressão de escala total do transmissor (isto é, 5 Volts ou 20 mA). 

• Pressão fixa – Habilitado se “Fixed” foi selecionado para “Temperature for meter corrections” 
na Página Inicialização. Ele também será ativado se uma entrada de temperatura real tiver sido 
selecionada para permitir que você insira um valor fixo a ser usado nos cálculos se a entrada 
real entrar em alarme. Insira uma pressão média do fluido do processo. 

• Alarme de pressão - Insira os limites de alarme baixo e alto. Uma leitura de pressão fora 
desses limites ocasiona um alarme “Pressure Validity”. A seleção de alarme determina qual 
valor utilizar enquanto houver uma entrada de tempo real com alarme. Esse valor é comum à 
seleção do alarme de temperatura, portanto, quando um for alterado, o outro será alterado 
para corresponder. 

 
4.10 Configuração do alarme de fluxo reverso 

Alarme de fluxo reverso 

A seleção de Ativar configurará o medidor para gerar um alarme de fluxo reverso se ele acumular 
mais volume na direção reversa do que o definido no limite de Volume. 

Para que o fluxo seja contado como fluxo reverso para essa verificação, ele deve estar fluindo a uma 
velocidade próxima ao limite de fluxo baixo. Esse limite de fluxo baixo é diferente do limite de corte 
de volume, abaixo do qual, o fluxo não é considerado como fluxo para acúmulo de volume. Sempre 
que a direção do fluxo muda de para frente para a direção oposta, o volume acumulado do fluxo na 
direção oposta é zerado. 

Se o medidor for bidirecional, esse alarme não deverá ser ativado para evitar que se torne ativo 
durante períodos de fluxo reverso esperado. 

Os limites do alarme são especificados pelo limite de volume do fluxo reverso (ponto de dados 
ReverseFlowVolLmt) e pelo corte de fluxo zero da detecção de fluxo reverso (ponto de dados 
ReverseFlowDetectionZeroCut). 

Os limites do alarme de visualização devem ser selecionados na página Assistente de configuração 
de campo - Inicialização para configurar esse alarme. 
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Figura 4-11: Alarme de fluxo reverso 

 
 

4.11 Configuração dos parâmetros de exibição local 
Configure os parâmetros do visor local. Use o menu suspenso do Assistente de configuração de 
campo na caixa de listagem Itens de exibição e selecione ou modifique os itens de exibição, as 
unidades de exibição e o atraso de rolagem. 
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Figura 4-12: Parâmetros de exibição local 

 

Configuração dos itens de exibição 
 

Descrição do rótulo do visor local Unidades válidas 

QFLOW — Taxa de fluxo de volume não corrigida • BBL – Barris 

• GAL – Galões 

• L - Litros 

• CM - Metros cúbicos 

• MCM - Mil metros cúbicos 

• GAL – Galões 

• CM - Metros cúbicos 

TDYVL — Volume não corrigido do fluxo para frente do dia atual • +BBL - Barris 

• +GAL - Galões 

• +L - Litros 

• +CM - Metros cúbicos 

• +MCM - Mil metros cúbicos 
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Descrição do rótulo do visor local Unidades válidas 

TDYVL — Volume não corrigido do fluxo na direção oposta do 
dia atual 

• -BBL - Barris 

• -GAL - Galões 

• -L - Litros 

• -CM - Metros cúbicos 

• -MCM - Mil metros cúbicos 

YSTVL - Volume não corrigido do fluxo para frente do dia 
anterior 

• +BBL - Barris 

• +GAL - Galões 

• +L - Litros 

• +CM - Metros cúbicos 

• +MCM - Mil metros cúbicos 

YSTVL — Volume não corrigido do fluxo na direção oposta do 
dia anterior 

• -BBL - Barris 

• -GAL - Galões 

• -L - Litros 

• -CM - Metros cúbicos 

• -MCM - Mil metros cúbicos 

TOTVL — Volume não corrigido do fluxo para frente • +BBL - Barris 

• +GAL - Galões 

• +L - Litros 

• +CM - Metros cúbicos 

• +MCM - Mil metros cúbicos 

TOTVL — Volume não corrigido do fluxo na direção oposta • -BBL - Barris 

• -GAL - Galões 

• -L - Litros 

• -CM - Metros cúbicos 

• -MCM - Mil metros cúbicos 

VEL — Velocidade média do fluxo • Ft/S – Pés por segundo 

• M/S – Metros por segundo 

SOS — Velocidade média do som • Ft/S – Pés por segundo 

• M/S – Metros por segundo 

TEMP — Temperatura do fluxo • DEGF – Graus Fahrenheit 

• DEGC – Graus Celsius 

PRESS — Pressão do fluxo • PSI – Libra por polegada quadrada 

• MPA – Megapascal 

FRQ1A — Canal de frequência 1A • HZ – Hertz 

FRQ1B — Canal de frequência 1B • HZ – Hertz 
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Descrição do rótulo do visor local Unidades válidas 

KFCT1 — Fator 1K de Frequência • BBL – Barris 

• GAL – Galões 

• L - Litros 

• CM - Metros cúbicos 

• MCM - Mil metros cúbicos 

FRQ2A — Canal de frequência 2A • HZ – Hertz 

FRQ2A — Canal de frequência 2B • HZ – Hertz 

KFCT2 — Fator 2K de Frequência • BBL – Barris 

• GAL – Galões 

• L - Litros 

• CM - Metros cúbicos 

• MCM - Mil metros cúbicos 

AO1 — Corrente da Saída Analógica 1 • MA – Miliamperes 

AO2 — Corrente da Saída Analógica 2 • MA – Miliamperes 

 
Observação 
Quando conectado a um medidor com o visor local, a direção do fluxo na direção oposta é indicada 
através de um sinal de menos (negativo), antes do valor ser exibido no visor. 

Configuração de unidades de exibição 

As unidades de volume do medidor são exibidas em Padrão U.S ou sistema Métrico. Para modificar 
as unidades de exibição, configure o sistema de unidades do medidor no Assistente de 
configuração de campo - Página geral. 

• As unidades de volume de Padrão U.S disponíveis são: 
— Barris 

— Galões 

• As unidades de volume do sistema Métrico disponíveis são: 
— Metros cúbicos 

— Litros cúbicos 

• As unidades de exibição precedidas por um sinal de menos ou mais indicam a direção 
para frente ou direção oposta do fluxo, assim como é mostrado na tabela abaixo. 

• As unidades de tempo da taxa de fluxo do visor local podem ser modificadas selecionando o 
menu suspenso e clicando na unidade de tempo na caixa de listagem. 

• As unidades de tempo da taxa de fluxo disponíveis são: 
— segundos 

— minutos 

— horas 

— dias 
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Configuração de atraso de rolagem 

O Atraso de Exibição é o intervalo de tempo necessário para que os itens de exibição sejam exibidos 
no Visor Local. A configuração de atraso de exibição padrão é de cinco segundos. Clique na seta para 
cima ou para baixo da caixa para aumentar ou diminuir o intervalo de tempo para que um item seja 
exibido. 

1. Selecione Finish (Concluir) para gravar as definições de configuração no medidor. 

2. Salve o arquivo de configuração do medidor, obtenha um registro de Manutenção e 
Formas de onda para documentar as configurações "Novas". 

 
4.12 Configuração de usuários 

O firmware da série Rosemount 3810 v1.60 e posterior requer autenticação de usuário para se 
conectar ao medidor com o MeterLink™. 

Os medidores são fornecidos de fábrica com um único usuário padrão chamado administrator. A 
senha padrão é Administrator-XXXXX, em que XXXXX é o número de série da CPU com 
preenchimento diferente de zero, que pode ser encontrado em uma etiqueta no módulo da CPU. É 
altamente recomendável alterar essa senha na inicialização do medidor por motivos de segurança 
cibernética. Para aumentar a segurança, o nome de usuário padrão, administrador, também pode 
ser alterado. Consulte Gerenciar usuários para mais detalhes sobre como adicionar, alterar e excluir 
usuários. 

 
4.13 Salvando a configuração 

Procedimento 

1. Use o menu MeterLink™ Tools → Edit/Compare Configuration. 

2. Ative o botão de rádio View All para exibir a configuração estendida. 
Isso inclui alguns pontos de dados somente leitura que ajudam a descrever a 
configuração do medidor. Os pontos de dados somente leitura são exibidos apenas para 
referência e não podem ser alterados. Eles são exibidos com um fundo cinza apenas para 
referência e não podem ser alterados. Os pontos de dados de configuração estendida 
podem ser visualizados nas caixas de diálogo Relatório de registros de manutenção, 
Relatório de registros de arquivamento, Calibração de fluxo, Calibração zero e na 
ferramenta Editar/Comparar configuração. 

3. Ative o botão de rádio View Metrology para exibir apenas a parte de metrologia da 
configuração. 
A visualização de metrologia inclui os seguintes parâmetros: 

• Dimensões do caminho 

• Diâmetro do tubo 

• Parâmetros de atraso do transdutor 

• Coeficientes de calibração de fluxo zero 

• Coeficientes de calibração de fluxo 

4. Clique no botão Read para exibir os parâmetros de configuração do medidor. 
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Figura 4-13: Edição/Comparação da configuração 

 
 

5. Clique em Save para abrir a caixa de diálogo Salvar como. 
Um nome padrão é fornecido com base no nome do medidor, na hora e na data em que a 
configuração foi coletada. Por padrão, todos os arquivos são salvos no diretório da pasta Data 
(Dados) definido em Program Settings (Configurações do programa). Você pode alterar o 
nome e o local do diretório, se desejar. A configuração inteira é salva em um arquivo. 
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5 Registros/Relatórios 

5.1 Arquivos de registro 
Os medidores de vazão ultrassônicos para líquidos da série Rosemount™ 3810 fornecem cinco tipos de 
registros de dados: 

• Registro diário 

• Registro horário 

• Registro de auditoria 

• Registro de alarmes 

• Registro do sistema 

A partir do firmware v1.42 e posterior da série Rosemount 3810, o medidor pode armazenar até 
1825 registros diários (5 anos) e 4320 registros horários (180 dias). 

Cada tipo de registro é discutido em detalhes abaixo, seguido das instruções do MeterLink™ para ler 
(e, opcionalmente, salvar) os registros de registro do medidor (para obter mais informações, consulte 

Opções para leitura de registros diários e/ou horários). 

 
5.1.1 Ações dos pontos de dados dos registros diário e por hora 

Cinco ações diferentes de pontos de dados dos registros são suportadas pelos registros diários e 
horários: snapshot, média, vazão com acesso controlado (média), totalizar, e macro, como descrito 
abaixo: 

• SNAPSHOT: Registra o valor do ponto de dados no momento do registro. 

• AVERAGE: Registra o valor médio do ponto de dados sobre o intervalo de registro (dia ou 
hora). 

• FLOW_GATED: Valor médio do ponto de dados durante o intervalo de registro (dia ou hora) a 
ser registrado enquanto a taxa de vazão volumétrica (QFlow) estiver acima do limite de vazão 
volumétrica (QCutOff). Se a taxa de vazão volumétrica não exceder o limite durante o intervalo 
de registro, então a média de vazão controlada do ponto de dados será igual ao valor médio do 
ponto de dados durante o intervalo de registro a ser registrado. 

• FLOW_ANALYSIS_GATED: Média do ponto de dados durante o intervalo de registro (dia ou hora) a 
ser registrado enquanto a velocidade média do fluxo (AvgFlow) estiver entre os limites de análise 
de vazão de diagnóstico (FlowAnalysisLowFlowLmt e FlowAnalysisHighFlowLmt). Se a 
velocidade média do fluxo não estiver dentro dos limites durante o intervalo, então a média 
controlada da análise de vazão do ponto de dados é igual ao valor médio do ponto de dados 
durante o intervalo de registro a ser registrado. 

• TOTALIZE: Registra o valor acumulado do ponto de dados sobre o intervalo do registro (dia ou 
hora). 

• MACRO: Registra o valor (booleano) "fechado" do ponto de dados sobre o intervalo de registro 
(dia e hora). Um valor (booleano) "fechado" indica se o ponto foi alguma vez TRUE durante o 
intervalo do registro (onde um valor TRUE é representado por 1 e um valor FALSE é 
representado por 0). Isto permite que um grupo de pontos de dados booleanos sejam 
agrupados em um único valor inteiro onde cada bit representa o valor "fechado" de um único 
ponto de dados booleanos. 
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Registro diário 
O Medidor de Vazão Ultrassônico de Líquidos Rosemount™ Série 3810 armazena um registro diário 
uma vez por dia na hora de contrato especificada. 

(Consulte os arquivos de ajuda do MeterLink™ para obter informações sobre como especificar o 
ponto de dados ContractHour.) 

O usuário pode selecionar se registros antigos não lidos podem ser regravados quando o registro 
se torna cheio através do ponto de dados DoOverwriteUnreadDailyLog. Este ponto pode ser 
modificado usando a tela MeterLink Tools → Edit/Compare Configuration . O padrão é regravar 
registros antigos e não lidos. Consulte Opções para leitura dos registros diários e/ou por hora para 
mais informações sobre a leitura e marcação de registros como lidos. O ponto de dados 
IsDailyLogFull indica se o registro diário está cheio ou não e se é possível regravar sobre registros 
antigos e não lidos. 

Os pontos de dados incluídos no registro diário e a ação correspondente estão listados na tabela 
abaixo. Os pontos de dados exigidos pela norma da API, Capítulo 21, estão marcados com um 
asterisco (*). Para obter informações sobre um ponto de dados específico, consulte a ajuda online do 
MeterLink (consulte o tópico de ajuda para qualquer ponto de dados no MeterLink. Clique em Help → 
Liquid 3810 Series Registers Reference, selecione a aba Index, comece a digitar o nome do ponto de 
dados até que o ponto desejado seja destacado e clique no botão Display). 

Tabela 5-1: Pontos de dados do registro diário 
 

Ponto de dados Teor Ação do registro 

PosVolFlow TOTALIZE e SNAPSHOT 

NegVolFlow TOTALIZE e SNAPSHOT 

AccumFlowTime TOTALIZE 

DailyMacro1 MACRO 

bit 0 IsQFlowInvalid 

bit 1 Não utilizado 

bit 2 Não utilizado 

bit 3 Não utilizado 

bit 4 IsEstimatedFlowVelocityInUse 

bit 5 IsTooFewOperChords 

bit 6 Não utilizado 

bit 7 Não utilizado 

bit 8 Não utilizado 

bit 9 Não utilizado 

bit 10 IsAcqModuleIncompatible 

bit 11 IsHourlyLogFull 

bit 12 IsDailyLogFull 

bit 13 IsAuditLogFull 

bit 14 IsAlarmLogFull 

bit 15 IsSystemLogFull 

bit 16 IsXdcrFiringSyncError 

bit 17 IsColocMeterCommErr 
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Tabela 5-1: Pontos de dados do registro diário (continuação) 

Ponto de dados Teor Ação do registro 

bit 18 Não utilizado  

bit 19 Não utilizado 

bit 20 IsElecVoltOutOfRange 

bit 21 IsElecTempOutOfRange 

bit 22 DidCnfgChksumChg 

bit 23 DidPowerFail 

bit 24 IsAcqModuleError 

bit 25 IsAcqMode 

bit 26 DidColdStart 

bit 27 IsCorePresent 

bit 28 WatchDogReset 

bit 29 D11 

bit 30 IsWarmStartReq 

bit 31 lsClkInvalid 

DailyMacro2 MACRO 

bit 0 Não utilizado 

bit 1 Não utilizado 

bit 2 Não utilizado 

bit 3 Não utilizado 

bit 4 Não utilizado 

bit 5 IsReverseFlowDetected 

bit 6 Não utilizado 

bit 7 Não utilizado 

bit 8 Não utilizado 

bit 9 Não utilizado 

bit 10 Não utilizado 

bit 11 Não utilizado 

bit 12 IsColocMeterSndSpdRangeErr 

bit 13 IsColocMeterQFlowRangeErr 

bit 14 DidWarmStart 

bit 15 DidResetUsers 

bit 16 IsAnyLogFull 

bit 17 TemperatureInvalid 

bit 18 PressureInvalid 

bit 19 Não utilizado 

bit 20 IsChordLengthMismatched 
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Tabela 5-1: Pontos de dados do registro diário (continuação) 

Ponto de dados Teor Ação do registro 

bit 21 IsXdcrMaintenanceRequired  

bit 22 IsSNRTooLow 

bit 23 IsPeakSwitchDetected 

bit 24 IsHardFailedD 

bit 25 IsHardFailedC 

bit 26 IsHardFailedB 

bit 27 IsHardFailedA 

bit 28 IsMeterVelAboveMaxLmt 

bit 29 IsAvgSoundVelRangeErr 

bit 30 IsMeasSndSpdRange 

bit 31 Não utilizado 

DailyMacro3 MACRO 

bits 0 - 3 IsChordLengthMismatched<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsBatchInactive<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 IsXdcrMaintenanceRequired<A..D> 

bits 20 - 23 Não utilizado 

bits 24 - 27 IsFailedForBatch<A..D> 

bits 28 - 31 Não utilizado 

DailyMacro4 MACRO 

bits 0 - 3 DidDltTmChkFail<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsSigQltyBad<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 DidExceedMaxNoise<A..D> 

bits 20 - 23 Não utilizado 

bits 24 - 27 IsSNRTooLow<A..D> 

bits 28 - 31 Não utilizado 

DailyMacro5 MACRO 

bits 0 - 3 DidDltTmChkFail<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsSigDistorted<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 IsPeakSwitchDetected<A..D> 

bits 20 - 23 Não utilizado 
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Tabela 5-1: Pontos de dados do registro diário (continuação) 

Ponto de dados Teor Ação do registro 

bits 24 - 27 IsSigClipped<A..D>  

bits 28 - 31 Não utilizado 

DailyMacro6 MACRO 

bits 0 - 3 IsMeasSndSpdRange<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsStackingIncomplete<A..D> 

bits 12 - 31 Não utilizado 

ProfileFactor FLOW_GATED 

SwirlAngle FLOW_GATED 

Simetria FLOW_GATED 

CrossFlow FLOW_GATED 

Turbulence<A..D> FLOW_GATED 

SndVel<A..D> FLOW_GATED 

SpdSndSpread AVERAGE 

AvgSndVel FLOW_GATED 

SndVelDiff<A..D> FLOW_GATED 

AGA10SndVel FLOW_GATED 

ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED 

FlowVel<A..D> FLOW_GATED 

AvgFlow FLOW_GATED 

FlowVelRatio<A..D> AVERAGE 

PctGood<A1..D2> AVERAGE 

Gain<A1..D2> AVERAGE 

SNR<A1..D2> AVERAGE 

NoiseAmplitude<A1..D2> AVERAGE 

QFlow FLOW_GATED 

ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED 

FlowTemperature FLOW_GATED 

ExpCorrTemperature FLOW_GATED 

FlowPressure FLOW_GATED 

ExpCorrPressure FLOW_GATED 

AbsFlowPressure FLOW_GATED 

Viscosidade FLOW_GATED 

CnfgChksumValue SNAPSHOT 

CnfgChksumDate SNAPSHOT 
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Registro por hora 
O Medidor de Vazão Ultrassônico de Líquidos Rosemount™ Série 3810 armazena um registro 
por hora. O usuário pode selecionar se registros antigos não lidos podem ser regravados 
quando o registro se torna cheio através do ponto de dados DoOverwriteUnreadHourlyLog. 

Este ponto pode ser modificado usando a tela MeterLink Tools → Edit/Compare Configuration .  
O padrão é regravar registros antigos e não lidos. Consulte Opções para leitura dos registros diários 
e/ou por hora para mais informações sobre a leitura e marcação de registros como lidos. O ponto de 
dados IsHourlyLogFull indica se o registro horário está cheio ou não e se é possível regravar sobre 
registros antigos e não lidos. 

Os pontos de dados incluídos no registro horário e a ação correspondente estão listados na tabela 
abaixo. Os pontos de dados exigidos pela norma da API, Capítulo 21, estão marcados com um 
asterisco (*). Para obter informações sobre um ponto de dados específico, consulte a ajuda online 
do MeterLink™ (consulte o tópico de ajuda para qualquer ponto de dados no MeterLink. Clique em 
Help → Liquid 3810 Series Registers Reference, selecione a aba Index, comece a digitar o nome do 
ponto de dados até que o ponto desejado seja destacado e clique no botão Display). 

Tabela 5-2: Pontos de dados do registro por hora 
 

Ponto de dados Teor Ação do registro 

PosVolFlow TOTALIZE e SNAPSHOT 

NegVolFlow TOTALIZE e SNAPSHOT 

AccumFlowTime TOTALIZE 

HourlyMacro1 MACRO 

bit 0 IsQFlowInvalid 

bit 1 Não utilizado 

bit 2 Não utilizado 

bit 3 Não utilizado 

bit 4 IsEstimatedFlowVelocityInUse 

bit 5 IsTooFewOperChords 

bit 6 Não utilizado 

bit 7 Não utilizado 

bit 8 Não utilizado 

bit 9 Não utilizado 

bit 10 IsAcqModuleIncompatible 

bit 11 IsHourlyLogFull 

bit 12 IsDailyLogFull 

bit 13 IsAuditLogFull 

bit 14 IsAlarmLogFull 

bit 15 IsSystemLogFull 

bit 16 IsXdcrFiringSyncError 

bit 17 IsColocMeterCommErr 

bit 18 Não utilizado 

bit 19 Não utilizado 
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Tabela 5-2: Pontos de dados do registro por hora (continuação) 

Ponto de dados Teor Ação do registro 

bit 20 IsElecVoltOutOfRange  

bit 21 IsElecTempOutOfRange 

bit 22 DidCnfgChksumChg 

bit 23 DidPowerFail 

bit 24 IsAcqModuleError 

bit 25 IsAcqMode 

bit 26 DidColdStart 

bit 27 IsCorePresent 

bit 28 WatchDogReset 

bit 29 D11 

bit 30 IsWarmStartReq 

bit 31 lsClkInvalid 

HourlyMacro2 MACRO 

bit 0 Não utilizado 

bit 1 Não utilizado 

bit 2 Não utilizado 

bit 3 Não utilizado 

bit 4 Não utilizado 

bit 5 IsReverseFlowDetected 

bit 6 Não utilizado 

bit 7 Não utilizado 

bit 8 Não utilizado 

bit 9 Não utilizado 

bit 10 Não utilizado 

bit 11 Não utilizado 

bit 12 IsColocMeterSndSpdRangeErr 

bit 13 IsColocMeterQFlowRangeErr 

bit 14 DidWarmStart 

bit 15 DidResetUsers 

bit 16 IsAnyLogFull 

bit 17 TemperatureInvalid 

bit 18 PressureInvalid 

bit 19 Não utilizado 

bit 20 IsChordLengthMismatched 

bit 21 IsXdcrMaintenanceRequired 

bit 22 IsSNRTooLow 
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Tabela 5-2: Pontos de dados do registro por hora (continuação) 

Ponto de dados Teor Ação do registro 

bit 23 IsPeakSwitchDetected  

bit 24 IsHardFailedD 

bit 25 IsHardFailedC 

bit 26 IsHardFailedB 

bit 27 IsHardFailedA 

bit 28 IsMeterVelAboveMaxLmt 

bit 29 IsAvgSoundVelRangeErr 

bit 30 IsMeasSndSpdRange 

bit 31 Não utilizado 

HourlyMacro3 MACRO 

bits 0 - 3 IsChordLengthMismatched<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsBatchInactive<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 IsXdcrMaintenanceRequired<A..D> 

bits 20 - 23 Não utilizado 

bits 24 - 27 IsFailedForBatch<A..D> 

bits 28 - 31 Não utilizado 

DailyMacro4 MACRO 

bits 0 - 3 DidDltTmChkFail<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsSigQltyBad<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 DidExceedMaxNoise<A..D> 

bits 20 - 23 Não utilizado 

bits 24 - 27 IsSNRTooLow<A..D> 

bits 28 - 31 Não utilizado 

HourlyMacro5 MACRO 

bits 0 - 3 DidDltTmChkFail<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsSigDistorted<A..D> 

bits 12 - 15 Não utilizado 

bits 16 - 19 IsPeakSwitchDetected<A..D> 

bits 20 - 23 Não utilizado 

bits 24 - 27 IsSigClipped<A..D> 

bits 28 - 31 Não utilizado 
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Tabela 5-2: Pontos de dados do registro por hora (continuação) 

Ponto de dados Teor Ação do registro 

HourlyMacro6 MACRO 

bits 0 - 3 IsMeasSndSpdRange<A..D> 

bits 4 -7 Não utilizado 

bits 8 - 11 IsStackingIncomplete<A..D> 

bits 12 - 31 Não utilizado 

ProfileFactor FLOW_GATED 

SwirlAngle FLOW_GATED 

Simetria FLOW_GATED 

CrossFlow FLOW_GATED 

Turbulence<A..D> FLOW_GATED 

SndVel<A..D> FLOW_GATED 

SpdSndSpread AVERAGE 

AvgSndVel FLOW_GATED 

SndVelDiff<A..D> FLOW_GATED 

ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED 

FlowVel<A..D> FLOW_GATED 

AvgFlow FLOW_GATED 

FlowVelRatio<A..D> AVERAGE 

PctGood<A1..D2> AVERAGE 

Gain<A1..D2> AVERAGE 

SNR<A1..D2> AVERAGE 

NoiseAmplitude<A1..D2> AVERAGE 

QFlow FLOW_GATED 

ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED 

FlowTemperature FLOW_GATED 

ExpCorrTemperature FLOW_GATED 

FlowPressure FLOW_GATED 

ExpCorrPressure FLOW_GATED 

AbsFlowPressure FLOW_GATED 

Viscosidade FLOW_GATED 

CnfgChksumValue SNAPSHOT 

CnfgChksumDate SNAPSHOT 
 

Registro de auditoria 
Os Medidores de Vazão Ultrassônicos de Líquidos Rosemount 3810 armazenam um registro de 
auditoria sempre que qualquer parâmetro que afete a medição de vazão for alterado. O registro de  
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auditoria indica qual ponto de dados foi mudado, a data da mudança e a hora da mudança, e 
ambos os valores "como encontrado" e "como deixado". 

O medidor pode armazenar até 3000 registros de auditoria. O usuário pode selecionar se registros 
antigos não lidos podem ser regravados quando o registro se torna cheio através do ponto de dados 
DoOverwriteUnreadAuditLog. Este ponto pode ser modificado usando a tela MeterLink Tools → 
Edit/Compare Configuration . O padrão é regravar registros antigos e não lidos. 
Consulte Opções para leitura dos registros de auditoria, de alarmes e/ou do sistema para obter 
informações sobre a leitura e marcação de registros como lidos. O ponto de dados IsAuditLogFull 
indica se o registro diário está cheio ou não e se é possível regravar sobre registros antigos e não 
lidos. 

Os pontos de dados monitorados e coletados para o registro de auditoria são mostrados no 
Registro de auditoria por meio do Registro de eventos: alarme/auditoria. Os pontos estão 
agrupados e, dentro de cada grupo, estão listados alfabeticamente. 

O agrupamento é o seguinte: 

• Calibração 

• Proporções das cordas 

• Medidor co-localizado 

• Comunicações 

• Registro de Dados 

• Correção de Expansão 

• Análise de vazão 

• Sinais de Frequência, Digitais e Analógicos 

• Informações Gerais 

• HART® 

• Indicadores 

• Visor local 

• Informações do medidor 

• Pressão e Temperatura 

• Cálculo do Número de Reynolds 

• Processamento de Sinais 

• Rastreio 

Para informações a respeito de um ponto de dados específico, consulte a ajuda online do MeterLink™. 
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Tabela 5-3: Pontos de dados monitorados do grupo de calibração do registro de auditoria 
 

Grupo de dados Ponto de dados 

 AvgDly<A..D> 
CalFlag 
CalMethod 
DltDly<A..D> 
Fwd<A0..A3> 
FwdA0HighViscosity 
FwdFlwRt<1..12> 
FwdMtrFactr 
FwdMtrFactr<1..12> 
FwdMtrFctrHighViscosity<1..12> 
FwdProfileFactor<1..12> 
HighViscosityMethod 
L<A..D> 
MeterHousingLength<A..D> 
PipeDiam 
Rev<A0..A3> 
RevA0HighViscosity 
RevFlwRt<1..12> 
RevMtrFctr<1..12> 
RevMtrFctr 
RevMtrFctrHighViscosity<1..12> 
RevProfileFactor<1..12> 
SystemDelay 
Wt<A..D> 
X<A..D> 
XdcrHousingLength<A..D> 
XdcrHousingSerialNumber<A..D> 
ZeroFlowCalReqControl 
ZeroFlowCalReqDuration 

 
Tabela 5-4: Registro de auditoria Pontos de dados monitorados do grupo de proporções das cordas 

 

Grupo de dados Ponto de dados 

 LowFlowLmt NumVals  
PropUpdtSeconds  
ResetProp 

 
Tabela 5-5: Ponto de dados monitorado do grupo de medidores colocado no registro de auditoria 

 

Grupo de dados Ponto de dados 

 ColocMeterIPAddress  
ColocMeterMode  
ColocMeterQFlowErrLimit  
ColocMeterRunningAverageInterval  
ColocMeterSndSpdErrLimit  
IsColocMeterClockSyncEnabled 
IsColocMeterQFlowRangeCheckEnabled  
IsColocMeterSndSpdRangeCheckEnabled 
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Tabela 5-6: Ponto de dados monitorado do grupo de comunicação do registro de auditoria 
 

Grupo de dados Ponto de dados 

 BaudPort<A..C> 
CommRspDlyPort<A..C> 
CommTCPMaxDatagramSizePort<A..C> 
CommTimeoutPort<A..C> 
DriveSelectionPort<A..C> 
Eth1AltMapfilePt 
Eth1AltModbusPort 
Eth1AltModbusReadWriteMode 
Eth1DfltGatewayAddr 
Eth1IPAddr 
Eth1MapfilePt 
Eth1ModbusID 
Eth1ModbusReadWriteMode 
Eth1SubnetMask 
FTPServerControlPort 
HTTPServerPort 
IsHWFlowControlEnabledPortA 
IsTelnetServerEnabled 
MaxConnDBAPI 
ModbusIDPort<A..D> 
PortAMapfilePt 
PortBMapfilePt 
PortCMapfilePt 
ProtocolPort<A..C> 
PTPDomainNumber 
ReadWriteModePort<A..C> 
RTSOffDelayPortA 
RTSOnDelayPortA 

 
Tabela 5-7: Ponto de dados monitorado do grupo de registro de dados do registro de auditoria 

 

Grupo de dados Ponto de dados 

 AlarmTurnOffHysterisisCount 
AlarmTurnOffHysterisisTimeSpan 
ContractHour 
DailyLogInterval 
DoOverwriteUnreadAlarmLog 
DoOverwriteUnreadAuditLog 
DoOverwriteUnreadDailyLog 
DoOverwriteUnreadHourlyLog 
DoOverwriteUnreadSystemLog 
HourlyLogInterval 
IsAuditLogFixedDataPointsEnabled 
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Tabela 5-8: Registro de auditoria Ponto de dados monitorado do grupo de correção de expansão 
 

Grupo de dados Ponto de dados 

 EnableExpCorrPress 
EnableExpCorrTemp 
LinearExpansionCoef 
PipeOutsideDiameter 
PoissonsRatio 
RefPressExpCoef 
RefTempLinearExpCoef 
YoungsModulus 

 
Tabela 5-9: Registro de auditoria Ponto de dados monitorado do grupo de análise de vazão 

 

Grupo de dados Ponto de dados 

 FlowAnalysisHighFlowLmt 
FlowAnalysisLowFlowLmt 
ReverseFlowDetectionZeroCut 
ReverseFlowVolLmt 
SwirlAngleLmt 
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Tabela 5-10: Frequência de registro de auditoria, dados monitorados dos grupos digital e 
analógico, seção 1 

 

Grupo de dados Ponto de dados 

 AO1ActionUponInvalidContent 
AO1Content 
AO1CurrentTrimGain 
AO1CurrentTrimZero 
AO1Dir 
AO1FullScaleVolFlowRate 
AO1TestModeOutputPercent 
AO1TrimCurrent 
AO1TrimGainExtMeasCurrent 
AO1TrimZeroExtMeasCurrent 
AO1ZeroScaleVolFlowRate 
AO2ActionUponInvalidContent 
AO2Content 
AO2CurrentTrimGain 
AO2CurrentTrimZero 
AO2Dir 
AO2FullScaleVolFlowRate 
AO2TestModeOutputPercent 
AO2TrimCurrent 
AO2TrimGainExtMeasCurrent 
AO2TrimZeroExtMeasCurrent 
AO2ZeroScaleVolFlowRate 
DI1IsInvPolarity 
DI1Mode 
DO1AContent... DO1BContent 
DO1AIsInvPolarity... DO1BIsInvPolarity 
DO1PairTestEnable 
DO2AContent... DO2BContent 
DO2AIsInvPolarity... DO2BIsInvPolarity 
DO2PairTestEnable 
FODO1Mode 
FODO1Source 
FODO2Mode 
FODO2Source 
FODO3Mode 
FODO3Source 
FODO4Mode 
FODO4Source 
FODO5Mode 
FODO5Source 
FODO6Mod 
FODO6Source 
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Tabela 5-11: Frequência de registro de auditoria, dados monitorados dos grupos digital e 
analógico, seção 2 

 

Grupo de dados Ponto de dados 

 Freq1BPhase 
Freq1Content 
Freq1Dir 
Freq1FeedbackCorrectionPcnt 
Freq1FullScaleVolFlowRate 
Freq1MaxFrequency 
Freq1TestModeOutputPercent 
Freq1ZeroScaleVolFlowRate 
Freq2BPhase 
Freq2Content 
Freq2Dir 
Freq2FeedbackCorrectionPcnt 
Freq2FullScaleVolFlowRate 
Freq2MaxFrequency 
Freq2TestModeOutputPercent 
Freq2ZeroScaleVolFlowRate 
IsAO1EnableTest 
IsAO2EnableTest 
IsDI1ForCalActiveLow 
IsDI1ForCalStateGated 
IsFreq1BZeroedOnErr 
IsFreq1EnableTest 
IsFreq2BZeroedOnErr 
IsFreq2EnableTest 
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Tabela 5-12: Ponto de dados monitorado do grupo geral do registro de auditoria 
 

Grupo de dados Ponto de dados 

 AlarmDef 
AsyncEnable 
AvgSoundVelHiLmt 
AvgSoundVelLoLmt 
ChordalConfig 
ChordInactv<A..D> 
DampEnable 
DeviceNumber 
DitherEnable 
FlowDir 
IsPlaybackSimulationEnabled 
MaxNoDataBatches 
MeterMaxVel 
MinChord 
MinPctGood 
NonNormalModeTimeout 
PeakSwitchDetectModeSimFileName 
PerfStatusSuppressLmt 
RTCSecondsSinceEpochSet 
SimFileName 
SSMax 
SSMin 
UnitsSystem 
UserChanged 
VelHold 
VolFlowRateTimeUnit 
VolUnitMetric 
VolUnitUS 
XdcrFiringSync 
XdcrMaintenanceGainRange 
XdcrMaintenanceSNRRange 
XdcrType 
ZeroCut 
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Tabela 5-13: Registro de auditoria Ponto de dados monitorado do grupo de dados HART® 
 

Grupo de dados Ponto de dados 

 HARTDate 
HARTDescriptor 
HARTDeviceFinalAssyNum 
HARTLengthUnit 
HARTLongTag 
HARTMessage 
HARTMinNumPreambles 
HARTNumPreambleBytesFromSlave 
HARTPollingAddress 
HARTPressureUnit 
HARTQVContent 
HARTRateTimeUnit 
HARTSlot0Content 
HARTSlot1Content 
HARTSlot2Content 
HARTSlot3Content 
HARTTag 
HARTTemperatureUnit 
HARTTVContent 
HARTVelUnit 
HARTViscosityUnit 
HARTVolUnit 
HARTYoungsModulusPressureUnit 
IsHARTSlaveEnabled 

 
Tabela 5-14: Ponto de dados monitorado do grupo de indicadores do registro de auditoria 

 

Grupo de dados Ponto de dados 

 CnfgChksumDate 
CnfgChksumValue 
DidCnfgChksumChg 
DidColdStart 
DidPowerFail 
DidWarmStart 
DoWarmStart 
IsConfigProtected 
IsCorePresent 
IsProgrammingStarted 
MeterResetTime 
WatchDogReset 

 
Tabela 5-15: Ponto de dados monitorado do grupo de exibição local do registro de auditoria 

 

Grupo de dados Ponto de dados 

 LocalDisplayFlowRateTimeUnit 
LocalDisplayItem<1..10> 
LocalDisplayMode 
LocalDisplayScrollDelay 
LocalDisplayVolUnitMetric 
LocalDisplayVolUnitUS 
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Tabela 5-16: Ponto de dados monitorado do grupo de informações do medidor do registro de auditoria 
 

Grupo de dados Ponto de dados 

 Address 
City 
CPUBdBootLoaderSwVer 
CPUBdSwVer 
FileSysVer 
MeterName 
MeterSerialNumber 
OSVer 
StateAndCountry 
StationName 
UserScratch1 
UserScratch2 

 
Tabela 5-17: Ponto de dados monitorado do grupo de pressão e temperatura do registro de auditoria 

 

Grupo de dados Ponto de dados 

 AtmosphericPress 
EnablePressureInput 
EnableTemperatureInput 
FlowPOrTSrcUponAlarm 
FlowPressureWhileCal 
FlowTemperatureWhileCal 
HighPressureAlarm 
HighTemperatureAlarm 
InputPressureUnit 
LiveFlowPressureCalCtrl 
LiveFlowPressureGain 
LiveFlowPressureOffset 
LiveFlowTemperatureCalCtrl 
LiveFlowTemperatureGain 
LiveFlowTemperatureOffset 
LowPressureAlarm 
LowTemperatureAlarm 
MaxInputTemperature 
MinInputPressure 
MinInputTemperature 

 
Tabela 5-18: Registro de auditoria Ponto de dados monitorado do grupo de cálculo do número de 
Reynolds 

 

Grupo de dados Ponto de dados 

 Viscosity 
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Tabela 5-19: Ponto de dados monitorado do grupo de processamento de sinal do registro de 
auditoria 

 

Grupo de dados Ponto de dados 

 BatchPercentSmoothing 
BatchSize 
CRange 
DltChkSI 
EmRateActual 
EmRateDesired 
Filter 
FireSeq 
GainHighLmt 
GainLowLmt 
MaxHoldTm 
MaxNoise 
MinHoldTime 
MinSigQlty 
NegSpan 
Pk1Pct 
Pk1Thrsh 
PkPlsWdthSI 
PosSpanSI 
SampInterval 
SampPerCycle 
SetXdcrType 
SndSpdChkMaxVel 
SndSpdChkMinVel 
SNRatio 
SpecBatchUpdtPeriod 
StackEmRateActual 
StackEmRateDesired 
StackSize 
TmDevFctr1 
TmDevLow1SI 
XdcrFreq 
XdcrNumDriveCycles 
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Tabela 5-20: Ponto de dados monitorado do grupo de monitoramento do registro de auditoria 
 

Grupo de dados Ponto de dados 

 ResetTrkParam Tamp 
TampHi 
TampLo 
TampSen 
TampWt 
Tspe 
TspeHi 
TspeLmt 
TspeLo 
TspeSen 
TspeWt 
Tspf 
TspfHi 
TspfLo 
TspfMatch 
TspfSen 
TspfWt 

 
Tabela 5-21: Registro de auditoria Pontos de dados fixos 

 

Grupo de dados Ponto de dados 

Os pontos de dados de configuração de valor fixo, que são gravados por um cliente externo como um 
computador de vazão em intervalos periódicos, podem ser habilitados definindo 
IsAuditLogFixedDataPointsEnabled como TRUE. Por padrão, IsAuditLogFixedDataPointsEnabled é definido 
como FALSE, o que desativa o registro de auditoria dos seguintes pontos de dados. 

Entradas SpecFlowTemperature  
SpecFlowPressure 

 
Determinação dos horários de inicialização e desligamento do medidor 
O registro de auditoria pode ser usado para determinar o horário de início (ou reinício) do medidor e o 
horário de desligamento analisando os registros MeterResetTime. O horário de registro 
MeterResetTime indica (com precisão de até poucos segundos) o horário em que o medidor foi 
iniciado. 

O valor “como deixado” indica o horário (com precisão de até poucos segundos) que o medidor foi 
desligado. 

 
5.1.2 Registro de eventos: alarme/auditoria 

O medidor monitora vários pontos de dados em relação ao limite de alarme de cada ponto. Pontos de 
dados não booleanos podem ter limites de alarme baixo e alto. Pontos de dados booleanos têm um 
único limite de alarme (isto é, ou TRUE ou FALSE). 

Há dois status associados com os alarmes: disparados e limpos. Um alarme é disparado quando o 
ponto de dados está no limite do alarme ou quando excede este limite. Um alarme é limpo quando o 
ponto de dados está dentro dos limites do alarme. 

O Medidor de Vazão Ultrassônico de Líquidos Série 3810 Rosemount™ armazena um registro de 
alarme toda vez que o status do alarme monitorado do ponto de dados muda. O registro do alarme 
indica o ponto de dados, a data e a hora, o status do alarme, o limite de alarme correspondente, e o 
valor do ponto de dados. 
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O medidor pode armazenar até 3000 registros de alarme. O usuário pode selecionar se registros 
antigos não lidos podem ser regravados quando o registro se torna cheio através do ponto de dados 
DoOverwriteUnreadAlarmLog. Este ponto pode ser modificado usando a tela MeterLink Tools → 
Edit/Compare Configuration . O padrão é regravar registros antigos e não lidos. Consulte Opções 
para leitura dos registros de auditoria, de alarmes e/ou do sistema para obter informações sobre a 
leitura e marcação de registros como lidos. O ponto de dados IsAlarmLogFull indica se o registro de 
alarmes está cheio ou não e se é possível regravar sobre registros antigos e não lidos. 

Os pontos de dados estabelecidos pelo usuário AlarmTurnOffHysterisisCount e 
AlarmTurnOffHysterisis-TimeSpan devem ser usados para prevenir que alarmes muito repetitivos 
encham o registro de alarmes. Quando um alarme é disparado em AlarmTurnOffHysterisisCount 
vezes em AlarmTurnOffHysteresisTimeSpan segundos, o alarme é suprimido até que a frequência 
do mesmo caia abaixo da especificada (contagens por tempo de duração), ponto em que o alarme 
deixará de ser suprimido após a próxima limpeza de alarme. Os registros de alarmes indicam 
quando uma supressão de alarme é iniciada ou terminada. Os valores padrão são 8 ocorrências em 
240 segundos. 

Os pontos de dados monitorados para o registro de alarmes são mostrados nas tabelas abaixo. 
Observe que os limites de alarme são por si só pontos de dados. Os limites de alarme definidos pelo 
usuário estão listados por nome do ponto de dados. Os limites de alarme não configuráveis estão 
listados por valor de ponto de dados. 

Tabela 5-22: Pontos de dados monitorados do registro de alarmes 
 

Ponto de dados Limite de alarme baixo Limite de alarme alto 

GainA1, GainA2, 
GainB1, GainB2, 
GainC1, GainC2, 
GainD1, GainD2, 

GainLowLmt GainHighmit 

AvgSndVel AvgSoundVelLoLmt AvgSoundVelHiLmt 

SpecFlowPressure LowPressureAlarm HighPressureAlarm 

SpecFlowTemperature LowTemperatureAlarm HighTemperatureAlarm 

LiveFlowPressure LowPressureAlarm HighPressureAlarm 

LiveFlowTemperature LowTemperatureAlarm HighTemperatureAlarm 

AvgFlow MeterMaxNegVel MeterMaxVel 

SysTemp -40°C 100°C 

SysVoltage1V 0,90 V 1,10 V 

SysVoltage1V2 1,08 V 1,32 V 

SysVoltage2V5 2,225 V 2,775 V 

SysVoltage3V3 2,937 V 3,663 V 

 
Tabela 5-23: Registro de alarme Limite de alarme booleano 

 

Ponto de dados Unidade de alarme booleano 

IsClkInvalid TRUE 

SpecFlowTemperature TRUE 

SpecFlowPressure TRUE 

PressureInvalid TRUE 

TemperatureInvalid TRUE 

IsAcqModuleError TRUE 

AvgFlow TRUE 



Registros/Relatórios Operação 

82 Emerson.com/Rosemoun
t 

 
 

 

Dezembro 2023 00809-0222-3810 
 

 
 
 

Tabela 5-23: Registro de alarme Limite de alarme booleano(continuação) 

Ponto de dados Unidade de alarme booleano 

IsMeterVelAboveMaxLmt TRUE 

AvgSndVel TRUE 

IsAvgSoundVelRangeErr TRUE 

QMeterValidity FALSE 

QFlowValidity FALSE 

DidColdStart TRUE 

IsMeasSndSpdRange<A..D> TRUE 

IsAcqMode TRUE 

IsTooFewOperChords TRUE 

IsHardFailed<A..D> TRUE 

Freq1DataValidity FALSE 

Freq2DataValidity FALSE 

SysTemp TRUE 

SysVoltage2V5 TRUE 

SysVoltage3V3 TRUE 

IsHourlyLogFull TRUE 

IsDailyLogFull TRUE 

IsAuditLogFull TRUE 

IsSystemLogFull TRUE 

IsAcqModuleIncompatible TRUE 

LiveFlowPressure TRUE 

LiveFlowTemperature TRUE 

AO1IsSaturated TRUE 

AO2IsSaturated TRUE 

AO1DataValidity FALSE 

AO2DataValidity FALSE 

HARTTVValidity FALSE 

HARTQVValidity FALSE 

HARTSlot0Validity FALSE 

HARTSlot1Validity FALSE 

HARTSlot2Validity FALSE 

HARTSlot3Validity FALSE 

AreSwComponentsCompatible TRUE 

IsAcqModuleErrorLatched TRUE 

IsAcqModeLatched TRUE 

IsTooFewOperChordsLatched TRUE 
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Tabela 5-23: Registro de alarme Limite de alarme booleano(continuação) 

Ponto de dados Unidade de alarme booleano 

TemperatureInvalidLatched TRUE 

PressureInvalidLatched TRUE 

IsMeterVelAboveMaxLmtLatched TRUE 

IsAvgSoundVelRangeErrLatched TRUE 

IsReverseFlowDetected TRUE 

ReverseFlowVol TRUE 

IsReverseFlowDetectedLatched TRUE 

SysVoltage1V2 TRUE 

SysVoltage1V TRUE 

SysVoltageAcqModule1V2 TRUE 

SysVoltageAcqModule2V5 TRUE 

SysVoltageAcqModule3V3 TRUE 

SysTempAcqModule TRUE 

IsXdcrFiringSyncError TRUE 

IsColocMeterCommErr TRUE 

IsColocMeterCommErrLatched TRUE 

IsColocMeterSndSpdRangeErr TRUE 

IsColocMeterSndSpdRangeErrLatched TRUE 

IsColocMeterQFlowRangeErr TRUE 

IsColocMeterQFlowRangeErrLatched TRUE 

IsChordLengthMismatched<A..D> TRUE 

DidResetUsers TRUE 
 

Registro do sistema 
O Medidor de Vazão Ultrassônico de Líquidos Série 3810 Rosemount registra todas as mensagens 
do sistema no registro do sistema. 

O medidor pode armazenar até 3000 registros do sistema. O usuário pode selecionar se registros 
antigos não lidos podem ser regravados quando o registro se torna cheio através do ponto de dados 
DoOverwriteUnreadSystemLog. 

Este ponto pode ser modificado usando a tela MeterLink Tools → Edit/Compare Configuration . O 
padrão é regravar registros antigos e não lidos. Consulte Opções para leitura dos registros de 
auditoria, de alarmes e/ou do sistema para obter informações sobre a leitura e marcação de registros 
como lidos. O ponto de dados IsSystemLogFull indica se o registro do sistema está cheio ou não e se 
é possível regravar sobre registros antigos e não lidos. 

Existe uma prevenção para que mensagens repetitivas não encham o registro do sistema. 
Quando uma determinada mensagem ocorre três vezes em menos de 60 segundos, tal 
mensagem do sistema é suprimida até que a frequência da mensagem caia para menos de 3 
vezes em 60 segundos. Os registros do sistema indicam quando uma supressão de mensagem 
do sistema foi iniciada e terminada. 
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5.1.3 Leitura dos registros 
Os registros do Medidor de Vazão Ultrassônico Série 3810 Rosemount são lidos usando a tela 
Logs/Reports → Meter Archive Logs.  

Há três grupos de registros: 

• Diariamente 

• Por hora 

• Evento (registros de auditoria, alarme e do sistema) 

Selecione os grupos desejados pelas caixas de verificação Collect daily log/Collect hourly log/Collect 
event log, respectivamente, para registros diários, horários ou de eventos. Se o grupo de eventos for 
selecionado, os registros de auditoria, de alarmes e do sistema são selecionáveis individualmente. 
Toda vez que qualquer registro for coletado, a configuração atual do medidor também é coletada. 

 
5.1.4 Opções para leitura dos registros diários e/ou horários 

As opções para leitura dos registros diários e horários são as mesmas. A tela Logs/ Reports → 
Meter Archive Logs do MeterLink indica o número de registros diários que estão disponíveis 
para leitura. Selecione o tipo de registro a ser coletado pelas caixas de verificação Collect daily 
log e/ou Collect hourly log para registros diários ou horários, respectivamente. 

Selecione entre coletar todos os registros ou o último número de registros diários especificado. 
Selecione também entre coletar todos os dados de registro ou apenas os pontos de dados 
requeridos pela norma da API, Capítulo 21. 

A Tabela 5-1 lista os pontos de dados do registro diário e a Tabela 5-2 lista os pontos de dados do 
registro horário. 

Para ambas as tabelas, os pontos de dados requeridos pela norma da API, Capítulo 21, são 
marcados com um asterisco (*). 

 
5.1.5 Opções para leitura dos registros de auditoria, de alarmes 

e/ou do sistema 
As opções para a leitura de registros de auditoria, de alarmes, e do sistema são as mesmas. A tela 
Logs/Reports → Meter Archive Logs do MeterLink™ indica o número de registros disponíveis para 
cada tipo de registro. Selecione entre coletar todos os registros ou apenas o último número 
especificado de registros diários para o tipo de registro selecionado. 

 
5.1.6 Coleta e visualização de registros 

Três formatos estão disponíveis: 

• Microsoft Excel - Este é o formato recomendado para coletar/salvar os registros de forma a 
garantir todos os benefícios da função de registro de dados. Esta opção, no entanto, só está 
disponível se o Microsoft® Excel® estiver instalado no PC. O arquivo Excel® gerado por este 
utilitário possui até seis planilhas, dependendo dos registros coletados, incluindo: 
— Registro Diário 

— Registro por Hora 

— Registro de Alarmes 

— Registro de Auditoria 

— Registro do Sistema 

— Meter Config (Config. Medidor) 
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Os dados de registro coletados também são exibidos na tela. 

• Valores separados por vírgula - Este formato cria um arquivo com dados separados por 
vírgulas. Cada registro coletado é colocado em uma linha separada no arquivo. Cada tipo de 
registro é separado por uma linha em branco. A configuração do medidor é seguida pelos dados 
de registro separados por uma linha em branco. Os dados de registro coletados também são 
exibidos na tela. 

• Não registra no arquivo - Esta opção não salvará nenhum dos dados coletados em um arquivo, 
mas os exibirá na tela. 

1. Após selecionar o tipo de registro desejado e o formato do registro, clique no botão Collect 
para iniciar a coleta dos dados de registro. 
• Se um formato que salva os dados em um arquivo for selecionado, então uma caixa de 

diálogo Save As é aberta para permitir a especificação do nome do arquivo. Um nome 
padrão para o nome do arquivo é sugerido, mas pode ser mudado. Um comentário 
também pode  ser colocado e incluído ao arquivo de dados. 

 
2. Se um tipo de registro a ser lido for configurado de forma que os registros antigos não 

sejam regravados, o MeterLink™ pergunta ao usuário se ele quer marcar aqueles registros 
como lidos ou não. 

3. Uma vez concluída a coleta de dados, os dados são exibidos na caixa de diálogo Meter 
Archive Logs, um registro por vez. Selecione o tipo de registro a ser mostrado na caixa View 
log. Os dados podem ser organizados selecionando-se Oldest first, para visualizar os mais 
antigos primeiro, ou Newest first, para visualizar os mais novos, na caixa Sort order. 

 
5.1.7 Coleta de registros 

Para coletar registros de manutenção e de tendências para diagnóstico do medidor: 

Procedimento 

1. Estabeleça comunicação com o medidor via MeterLink™. 
2. Na janela principal do MeterLink, selecione Logs/Reports → Maintenance Logs and 

Reports. para abrir a caixa de diálogo de registros e relatórios de manutenção. 
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Figura 5-1: Registros de Manutenção de Líquidos 

 
 

 

 
3. Defina o tempo de duração da coleta de registros em minutos (2 minutos é o valor padrão 

normalmente adequado para uma boa visão dos parâmetros de diagnóstico atuais do 
medidor). Para uma boa representação do desempenho do medidor, é recomendável ter 
pelo menos 30 registros (linhas de dados). O número real 
de registros coletados é uma função do tipo de comunicação (Serial ou Ethernet), tamanho de 
empilhamento (se ativado) e a velocidade de coleta selecionada. O tempo de duração pode ser 
alterado clicando no número na caixa de exibição / edição e inserindo um novo valor. 

4. Também é possível adicionar um comentário no arquivo de registro digitando-o na caixa 
de exibição / edição fornecida. 

5. No campo “Log Format” (Formato do registro), selecione Microsoft® Excel®. Selecione 
Valores Separados por Vírgula (CSV) somente se a opção Microsoft Excel não estiver 
disponível, pois esse formato não é compatível com a geração de gráficos, tendências e 
análises oferecidas pelos Medidores de Vazão Ultrassônicos de Líquidos da Série 3810. Ao 
ser coletado no formato CSV, o arquivo não pode ser convertido para o formato Microsoft® 
Excel®. 

6. Para iniciar a coleta de registros, clique no botão Start. O MeterLink coleta a 
configuração do medidor e, em seguida, os dados do medidor. 

7. O MeterLink exibe uma mensagem de que o registro foi concluído depois que os registros são 
coletados. 

8. Para visualizar o arquivo Microsoft® Excel® selecione YES para abrir a pasta de trabalho. 
9. Selecione a visualização Workbook report na barra de ferramentas do ® Excel® na parte 

inferior da página. As abas disponíveis são: 

• Gráficos 

• Relatório de Inspeção 

• Config. do Medidor 
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• Dados brutos 

Figura 5-2: Barra de ferramentas da visualização de relatórios do Microsoft® Excel® 

 
 

10. O Relatório de Inspeção é a visualização padrão quando você abre o Registro de Manutenção. 

Figura 5-3: Visualização de relatórios de inspeção do Microsoft® Excel® 
 
 

 

 
11. Charts é a visualização dos dados em gráficos. 
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Figura 5-4: Visualização de gráficos do Microsoft® Excel® 
 

 
 

 
12. A próxima visualização de relatórios do Microsoft® Excel® é Meter Config. 

Figura 5-5: Visualização doMicrosoft® Excel® Meter Config.  

 
 

13. A última visualização de relatórios do Microsoft® Excel® é Raw Data. 
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Figura 5-6: Visualização de Dados Brutos do Microsoft® Excel®  

 
 

5.1.8 Coleta de registros de arquivamento do medidor 
Este utilitário permite coletar informações históricas de registro de um medidor ultrassônico. Essa 
caixa de diálogo está disponível apenas enquanto estiver conectado a um medidor. 

Procedimento 

1. Marque as caixas de seleção dos tipos de registros que deseja coletar, bem como das outras 
opções. 

Todos os registros serão coletados em um único arquivo de registro de arquivamento. 



Registros/Relatórios Operação 

90 Emerson.com/Rosemoun
t 

 
 

 

Dezembro 2023 00809-0222-3810 
 

 
 
 

Figura 5-7: Registros de Arquivamento do Medidor 
 
 

 

O formato de registro pode ser selecionado como Microsoft® Excel, valores separados por 
vírgula ou Don't log to file selecionando o botão de opção apropriado. 

Observação 
A opção Don't log to file não salva nenhum dado de registro no arquivo; ela apenas o exibe 
na tela. 

2. Clique em Collect. 
3. Na caixa de diálogo Save As, é fornecido um nome padrão com base no nome do medidor, no 

tipo de registros coletados e na data e horário do PC. Se desejar, você pode modificar o nome e 
o local padrão do arquivo. 
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6 Utilitário de comandos de ferramentas 

6.1 Menu de ferramentas 
Os comandos do menu Tools do MeterLink™ fornecem os seguintes utilitários para o status de 
integridade do medidor, monitoramento das condições operacionais, características de vazão do 
medidor, atualização dos componentes do programa do medidor e monitoramento da comunicação 
entre o MeterLink e o medidor. 

Tabela 6-1: Comandos do menu de ferramentas 
 

Editar/Comparar configuração Abrir, editar e comparar configurações de arquivos e medidores 

Editar/Comparar configuração Abra, edite e compare configurações de arquivos e medidores. 

Visualizador de forma de onda Colete, visualize, salve e imprima formas de ondas ultrassônicas de um 
medidor ou arquivo. 

Teste de saídas Teste a frequência, a corrente e as saídas digitais fixando-as em um valor 
definido. 

Troca de transdutor Ajuste os parâmetros de comprimento ao trocar transdutores, hastes, suportes 
ou montagens. 

Assistente para Definição do Padrão de 
Referência 

Estabelece a referência para as características de vazão do medidor que pode 
ser usada para monitorar a integridade do medidor usando recursos de 
Análise de Fluxo Contínuo. 

Download do programa Atualize os componentes do programa nos Medidores Ultrassônicos 
Rosemount. 

Analisador de comunicações Monitore a comunicação entre o MeterLink e um medidor. 

 
6.1.1 Edição/Comparação dos Parâmetros de Configuração 

Este utilitário de comando do MeterLink™ é usado para: 

• Aberto 

• Editar 

• Comparar configurações de arquivos e medidores 

• Gravar alterações de parâmetros no medidor 
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Figura 6-1: Edição/comparação dos parâmetros de configuração 

 

Edição dos parâmetros de configuração do medidor 

Pré-requisitos 

As opções desta caixa de diálogo incluem: 

• Visualizar e editar configurações coletadas do medidor ou abertas a partir de um arquivo 

• Gravar todos ou parte dos parâmetros alterados de uma configuração em um medidor conectado 

• Comparar e converter configurações legadas 

• Salvar e imprimir configurações 

Figura 6-2: Editar/comparar parâmetros de configuração 
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Procedimento 

1. Clique em Read para coletar e exibir uma configuração de um medidor conectado. 
2. Clique em ALL para exibir a configuração estendida do medidor ou em Metrology para exibir 

apenas a parte metrológica da configuração. 
3. Clique duas vezes em Value para alterar um parâmetro e selecione a opção na lista 

suspensa ou, se um sinal de intercalação for exibido, insira o valor. 

Se alterar um registro de dados, o Valor exibido na caixa de diálogo ficará amarelo e a caixa 
de seleção será selecionada. Posteriormente, você poderá optar por Write Checked apenas 
valores verificados no medidor. 

Figura 6-3: Alterações na configuração 

 
 

4. Clique no ícone de ponto de interrogação à direita de um ponto de dados para exibir 
informações adicionais. 

5. Clique em Write All para gravar a configuração completa em um medidor. Dependendo da 
Visualização selecionada, a configuração exibida pode não ser a configuração completa. 
Clique em Write Checked para gravar apenas os valores com uma caixa de seleção 
selecionada ao lado do valor e que estejam visíveis na visualização atualmente selecionada. 
Selecione quaisquer valores para gravar e apague quaisquer valores que não deseja gravar no 
medidor antes de clicar em Write Checked. 

6. Abra uma configuração no editor e selecione Meter ou selecione File para compará-la com 
uma configuração salva como um arquivo. 

7. Clique em Compare para ler a configuração do medidor ou abra a caixa de diálogo Open 
para selecionar a configuração a ser comparada com a do editor. 

a. Excluir registros que normalmente são diferentes: Inclui itens 
que podem mudar regularmente. Uma lista completa é definida em  
reg_list_compare_config_exclude.txt  encontrado no diretório de instalação do MeterLink™. 

b. Incluir registros somente leitura: Inclui, na comparação, registros somente 
leitura armazenados nas configurações coletadas. Isso inclui pontos como versão 
do firmware, fatores K, etc. 
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Após as configurações serem selecionadas, uma caixa de diálogo será exibida, fornecendo 
opções para personalizar ainda mais a operação de comparação. 

8. Clique em Save para salvar o arquivo de configuração. Um nome de arquivo padrão é 
fornecido com base no nome do medidor, horário e data em que a configuração foi 
coletada. Você pode manter o nome padrão ou alterá-lo. O arquivo é salvo, por padrão, no 
diretório da pasta Data definido em File → Program Settings. Você pode alterar a 
localização do diretório, se desejar. 

9. Clique em Print para imprimir a configuração atualmente aberta no editor. 
Somente os registros na visualização atualmente selecionada serão impressos. Você 
também pode clicar no ícone de impressão na barra de ferramentas para imprimir a 
configuração aberta. 

10. Use Convert para baixar a configuração de um Medidor Ultrassônico Rosemount legado 
para uma geração posterior de componentes eletrônicos. 

a) Primeiro conecte-se aos componentes eletrônicos legados. Colete e salve a 
configuração usando a caixa de diálogo Tools → Edit/Compare Configuration. 
Atualize os componentes eletrônicos do medidor. 

b) Conecte-se aos novos componentes eletrônicos do medidor e abra a caixa de 
diálogo Tools → Edit/Compare Configuration . Abra a configuração coletada dos 
componentes eletrônicos legados. O botão Convert será habilitado. 

c) Clique em Convert para ler a configuração do novo medidor e modificá-la com os 
dados da configuração legada. O MeterLink exibe esta configuração modificada na 
caixa de diálogo. Neste momento, o MeterLink não gravou nada no novo medidor. 
Todos os valores destacados em amarelo são valores da configuração legada. 

d) Clique em Write Checked para gravar a parte alterada da configuração no novo 
medidor. Se algum ponto de dados falhou ao ser gravado, você deve corrigir o valor 
inválido e clicar em Write Checked novamente até que a configuração seja gravada 
sem erros. Após a configuração ser gravada, é possível optar por comparar a 
configuração exibida com a configuração no medidor, selecionando Meter e clicando 
em Compare. Isso verificará se tudo foi gravado corretamente. 

 
Visualizador de formas de onda de transdutores 
A velocidade em que as ondas são atualizadas depende da conexão entre o PC e o medidor. Com 
uma conexão Ethernet e o MeterLink™, são possíveis diversas atualizações por segundo. Com uma 
conexão serial, as atualizações podem ocorrer apenas a cada 15 a 30 segundos. 

Até três tipos de sinais de ondas podem ser exibidos por corda: 

• Raw - A forma de onda amostrada recebida pelo transdutor (com ganho aplicado). 

• Stacked - O resultado de aplicar empilhamento aos sinais brutos. Observe que quando o 
empilhamento não é usado (StackSize definido em 1), o sinal de empilhamento é o mesmo do 
sinal bruto. 
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• Filtered - ƒO resultado de aplicar o filtro passa-banda no sinal empilhado. Esta onde 
está disponível apenas quando o filtro estiver habilitado (via ponto de dados Filter). 

Para fins de diagnóstico, os sinais de forma de onda do transdutor podem ser armazenados em um 
arquivo usando a caixa de seleção Diagnostic Collection - Stream to file. Esta utiliza o recurso 
patenteado de “snapshot e playback” do Medidor de Vazão Ultrassônico de Líquidos Rosemount 3810 
para registrar com precisão os sinais de vazão que podem ser posteriormente reproduzidos para 
análise detalhada. 

As formas de onda são exibidas no domínio do tempo (ex: o sinal da forma de onda é plotado em 
relação ao tempo). 

Figura 6-4: Visualizador de formas de onda - domínio do tempo 

 

As formas de onda também podem ser exibidas no domínio da frequência. Neste modo, uma  
Transformada Discreta de Fourier é obtida da forma de onda para que o conteúdo de frequência da 
forma de onda possa ser exibido. Isto pode ser útil em ambientes ruidosos para ver a frequência do 
ruído e se ele está na faixa do sinal do transdutor. 
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Figura 6-5: Visualizador de formas de onda - domínio da frequência 

 

Passagem por zero e primeiros marcadores de movimento 

Dois marcadores são exibidos ao longo do eixo horizontal para a forma de onda Empilhada ou 
Filtrada. Se a filtragem estiver ativada, os marcadores estarão na forma de onda Filtrada. Se a 
filtragem estiver desativada, os marcadores estarão na forma de onda Empilhada. O marcador verde 
mostra o ponto onde o primeiro movimento é detectado. O marcador roxo mostra a passagem por 
zero que é o ponto que o medidor utiliza como ponto de chegada do sinal. 

Navegação no visualizador de formas de onda 

Procedimento 

1. Selecione as formas de onda a serem coletadas no menu suspenso Meter e clique em Read.  
As seleções possíveis incluem: 
• All Chords (Todas as Cordas) 

• Chord A (Corda A) 

• Chord B (Corda B) 

• Chord C (Corda C) 

• Chord D (Corda D) 

Observação 
As cordas C e D estão disponíveis para Medidores de Líquidos de 4 Vias. 

2. O MeterLink™ começa a transmitir continuamente formas de onda do medidor. 
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3. Clique em Save durante a transmissão de formas de onda ou clique em Stop. 
O MeterLink abre uma caixa de diálogo Save As para permitir que você escolha um nome 
para o arquivo da forma de onda. É sugerido um nome padrão baseado no Nome do 
Medidor, no tipo de forma de onda coletada e na data e horário do PC. Altere o nome ou 
local padrão, se desejar. Clique em Save para aceitar o nome do arquivo e salvar o último 
conjunto de formas de onda coletadas. 

4. Clique em Open e selecione o nome do arquivo da forma de onda na caixa de diálogo Open 
para visualizar uma forma de onda salva anteriormente. 

5. Clique em Tracking para exibir a caixa de diálogo Tracking Parameters do sinal bruto, 
filtrado ou empilhado do transdutor para a corda selecionada. 
Esta caixa de diálogo exibe a identificação, o valor e as unidades do parâmetro. Alguns dos 
parâmetros de Monitoramento incluídos são Ganho, Tempo de espera, Tempo (data e 
horário), Qualidade Máxima do Sinal, Largura do pico, Posição do Pico e Pico de Passagem 
por Zero para sinais a montante e a jusante. Esses parâmetros são utilizados no diagnóstico 
das condições de campo. 

6. Clique em Export para salvar as formas de onda exibidas no formato Microsoft Excel®. 
O arquivo Microsoft Excel® contém três planilhas. A primeira planilha chamada Charts 
contém gráficos para cada uma das formas de onda coletadas. A segunda planilha chamada 
Raw Data contém os dados da forma de onda para fazer os gráficos. A terceira planilha 
chamada Tracking contém os parâmetros de monitoramento da corda. 

7. Clique em Close para sair do Visualizador de Formas de Onda. 

8. Use o recurso do conjunto de controles de Coleta de Diagnóstico para capturar um snapshot 
da forma de onda a ser reproduzido em um simulador. Este recurso patenteado nos EUA é 
útil para permitir que a Emerson reproduza quaisquer condições específicas de campo. 

a. Clique na caixa de seleção Stream to file e aguarde até que as formas de onda 
comecem a ser transmitidas para a tela. O medidor retorna formas de onda brutas 
exatamente como elas são recebidas, sem qualquer empilhamento ou filtragem. 

b. Clique em Record para começar a salvar todas as formas de onda brutas em um 
arquivo. A coleta de formas de onda pode ser pausada e retomada sem a 
necessidade de iniciar um novo arquivo. Clicar em Stop fornece a opção de salvar os 
dados coletados em um arquivo. O arquivo terá uma extensão .strm. Não há nenhum 
utilitário no MeterLink para reproduzir esses arquivos. Os arquivos devem ser usados 
apenas internamente pela Emerson em ferramentas de diagnóstico especiais. 
Desmarcar a caixa de seleção Stream to file interrompe o modo de transmissão e 
retorna o Visualizador de Formas de Onda ao seu modo normal de operação. 
Importante 
Não há nenhum utilitário no MeterLink para reproduzir esses arquivos. Os arquivos 
devem ser usados apenas internamente pela Emerson em ferramentas de diagnóstico 
especiais. 

 

9. Desmarque a caixa de seleção Stream to file para interromper o modo de transmissão de 
forma de onda e retornar o Visualizador de Formas de Onda ao seu modo normal de operação. 

Observação 
O arquivo criado com a coleta para Diagnóstico cresce rapidamente. Normalmente, quando 
conectado via Ethernet ao medidor, o arquivo pode facilmente ocupar 2,5 megabytes por 
minuto. Se o arquivo precisar ser enviado por e-mail, muitos servidores de e-mail permitem 
apenas arquivos de 10 a 20 megabytes ou aproximadamente 4 a 8 minutos de dados. 

10. Use os utilitários de Gráficos para controlar a exibição da forma de onda. Os controles do 
utilitário de gráficos de formas de onda incluem: 
• Barra de rolagem - ativa barras de rolagem horizontais e verticais no gráfico. 

• Marcadores - exibe marcadores para a série para ver os pontos de dados coletados. 
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• Ampliar - amplia as escalas horizontal e vertical centralizadas no cursor. 

• Afastar - afasta as escalas horizontal e vertical centralizadas no cursor. 

• Fixo - força o cursor a permanecer no traçado da forma de onda. 

• Outros comandos do teclado - use os comandos do teclado como atalho para 
acessar a função desejada. Clique com o botão direito no gráfico para exibir 
esses comandos ou digite o comando do teclado. 

Tabela 6-2: Comandos do teclado do gráfico de forma de onda 
 

Função Tecla Descrição 

Salvar Estado Ctrl + Home Salvas as configurações de ampliação atuais. 
Essas configurações podem ser recuperadas com 
o comando Restaurar Estado. Quaisquer 
configurações salvas serão perdidas quando o 
utilitário for fechado. 

Restaurar Estado Início Restaura as últimas configurações de ampliação 
salvas. 

Cursor para o Ponto Mais Próximo F8 Move o cursor para o ponto mais próximo exibido. 

Alternar entre Cursor Grosso/Fino F4 Alterna o cursor entre um cursor de movimento 
rápido e lento. O cursor é fisicamente maior para 
o cursor de movimento rápido. 

Alternar Linhas/Marcadores F9 Desativa as linhas que conectam os dados 
coletados e força os marcadores. 

Alternar Dica de Posição do Mouse Ctrl+F4 Ativa a dica de ferramenta que mostra as 
coordenadas para as quais o ponteiro do mouse 
está apontando. 

Alternar Dica do Ponto mais 
Próximo 

Ctrl+F9 Ativa a dica de ferramenta que mostra as 
coordenadas do ponto de dados mais próximo 
do ponteiro do mouse. 

Imprimir Ctrl+P Imprime o gráfico exibido. 

Copiar para área de transferência Ctrl+C Copia o gráfico exibido para a área de 
transferência do Windows® como dados de tabela. 

Colar da área de transferência Ctrl+V Cola os dados da área de transferência do 
Windows® no utilitário de gráficos. Os dados 
devem estar no formato apropriado para serem 
colados corretamente como uma nova série no 
gráfico. Copia os dados do gráfico para um 
arquivo de texto para ver o formato apropriado. 

Ampliar Forma de Onda Ctrl+I Ativa/desativa o recurso de ampliação no modo de 
Leitura de Forma de Onda ou Stream to file. 

 
 

6.1.2 Teste das saídas 
Menu de ferramentas 

A caixa de diálogo Outputs Test permite monitorar os valores ativos de todas as saídas de 
frequência, de corrente e digitais. Além disso, as saídas podem ser definidas em um Modo de Teste 
para forçar as saídas a valores específicos definidos pelo usuário. Essa caixa de diálogo está 
disponível apenas enquanto estiver conectado a um medidor. 

Consulte Modo de teste das saídas neste manual para obter informações adicionais. 
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6.1.3 Troca de Transdutores 
O utilitário de troca de transdutores permite atualizar parâmetros como comprimentos, tempos de 
atraso e tempos delta das cordas. Isto é necessário sempre que as carcaças dos transdutores 
precisarem ser substituídas por uma corda. 

Consulte o Manual de Manutenção e Solução de Problemas dos Medidores de Vazão Ultrassônicos 
de Líquidos Rosemount Série 3814 (P/N 00809-0100-3814, Seção 3.3) ou o Manual de Manutenção 
e Solução de Problemas dos Medidores de Vazão Ultrassônicos de Líquidos Rosemount Série 3812 
(P/N 00809-0100-3812, Seção 3.6) para obter instruções detalhadas sobre como substituir as 
carcaças dos transdutores e definir os parâmetros das peças substituídas. 

 
6.1.4 Atualização dos componentes do programa 

Use a caixa de diálogo ™ Tools → Program Download para atualizar os componentes do programa 
no Medidor Ultrassônico Rosemount Quando a caixa de diálogo for aberta pela primeira vez, a tabela 
Currently Installed Versions  mostrará os componentes do programa atualmente instalados no 
medidor. 

 

6.1.5 Partida a quente do medidor 

Selecionar este comando exibirá a mensagem: Do you want to warm start the meter and 
disconnect from it now?  Clique em Yes para forçar a reinicialização do medidor. 

Uma partida a quente é a mesma reinicialização de quando o medidor é reiniciado. Nenhuma 
configuração ou histórico de registro de arquivamento é perdido. Algumas alterações na 
configuração exigem a reinicialização do medidor para que as alterações tenham efeito. Clique em No 
para fechar a caixa de diálogo. 

 
6.1.6 Analisador de comunicação 

O Analisador de Comunicação é um aplicativo do Windows® que exibe “mensagens” transmitidas e 
recebidas de um dispositivo endereçável, como um servo Modbus, por outro aplicativo do 
Windows®. As mensagens são exibidas da mais antiga (no topo da lista) até a mais recente (no 
final da lista). O Analisador de Comunicação registra a 
data e a hora de cada mensagem exibida. Após a exibição de 4.096 mensagens, as mensagens mais 
antigas são apagadas da lista à medida que novas mensagens são adicionadas. 

A caixa de combinação de Endereço filtra novas mensagens para que somente aquelas com o 
endereço selecionado (1-32) sejam exibidas. Por padrão, todos os endereços são exibidos. O filtro de 
endereço não afeta as mensagens já exibidas, apenas as novas mensagens. 

https://www.emerson.com/documents/automation/manual-3814-liquid-ultrasonic-flow-meters-maintenance-troubleshooting-manual-en-44128.pdf
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Figura 6-6: Analisador de comunicação do menu de ferramentas 

 

Procedimento 

1. Marque Browse para desativar a rolagem automática. Isto é útil se você quiser ver uma 
determinada mensagem enquanto uma nova mensagem está sendo adicionada à lista. 

2. Clique em Copy para copiar as mensagens para a área de transferência para que possam 
ser coladas em outro aplicativo do Windows, por exemplo, Bloco de Notas. 

3. Clique em Reset para limpar a lista de mensagens exibidas. 
4. Clique em Close para fechar a caixa de diálogo e retornar à página principal do MeterLink™. 



Operação Fatores de conversão 

Rosemount 3810 101 

 

 

00809-0222-3810 Dezembro 2023 
 

 
 
 

A Fatores de conversão 

A.1 Unidades de medida do fator de conversão 
Tabela A-1: Unidades de medida do fator de conversão 

 

Fator de conversão Unidades de medida 

(°F-32)x(5/9)->°C (°C+273,15)->K  

1 K/°C 

5/9 °C/°F 

10 -6 MPa/Pa 

0.006894757 MPa/psi 

0.1 MPa/bar 

0.101325 MPa/atm 

0.000133322 MPa/mmHg 

0.3048 m/ft 

0.0254 m/pol 

10 3 dm 3 /m 3 

10 -6 m 3 /cc (=m 3 /cm 3 ) 

(0,3048) 3 m 3 /ft 3 

(0,0254) 3 m 3 /in 3 

3600 s/h 

86400 s/dia 

10 3 g/kg 

0.45359237 kg/lbm 

4.1868 kJ/kcal 

1.05505585262 kJ/ BtuIT 

10 -3 Pa•s/cPoise 

1.488 Pa•s/(lb/(ft•s) 
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B Equações Diversas 

B.1 Fatores de conversão diversos 
Use os seguintes cálculos: 

• Fator K - Um valor somente leitura que mostra o fator K calculado a partir da taxa de vazão 
volumétrica total usada com as saídas de frequência e a Frequência máxima da saída de 
frequência. Esta propriedade é desabilitada se as Saídas de Frequência foram desmarcadas 
na Página Inicialização. 

• Vol/pulso - Um valor somente leitura que mostra o inverso calculado do fator K. Esta propriedade 
é desabilitada se as Saídas de Frequência foram desmarcadas na Página Inicialização. 

Equação B-1: Fator K da Taxa de Vazão Volumétrica de Frequência 

 
 

 

Equação B-2: Fator K Inverso da Taxa de Vazão Volumétrica de Frequência 

 
 

KFactor “Fator K” de frequência (pulsos/m3 ou pulsos/ft3) (Freq1KFactor e 
Freq2KFactor) 

InvKFactor “Fator K Inverso” de frequência (m3/pulso ou ft3/pulso) (Freq1InvKFactor e 
Freq2InvKFactor) 

FreqQFullScale Taxa de vazão volumétrica total de frequência (m3/h ou ft3/h) 
(Freq1FullScaleVolFlowRate e Freq2FullScaleVolFlowRate) 

MaxFreq frequência máxima (Hz = pulsos/s) (1000 ou 5000 Hz) 
(Freq1MaxFrequency e Freq2MaxFrequency) 

(*)TimeUnit: O fator de conversão de tempo depende do ponto de dados de VolFlowRate: 

• volume/segundo = 1 s/s 

• volume/minuto = 60 s/s 

• volume/hora = 3600 s/h 

(**)Volume: Onde o volume é selecionado por meio de pontos de dados do Sistema de Unidades.  

VolInitUS 

• Galões 

• Barris 

VolUnitMetric 

• Metros cúbicos 
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C Solução de problemas de comunicação: 
problemas mecânicos e elétricos 

C.1 Solução de problemas de comunicação 
Q1: Por que o LED LINK do Módulo da CPU não acende quando ocorre conexão com o medidor 
via Ethernet? 

A1: A luz LINK indica boa conectividade elétrica entre duas portas LAN. Ela também indica 
polaridade adequada na conexão Ethernet. 

QUANDO CONECTADO DIRETAMENTE: Verifique se o cabo ultrassônico (P/N 1-360-01-
596) está conectado corretamente. 

QUANDO UTILIZAR UM HUB: Quando utilizar um hub entre o medidor e o PC, é necessário um cabo 
de conexão direta entre o medidor e o hub e um cabo de conexão direta entre o hub e o PC. Não 
conecte o medidor ou PC à porta UPLINK do hub. A maioria dos hubs não permite o uso da porta 
imediatamente ao lado da porta UPLINK do hub quando a porta UPLINK é utilizada para conectar o 
hub a uma LAN. Certifique-se de que o medidor e o PC não estão conectados a uma porta UPLINK 
que não pode ser utilizada do hub. 

Verifique se o medidor está ligado, verificando se o LED 1 do Módulo da CPU está aceso (vermelho ou 
verde fixo). Se o LED não estiver aceso, verifique a alimentação do medidor. Se o LED estiver aceso, 
verifique as conexões do cabo Ethernet. 

Q2: O LED LINK do Módulo da CPU está aceso, mas não é possível estabelecer comunicação com 
o medidor via Ethernet. Qual é o problema? 

A2: Se estiver se conectando pela primeira vez, consulte Configurar o diretório do medidor 
para obter instruções sobre a configuração inicial da comunicação (via Ethernet). 

Caso esteja utilizando o programa MeterLink™, verifique se a conexão Ethernet opcional está 
habilitada. 

Verifique se o servidor DHCP do medidor está habilitado (chave S2-2 da Placa da CPU na posição 
FECHADO). Verifique se o PC recebeu um endereço IP do medidor da seguinte forma: 

• Abra a janela do prompt de comando do DOS (Start|Run|(digite)cmd) 

• Na janela do prompt de comando do DOS, digite “ipconfig”. 

Você verá algo como: 

• Windows® IP Configuration 

• Ethernet adapter Local Area Connection 1: 

• Connection-specific DNS Suffix: 

• IP Address:192.168.135.35 (nota: o último 0,35 pode ser até 0,44) 

• Máscara de subrede: 255.255.255.0 

• Default Gateway: 

Se visualizar o seguinte: 

• Ethernet adapterLocal Area Connection 1: 

• IP Address: 0.0.0.0 
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Então o PC ainda não recebeu um endereço IP do servidor DHCP e é aconselhável aguardar (até 30 
segundos) para receber um endereço IP antes de tentar conectar-se ao medidor. Se após 30 
segundos o PC não receber um endereço IP do servidor DHCP do medidor ou o endereço IP 
mostrado acima (do ipconfig) for diferente do intervalo de 192.168.135.35 a 192.168.135.44, verifique 
se o PC está configurado para receber o endereço IP automaticamente (via DHCP). 

Para garantir a conexão com o medidor a partir do PC, no prompt de comando 

do DOS, digite: ping 192.168.135.100 <enter> 

• Se o medidor estiver acessível, será exibida uma mensagem como: 
— Pinging 192.168.135.100 with 32 bytes of data: 

—   Reply from 192.168.135.100: bytes=32 time < 10ms TTL=64 

— etc. 

• Se o medidor não estiver acessível, será exibido algo como: 
— Pinging 192.168.135.100 with 32 bytes of data: 

— Request Timed Out etc. 

Q3: Como faço para conectar a vários medidores via Ethernet quando eles estão na mesma LAN? 

A3: Antes de conectar vários medidores via Ethernet em uma LAN, cada medidor deve ser configurado 
com um endereço IP especificado pelo usuário (seguindo as instruções de início rápido da 
comunicação emUtilitários de configuração do MeterLink™). Entre em contato com seu departamento 
de TI para obter endereços IP válidos para a LAN e o endereço de Gateway, se necessário. Após o 
endereço IP do medidor ser configurado, ele pode ser conectado à LAN da Intranet e acessado 
utilizando esse endereço IP. 

Os medidores da Série 3810 Rosemount conectados a uma LAN na Intranet não devem ter seus 
servidores DHCP habilitados. 

Q4: Como faço para conectar a vários medidores via Ethernet quando eles estão no mesmo hub, 
mas não estão conectados a uma LAN na Intranet? 

A4: O PC pode receber o endereço IP de um servidor DHCP externo; nesse caso, apenas um medidor 
deve ter o servidor DHCP habilitado. Esse servidor DHCP atenderá até 10 endereços IP de PCs que 
tentarem se comunicar com todos os medidores no hub. 

Antes de conectar vários medidores via Ethernet em um hub, cada medidor deve ser configurado 
com um endereço IP especificado pelo usuário (seguindo as instruções de início rápido da 
comunicação em Utilitários de configuração do MeterLink™ ). Atribua a cada medidor no hub um 
endereço IP exclusivo dentro do intervalo 192.168.135.150 a 192.168.135.254. O endereço de 
Gateway de cada medidor não precisa ser configurado, sendo deixado em 0.0.0.0. Após o endereço 
IP de um medidor ser configurado, o medidor pode ser conectado ao hub e acessado utilizando 
esse endereço IP. 

 
C.2 Solução de problemas mecânicos/elétricos 

Esta seção visa auxiliar os funcionários de manutenção e operações do local, treinados na 
operação do medidor de vazão ultrassônico, e que conhecem as técnicas básicas de solução de 
problemas mecânicos e eletrônicos/elétricos, utilizando laptops, bem como medidores digitais 
de volt/ohm. Deve-se tomar muito cuidado para não “causar um curto-circuito” em um 
determinado circuito eletrônico/elétrico durante a solução de problemas. 
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Tabela C-1: Solução de problemas mecânicos/elétricos 
 

Problema Solução 

Unidade sem alimentação • Verifique se a Placa de Conexões Remotas está recebendo a  
tensão correta (CA ou CC) em sua entrada. (Ver Desenhos de engenharia, 
Esquema Elétrico do Sistema). 

• Verifique a fonte de alimentação principal quanto a fusíveis queimados ou 
disjuntores desarmados. Consulte os desenhos de instalação "as built” do seu 
local. 

• Verifique os fusíveis da Placa de Conexões Remotas. Consulte a localização dos 
fusíveis F1 e F2. 

Não há comunicação com 
o programa MeterLink™  

• Verifique se o medidor está recebendo alimentação corretamente. 

• Certifique-se de que o cabo do computador está conectado corretamente à placa 
de conexões remotas e verifique os pinos da interface (RS-485 ou RS-232). 

• Verifique se os parâmetros de comunicação do programa MeterLink estão 
configurados de acordo com os jumpers na placa da CPU do medidor. Consulte 
osUtilitários de configuração do MeterLink™ deste manual para obter instruções 
sobre como configurar a comunicação. 

Uma ou mais cordas não 
indicam leitura (reportam 
zeros) 

• Verifique se os conectores dos cabos estão soltos. Consulte Desenhos .de 
Engenharia. 

• Verifique a resistência dos transdutores (deve ser de aproximadamente 1-2 Ω). 

• O problema também pode ser causado por uma Placa de Aquisição Incorreta ou 
cabo de interconexão. Consulte os Desenhos de Engenharia para mais 
informações. 

• Verifique o status do sistema no MeterLink, Meter → Monitor em busca de 
quaisquer erros indicados. 

• Verifique os LEDs da placa da CPU. 

A forma de onda contém 
uma quantidade excessiva 
de ruído 

Aumente o “StackSize” até o nível de ruído diminuir (as configurações podem ser 1 
(nenhum), 2, 4, 8 ou 16). Se aumentar o tente ligar  
o filtro ou consulte o Suporte ao Cliente da Emerson para produtos Rosemount se 
não estiver seguro de como empilhar um sinal pode afetar a operação do medidor. 
Consulte o Suporte Técnico no menu Help do MeterLink para obter informações de 
contato. 

A linha de comunicação 
está conectada ao 
computador de vazão, 
mas não recebe sinal 

• Verifique se há conexões soltas no medidor de vazão e no computador de vazão 
(consulte os Desenhos de Engenharia). 

• Verifique o Módulo da CPU, a Placa de Conexões Remotas e a fiação de 
Alimentação. Certifique-se de que a fiação e os conectores do bloco de terminais 
apresentam bom contato. 

Há comunicação com o 
medidor, mas todas as 
cordas exibem falhas 

• Verifique se a resistência dos transdutores está de acordo com a Especificação (1-
2 Ω). 

• Verifique a Placa de Aquisição. 

• Verifique os cabos de interconexão entre o gabinete da base e o gabinete do 
transmissor. 

A corda não está 
fornecendo indicação 

• Verifique a resistência do transdutor com falha. 

• Se a Corda A não estiver fornecendo indicação, troque os cabos dos transdutores 
da corda D à corda A. 

• Se a Corda D falhar, os transdutores estão com defeito na Corda A. 

• O mesmo procedimento de teste pode ser realizado trocando as Cordas B e C, 
caso uma corda apresente falha em uma das cordas. 

 

Observação 
Os cabos externos da corda não podem ser trocados pelos cabos internos da corda. 
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D Parâmetros protegidos contra gravação 

D.1 Parâmetros de configuração protegidos contra gravação 
Os parâmetros de configuração que são protegidos contra gravação impedem alterações quando a 
chave WRITE PROT. da Placa da CPU está na posição ON. Os pontos de dados na Tabela D-1 são 
aplicáveis ao firmware v1.06 e posterior. 

Tabela D-1: Parâmetros de configuração protegidos contra gravação 
 

AbnormalProfileDetectionLmt 

Address 

AlarmDef 

AO1ActionUponInvalidContent 

AO1Content 

AO1Dir 

AO1FullScaleEnergyRate 

AO1FullScaleMassRate 

AO1FullScaleVolFlowRate 

AO1MaxVel 

AO1MinVel 

AO1TrimCurrent 

AO1TrimGainExtMeasCurrent 

AO1TrimZeroExtMeasCurrent 

AO1ZeroScaleEnergyRate 

AO1ZeroScaleMassRate 

AO1ZeroScaleVolFlowRate 

AO2ActionUponInvalidContent 

AO2Content 

AO2Dir 

AO2FullScaleEnergyRate 

AO2FullScaleMassRate 

AO2FullScaleVolFlowRate 

AO2MaxVel 

AO2MinVel 

AO2TrimCurrent 

AO2TrimGainExtMeasCurrent 

AO2TrimZeroExtMeasCurrent 

AO2ZeroScaleEnergyRate 

AO2ZeroScaleMassRate 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

AO2ZeroScaleVolFlowRate 

AsyncEnable 

AtmosphericPress 

AvgDlyA 

AvgDlyB 

AvgDlyC 

AvgDlyD 

AvgSoundVelHiLmt 

AvgSoundVelLoLmt 

BatchSize 

BlockageTurbulenceLmtA 

BlockageTurbulenceLmtB 

BlockageTurbulenceLmtC 

BlockageTurbulenceLmtD 

CalMethod 

ChordInactvA 

ChordInactvB 

ChordInactvC 

ChordInactvD 

City 

ColocMeterMode 

ContractHour 

CRange 

DailyLogInterval 

DampEnable 

DeviceNumber 

DI1IsInvPolarity 

DitherEnable 

DltChk 

DltDlyA 

DltDlyB 

DltDlyC 

DltDlyD 

DO1AContent 

DO1AIsInvPolarity 

DO1BContent 

DO1BIsInvPolarity 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

DO1PairTestEnable 

DO2AContent 

DO2AIsInvPolarity 

DO2BContent 

DO2BIsInvPolarity 

DO2PairTestEnable 

EmRateDesired 

EnableExpCorrPress 

EnableExpCorrTemp 

EnablePressureInput 

EnableTemperatureInput 

Filter 

FireSeq 

FlowAnalysisHighFlowLmt 

FlowAnalysisLowFlowLmt 

FlowDir 

FlowPOrTSrcUponAlarm 

FODO1Mode 

FODO1Source 

FODO2Mode 

FODO2Source 

FODO3Mode 

FODO3Source 

Freq1BPhase 

Freq1Content 

Freq1Dir 

Freq1FeedbackCorrectionPcnt 

Freq1FullScaleEnergyRate 

Freq1FullScaleMassRate 

Freq1FullScaleVolFlowRate 

Freq1MaxFrequency 

Freq1MaxVel 

Freq1MinVel 

Freq1ZeroScaleEnergyRate 

Freq1ZeroScaleMassRate 

Freq1ZeroScaleVolFlowRate 

Freq2BPhase 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

Freq2Content 

Freq2Dir 

Freq2FeedbackCorrectionPcnt 

Freq2FullScaleEnergyRate 

Freq2FullScaleMassRate 

Freq2FullScaleVolFlowRate 

Freq2MaxFrequency 

Freq2MaxVel 

Freq2MinVel 

Freq2ZeroScaleEnergyRate 

Freq2ZeroScaleMassRate 

Freq2ZeroScaleVolFlowRate 

FTPServerControlPort 

FwdA0 

FwdA1 

FwdA2 

FwdA3 

FwdFlwRt1 

FwdFlwRt10 

FwdFlwRt11 

FwdFlwRt12 

FwdFlwRt2 

FwdFlwRt3 

FwdFlwRt4 

FwdFlwRt5 

FwdFlwRt6 

FwdFlwRt7 

FwdFlwRt8 

FwdFlwRt9 

FwdMtrFctr1 

FwdMtrFctr10 

FwdMtrFctr11 

FwdMtrFctr12 

FwdMtrFctr2 

FwdMtrFctr3 

FwdMtrFctr4 

FwdMtrFctr5 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

FwdMtrFctr6 

FwdMtrFctr7 

FwdMtrFctr8 

FwdMtrFctr9 

HighViscosityMethod 

HARTDate 

HARTDescriptor 

HARTDeviceFinalAssyNum 

HARTLongTag 

HARTMessage 

HARTMinNumPreambles 

HARTNumPreambleBytesFromSlave 

HARTPollingAddress 

HARTPressureUnit 

HARTQVContent 

HARTRateTimeUnit 

HARTSlot0Content 

HARTSlot1Content 

HARTSlot2Content 

HARTSlot3Content 

HARTTag 

HARTTemperatureUnit 

HARTTVContent 

HARTVelUnit 

HARTVolUnit 

HighPressureAlarm 

HighTemperatureAlarm 

HourlyLogInterval 

HTTPServerPort 

InputPressureUnit 

IsAO1EnableTest 

IsAO2EnableTest 

IsFreq1BZeroedOnErr 

IsFreq1EnableTest 

IsFreq2BZeroedOnErr 

IsFreq2EnableTest 

IsTelnetServerEnabled 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

LA 

LB 

LC 

LD 

LinearExpansionCoef 

LiveFlowPressureCalCtrl 

LiveFlowPressureGain 

LiveFlowPressureOffset 

LiveFlowTemperatureCalCtrl 

LiveFlowTemperatureGain 

LiveFlowTemperatureOffset 

LowFlowLmt 

LowPressureAlarm 

LowTemperatureAlarm 

MaxHoldTm 

MaxInputPressure 

MaxInputTemperature 

MaxNoDataBatches 

MaxNoise 

MeterHousingLength<A..D> 

MeterMaxVel 

MeterName 

MeterSerialNumber 

MinChord 

MinHoldTime 

MinInputPressure 

MinInputTemperature 

MinPctGood 

MinSigQlty 

NegSpanSI 

NonNormalModeTimeout 

NumVals 

PipeDiam 

PipeOutsideDiameter 

Pk1Pct 

Pk1Thrsh 

Pk1Wdth 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

PoissonsRatio 

PosSpanSI 

PropUpdtBatches 

RefPressExpCoef 

RevA0 

RevA1 

RevA2 

RevA3 

RevC0 

RevC1 

RevC2 

RevC3 

ReverseFlowVolLmt 

RevFlwRt1 

RevFlwRt10 

RevFlwRt11 

RevFlwRt12 

RevFlwRt2 

RevFlwRt3 

RevFlwRt4 

RevFlwRt5 

RevFlwRt6 

RevFlwRt7 

RevFlwRt8 

RevFlwRt9 

RevMtrFctr1 

RevMtrFctr10 

RevMtrFctr11 

RevMtrFctr12 

RevMtrFctr2 

RevMtrFctr3 

RevMtrFctr4 

RevMtrFctr5 

RevMtrFctr6 

RevMtrFctr7 

RevMtrFctr8 

RevMtrFctr9 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

SampInterval 

SampPerCycle 

SetXdcrType 

SndSpdChkMaxVel 

SndSpdChkMinVel 

SndVelCompErrLimit 

SNRatio 

SpecBatchUpdtPeriod 

SSMax 

SSMin 

StackEmRateDesired 

StateAndCountry 

StationName 

SwirlAngleLmt 

Tamp 

TampHi 

TampLo 

TampSen 

TampWt 

TmDevFctr1 

TmDevLow1 

Tspe 

TspeHi 

TspeLmt 

TspeLo 

TspeSen 

TspeWt 

Tspf 

TspfHi 

TspfLo 

TspfMatch 

TspfSen 

TspfWt 

UnitsSystem 

VelHold 

VolFlowRateTimeUnit 

VolUnitMetric 
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Tabela D-1: Parâmetros de configuração protegidos contra gravação (continuação) 

VolUnitUS 

XA 

XB 

XC 

XD 

XdcrFiringSync 

XdcrFreq 

XdcrHousingLength<A..D> 

XdcrHousingSerialNumber<A..D> 

XdcrNumDriveCycles 

XdcrType 

YoungsModulus 

ZeroCut 
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